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F ilm F re e P roje ction E xte nd e d is a W ind ow s p rog ra m d e sig ne d to a llow ca m e ra club s to run d ig ita l com p e titions using a la p top
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to p roje ct the im a g e s.
This is the use r g uid e for F ilm F re e P roje ction E xte nd e d . The g uid e is org a nise d into thre e m a jor se ctions; G e tting Sta rte d , U sing
F F P x in D e ta il a nd W a lkthroug hs.
By fa r the m ost use ful a d v ice I ca n g iv e is to p ra ctice b e fore ha nd ; if y ou d on't w a nt to w e a r out y our p roje ctor b ulb , the n I'd
re com m e nd p lug g ing a "norm a l" m onitor into the se cond p ort of y our la p top . W hilst p ra cticing , try e xp loring w ha t the p rog ra m
to d o - re a d the m a nua l, the e xp e rie nce of m a ny ca m e ra club s ha s, in one w a y or a nothe r, g one into the p rog ra m so y ou m a y
find id e a s for ne w com p e titions w hich F F P x ca n he lp y ou run.
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1

Getting Started

1.1

Conventions Used in this Guide
Menu and dialog box options are shown in a different font. When references are made to other parts of the guide, a page number
reference will be shown like this 8 .
The example windows and menus are generally taken from Film Free Projection Extended running under Windows 10, although where
there are differences between the various versions of Windows that affects the use of FFPx, the examples will be from 8.1, 8 or 7 as
appropriate.
Keyboard combinations are indicated by a plus ('+') sign. For example, if the guide says to press Ctrl+Home, that means to press the
Ctrl key and at the same time press the Home key.
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1.2

Setting up the PC
Introduction
FFPx is designed to be used on a computer with two monitors. The images are shown on the secondary monitor and the show is
controlled from the main, or primary, monitor. This may seem an esoteric set-up, but in fact most laptop computers have a port into
which you can plug a secondary monitor - the laptop's screen is the primary monitor. The ideal secondary monitor from our point of
view is a digital projector.
Using a second monitor is straightforward; when you plug in a second monitor Windows detects the new hardware and asks what
you want to do - for FFPx you want to extend the desktop.

Configuring the Second Monitor with Windows 10
When you connect a second monitor Windows 10 will usually automatically detect it and ask you what you want to do. You can
change the configuration of the second monitor by holding down the Windows key (between the Ctrl and Alt keys on most
keyboards) and tapping the P key; a panel slides in from the right asking you how you want to arrange the monitors; you want to
extend the desktop:
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To set the relative positions of the monitors, right click the windows desktop and select Display settings . The display settings dialog
appears:
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You can see the relative positions of the monitors at the top of the dialog and can drag them into their correct positions.

Configuring the Second Monitor with Windows 8.1
When you connect a second monitor Windows 8 will usually automatically detect it and ask you what you want to do. You can
change the configuration of the second monitor by holding down the Windows key (between the Ctrl and Alt keys on most
keyboards) and tapping the P key; a panel slides in from the right asking you how you want to arrange the monitors; you want to
extend the desktop:
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To set the relative positions of monitors, right click the Windows desktop and select Screen reso lutio n . The screen resolution dialog
will appear:
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You can see the relative positions of the two displays at the top of dialog; it's important to make sure these match the actual
positions of your setup - you can drag the monitors into the correct positions. For example, with a projector the projected image
display is usually above the laptop screen, so the layout panel should look like this:
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Configuring the Second Monitor with Windows 7
Windows 7 has simplified multi-monitor support compared with earlier versions of Windows. You can change the "projector mode"
of Windows 7 by holding down the Windows key (this key is between the Ctrl and Alt keys on most keyboards) and tapping the P key;
the projector options will appear and you can select Extend .
To adjust the relative positions of the displays, right click the desktop and select Screen reso lutio n . The screen resolution dialog will
appear:

This dialog is from a PC with two screens. If you have two screens connected but only one is working, try clicking the Detect button.
The second screen should be detected. Make sure the M ultiple displays option is set to "Extend these displays".
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You can see the relative positions of the two displays at the top of dialog; it's important to make sure these match the actual
positions of your setup - you can drag the monitors into the correct positions. For example, with a projector the projected image
display is usually above the laptop screen, so the layout panel should look like this:
If your computer has two monitors, then FFPx will assume you want images projected onto the monitor that FFPx isn't running on.
Congratulations! With the monitors configured thus, you should be ready to run FFPx.

Installing Film Free Projection Extended
The downloaded FFPx installation zip contains two files; double click the setup.exe file to run the installation.

Updating an Earlier Version
If there was an earlier version of FFPx installed, this earlier version will be automatically replaced by the installation process.
If you have FFP installed
If you have Film Free Projection (ie the non-extended version of the program) installed. FFPx will install in addition to the existing FFP
installation and you can run both if you want to. FFPx can read FFP sequences, but it can't save them. FFP can't read FFPx sequences.
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1.3

Running FFPx
To run FFPx, under Windows 7, go to the Start menu, select All Pro gram s , and under RGM M you should find Film Free Pro jectio n
Extended ; select that and Film Free Projection Extended will start.
To run FFPx under later versions of Windows press the Windows key to go to the Windows start screen and start typing film free
pro jec tio n extended ; almost certainly, Windows will offer you Film Free Pro jectio n Extended as an application as soon as you
type film . Once Film Free Pro jectio n Extended has been offered, press the Enter key.
A "splash screen" will be displayed showing the version number and who the program is registered to:

The example screen shown above is from a beta version; for the release version the BETA tag is removed. You can see the same
information from the Abo ut Film Free Pro jectio n Extended dialog which you can open by going the Settings tab on the ribbon and
clicking the More button on the Registratio n panel:
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FFPx on the Desktop
When FFPx is installed any user of the computer can run it and an FFPx icon is automatically added to the desktop. You can right click this icon
and pin it to the taskbar.

PC Settings whilst FFPx is running
If you need to adjust the screen settings whilst FFPx is running, select the W indo ws "Display Settings" dialo g... option from the Settings
tab on the ribbon. The Windows Screen Resolution dialog appears which allows you to enable the second monitor and set the relative position
of monitors. More information about the dialog is given here 9 for Windows 10, here 11 for Windows 8.1 and here 14 for Windows 7. Note
that if you are projecting an image or showing a test image, this will automatically be closed when this dialog is opened.

Unplugging the Projector whilst FFPx is running
Usually, and I speak from experience, this is something that happens accidentally. If the second monitor is unplugged whilst FFPx is running
then FFPx will detect this and switch to single screen operation. When the second monitor is reconnected, then FFPx will switch back to use the
second screen. However, Windows itself may try and "intervene" with the switching back and you may have to go to the Settings tab and
click the Use Seco nd M o nito r option to move the projected image onto the correct screen.
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1.3.1

The Ribbon

About the Ribbon
FFPx is largely controlled using a ribbon style interface at the top of the FFPx Window:

The FFPx ribbon consists of four tabs; File , Ho m e , Co m petitio ns and Settings . The File tab contains a drop down menu but selecting
one of the other tabs will display a different set of panels. Note that some panels have more buttons; for example, the Projector
panel on the ribbon shown above has a more button - these generally provide detailed setting information for that panel.
You can move panels either on their own tab or to a different tab (excluding the file tab) by right clicking the ribbon and choosing
M o ve a panel .
The ribbon control is very versatile; you can change the colour scheme of the ribbon by right clicking in the ribbon and selecting
Ribbo n Co lo ur Schem e from the menu that appears. You can also change the style of the ribbon; the default style is "2010", but
you can change the style to "2007" or "2013":

The Ribbon in "2007" Style
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The Ribbon in "2013" Style

Note that in the "2007" style, the File tab appearance is a circle (known as an orb); it's function is identical to the normal File tab.
The ribbon automatically adjusts its appearance depending on the size of the display; for example, on a small display it will appear
like this:

Hiding the Ribbon
You can hide the ribbon so that it appears as a list of tab titles by double clicking a tab title. Double click a tab title again to restore
the ribbon.
The Quick Access Toolbar
At the top of the ribbon is the quick access toolbar. The quick access toolbar can contain commonly used controls that will be visible
regardless of what tab is selected on the ribbon.
By default, the Projector button is available on the quick access toolbar, but you can put most controls on the quick access toolbar
(the exceptions are controls with drop down menus). There are several ways to move a control to the quick launch strip but probably
the easiest is to right click the control on the ribbon and select Co py to Quick Access To o lbar option.
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If you click the small arrow to the right of the toolbar, you'll see a drop down menu with common controls which you can add or
remove from the toolbar:

You can also choose the commands on the toolbar from the Custo m ise tab on the FFPx Settings Dialog (FIXME).
Restoring the Ribbon to Its Default Settings
You can restore the Ribbon to its default layout by right clicking the ribbon and selecting Reset ribbo n to defaults ; any moved
panels will be put back to their original positions and the quick access toolbar will be left with just the Projector option.
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1.3.2

The Start-up Options Window

When FFPx first starts or a new tab is opened the Start-up Options window will be shown:

The Start-up Options window contains commonly used functions and quick links to previously opened sequences.
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1.4

Adding Images
Adding Selected Images
To project images, you will need open an existing sequence, add some images or add a folder of images. To add images, you can select
the Add Im ages option from the File tab or Start-up options window. You will see the Open im age files dialog box:

You can select multiple images using the normal Windows techniques (for example, dragging the mouse cursor across several images
or holding the Ctrl key whilst clicking image names). Note that FFPx only supports JPEG or TIFF format files.
You can add more images to the sequence by selecting the Add Im ages option from the File menu, by adding a folder of images
(described below 23 ) or by dragging or pasting images into the sequence. The new images will be added to the end of the sequence.
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Adding Images from Other Applications
You can add images from other applications; for example you if you are viewing images using Windows Explorer, you can add those
images to FFPx by dragging the images into FFPx or by using Copy and Paste to paste the images into FFPx. You can drag and drop a
folder of images into FFPx; if you drop the folder into an existing sequence, the images in that folder will be added to the end of the
sequence. If you drop the folder into the background area of FFPx or if there is no existing sequence, then FFPx will create a new
sequence for the images. Note that subfolders will not be loaded and only one folder can be dropped at a time.

Adding a Folder of Images
As well as adding individual images, it is possible to add an entire folder of images. To add a folder of images, either select the Add
Fo lder o f im ages option from the File tab or the Start-up Options window. You will see the Open im age fo lder dialog box:

If a folder contains images, then if you "hover" the mouse pointer over the folder, FFPx will show the number of images within that
folder as a tooltip. However, if the folder contains subfolders, then the image count does not include any images within subfolders.
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At the base of the dialog is a dropdown menu with three options. These are:
Do n't Include Subfo lders ; with this option selected; only the images in the selected folder will be loaded.
Include Subfo lders ; with this option selected images in the current folder and subfolders of the current folder will be loaded.
Lo ad each subfo lder into its o wn tab ; with this option selected, images in the current folder and subfolders of the current folder

will be loaded, but each folder will be given its own tab and the images loaded into the appropriate tab for each folder.
Whilst images are being added, FFPx looks at the metadata 87 information associated with the image files to obtain extra information
about the image; including the author and title information.

Adding images to a Photo Entry based competition
You can't directly add images to a Photo Entry based competition; if you did, then Photo Entry wouldn't recognise the images when
you tried to update the scores. To add images to a Photo Entry competition, go to the Photo Entry website and add them there then
use the Load from Photo Entry option from the File menu.
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1.5

Moving Images
One of the jobs of the projectionist is to move images so that they are in an appropriate order; for example, title images will usually
have to be placed at the beginning of a sequence. There are two techniques that can be used:

Drag and Drop
In the example below, some images and a title slide have been loaded into FFPx - the title slide is, unfortunately, near the bottom of
the list of images:
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To move the title image (below number 6) to the top, drag it using the mouse until it is over the image you want it to replace; in this
case image 1. If image 1 isn't visible FFPx will automatically scroll the images as you approach the top of the form. When the mouse is
over image 1, release the mouse button and the title image becomes the new image 1 - all the other images are shifted to make
space.
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Moving Images in Light Box View Mode
It is also possible to move images in lightbox view mode; you may find it easier to move images in lightbox view as you can see most,
if not all the images simultaneously.

Cut, Copy and Paste
If you are moving images a long way, then you may find cut and paste an easier technique. As with the drag and drop example, we
want to move the title image to the top of the sequence. But with cut and paste, we right click the title image and select Cut from the
menu that appears:

The image will vanish from the sequence; it has been placed onto the Windows clipboard. Right click the first image of the sequence
and select Paste from the menu. The title image will be inserted at the position of the first image.
One advantage of cut/copy and paste is that you can select several images to be moved at the same time; hold down the Ctrl key on
the keyboard whilst and click each image you want to move; multiple images will be selected. Then use cut or copy as before to
move/copy the images to the clipboard; you can then paste all the images into position in one go.
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1.6

Projecting Images
Once you have some images loaded into FFPx - either by Adding Images 22 , Adding a Folder of Images 23 or by Opening an Existing
Sequence 49 - you can start to project the images. To do that, click the Pro jecto r On/Off button on the ribbon (by default, you'll find
a duplicate on the quick access toolbar). FFPx will start projecting the first image of the sequence.
If you have a projector or monitor connected to the laptop's second monitor port, and assuming that the laptop has been configured
correctly, then FFPx will use the second monitor to project the image. If there is no second monitor connected or configured, then a
window will open to show the image. If the laptop's screen is wide enough (at least 1024 pixels) then this window is placed alongside
the main FFPx window, otherwise it place on top of the FFPx window and is translucent so you can see any prompts that appear
behind the window.
If you have Multiple Projectors/Screens Connected
If you have the luxury of 2 (or more) extra monitors/projectors, then the image may not appear on the screen you want it to. If this
happens, go to the Settings tab on the ribbon select the screen you want to use from the Projector panel.

The Detailed View
The images are shown on the laptop screen as a table (this is called Detailed View mode); you can project any image simply by
clicking the appropriate row. For example, in the table below, the image with the title "St Katherine's Dock" has been selected by
clicking and that is the image that is projected.
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To move to the next image in the sequence, you can press the Enter key, the down arrow key or the Page Down key, to move to the
previous image in the sequence press the up arrow or Page Up key.
Constrained Mouse
When images are being projected, the mouse is constrained to the FFPx screen - this stops the mouse pointer accidentally appearing
on the projected image. You can turn off this constraint on the FFPx General Settings page.
300

To stop projecting images, click the Pro jecto r On/Off button again.
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1.7

Saving a Sequence
A sequence is automatically created when you add images. Each sequence is placed on a Tab and you can select the sequence to use
by clicking the appropriate tab. You can save the sequence by clicking the File tab and selecting
Save or by typing Ctrl+S. If the
sequence hasn't previously been saved then you will be asked to name the sequence using a file selector dialog. If the sequence had
been saved earlier (or is an existing sequence) then clicking Save will replace the existing sequence.
On the File tab the

Save option has a submenu of options; you can select Save As... , Save fo r m ulti-leg co m petitio ns , Save
sequence and im ages or Save All sequences and im ages . Going through these options:

Selecting Save As... will always ask for the sequence name.
Save fo r m ulti-leg co m petitio ns will open the Save Sequence fo r M ulti-Leg dialog; this described in more detail here 326 .
Save sequence and im ages saves the sequence and copies all the sequence images to a folder. This is intended to be used to

transfer a sequence to another computer; saving the sequence alone does not save the images.
Save all sequences and im ages is similar to Save sequence and im ages , except that every tab is saved.

FFPx has the facility to automatically save sequences, either when a score is entered or periodically; for more information see here

311

.

As well as the names and locations of the images files, FFPx also saves the locked and held back state of each image, any scores
recorded for the images, the scoring scheme and the competition mode. When you reload the sequence, it should be restored to be
exactly as you saved it.
If you have modified a sequence (for example, by adding images or scoring images) then when you exit FFPx, you will be asked if you
want to save the current sequence.

Saving Tab Sets
As well as saving individual sequences, you can also save a tab set - this contains all the currently open tabs. For example, you could
have two tabs (beginner and advanced), and save the tab set - both the sequences and tabs are saved. FFPx saves each tab as a
separate sequence file, so you can always load just one sequence at a later date.
To save a tab set, select Save as... from the File tab's Save menu and change the Save as type: drop down to Film Free
Pro jec tio n Extended Tab set:
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Now you can enter the name for the tab set.
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2

Using FFPx in Detail

2.1

The Home Tab
When running a competition, FFPx is largely controlled using the Home tab on the ribbon:

The Display Panel
The first panel on the Home tab is the Display panel (shown left). This has options to switch between
detailed view ( ) and lightbox view ( ). In lightbox view, you can choose to project the images on the
lightbox; you can select from projecting all the images, projecting all the images with numbers - so the
judge can refer to them or to project just the selected images.
There is also a drop down menu for shuffling or sorting images. This described in detail here

59

.

The Projector Panel
The Pro jecto r panel has controls for turning the projector on or off ( ), blanking the screen ( ),
projecting the shooting information for the image ( ), freezing the projected image ( ) and projecting a
test image. Going through these options; clicking the blank screen button will project a solid black image,
replacing whatever image is being projected.
Clicking the Shooting Information button will toggle the projecting of shooting information (exposure
time, aperture etcetera); you can see more about that here . Clicking the freeze projector button will
stop FFPx from changing the projected image if another image is selected; this is intended for the situation where the projectionists
160
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spots an error (for example, the author name or title might be misspelt) in an image. They can freeze the projector, correct the error
and unfreeze the projector by clicking the button again. FFPx will flash the button when the projector is frozen.
The Test Im ages button will project a built-in test image. Clicking the arrow by the Test Images button will open the test images
dialog.

38

The Projector button has a More button that opens the projector settings dialog.

The Thumbnail Size Panel
The Thum bnail size panel has a single control for setting the size of the thumbnail images in the detailed or lightbox
views.

The Score Panel
The Sco re panel contains controls for scoring competitions; you turn scoring on or off using the
Score button ( ). Note that for FFPx to accept a score for an image, scoring must be turned on and
the image must be projected.
To choose the scoring scheme for this competition, use the drop down menu on the panel. The Vo te
fo r im ages button is used to open the Vo te fo r Im ages
dialog which is used to calculate image scores based on audience votes.
217

The Image Information Panel
The Image Information panel contains controls for projecting extra information about the image; there are two
buttons ( and ) which toggle the projection of the image's Author and Title respectively. The Duration value
sets how long the information is shown for and the Size sets the size of the text.
The panel has a More button which opens the projected information dialog
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Held Back Images Panel
The Held Back Im ages panel contains controls for managing held back images; the Filter option opens the hold
back filter dialog; more about that is here 76 . The dropdown on the panel allows you to select what images are
shown (unheld images, held back only or all images). Finally, there is an Unhold all button that unholds all held
back images.

Automatic Slide Change Panel
The automatic slide change panel controls automatic projection of images. If the automatic slide change button (
) is clicked, then FFPx will show each image in turn starting with the currently selected image. You can stop the
automatic show at any point by clicking the button again. By default, the automatic slide change stops when the
last image in the sequence has been projected and FFPx will the return to showing the first image of the sequence.
However, by clicking the stop option (in the example above this appears as Sto p o n last im age ) you can select
from eight different options:
1. Stop on last image (the default).
2. Stop on locked image; this is useful if a competition is run in two sections. By placing a locked image - a title image of some kind between the two sections, you can select Automatic Slide change and run through all the first section and automatically stops
when it reaches the locked image.
3. Stop at end of panel. This is useful in panel competitions; as it automatically shows just one panel.
4. Stop at end of panel group. This is slightly more complicated to explain! Also used in panel competitions but in slide
mode - see the panels section for a description of these modes.

145

or cycle

146

144

5. Continuous slide show; the sequence is continuously shown until the automatic Slide change tick box is unchecked or the stop
option is changed.
6. Continuous slide show (all tabs); the current sequence is shown, when the sequence has been shown, the next tab is selected and
that sequence is shown and so on. When the last tab sequence has been shown, FFPx starts again with the first tab sequence.
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7. Full screen slide show; this option is only available if FFPx is being run on a computer with one screen or if the Use Second
Monitor option has been turned off in the Settings menu. If the Full screen slide show option is selected then a continuous slide
show is started; the images are shown full screen, so the FFPx window will disappear. A warning message is produced before the
slide show starts. Pressing any key will stop the slide show and return to the FFPx display. This mode is designed for exhibitions
where you want to show all the images as a continuous slide show.
8. Full screen slide show (all tabs); this is similar to the previous option except that the sequence on each tab is shown in sequence.
For all the stop options but the continuous, if the automatic slide change has shown the last slide in the sequence, FFPx will return to
displaying the first image and the automatic slide change stops.

Interval
The Interval up down control sets the time between images in seconds when using automatic slide change. This can be changed
whilst the automatic slide change is in progress.
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2.2

Test Images
Showing a Test Images
If you click the Test Im ages button on the Home tab on the ribbon then a test image will be projected - regardless of the state of the
projected image button. The idea is that you can check that the image from the projector fills the screen and to check that the
keystone of the projector is set correctly. FFPx has two test images built-in one for 4:3 screens, the other for 16:9 screens and will
automatically pick the appropriate one depending on your projector's aspect ratio. FFPx will expand the image to fill the projected
image, regardless of the resolution of the projector. If you have more than one extra screen, then you can select the screen you want
to use using the Select Screen to Use option from the Settings tab.
You turn off the test slide by clicking the test slide button again.

Choosing a Different Test Image
FFPx has two built-in test images and you can add up four of your own test images. For instructions on setting your own test images
look here .
301

Showing the Test Slide when FFPx Starts
On the FFPx Settings General tab there is an option to Sho w Test Im age o n Start . If this is checked, then FFPx will automatically
project the test image as soon as FFPx starts.
300
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2.3

Sequences

2.3.1

Detailed View

Most of the time FFPx is used with the Detailed View, the detailed view shows the image sequence as a table:
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Night Colour Scheme
By default, FFPx uses a white background and black text; on the Settings tab you can click the Use night co lo urs button - black
background with white text:
With the Night Colour Scheme turned on, the detailed view will use a colour scheme like this:
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The basic operation of FFPx is that you click the image you want to be projected. You can also use the up/down keys on the computer
to move up and down the sequence, Ctrl+Home will select the first image of the sequence, Ctrl+End will select the last image in the
sequence. Pressing Page Up will select the previous image, Page Down will select the next image.
For panel competitions; in detailed view, Ctrl+Cursor Up will take you to the start of the previous panel, Ctrl+Cursor Down will take
you to the start of the next panel. In lightbox mode, Ctrl+Cursor Left takes you to the start of the previous panel, Ctrl+Cursor Right
takes you to the start of the next panel.
Going through the columns in the table:
Number
This is the number of the image in the sequence; if an image has been held back then FFPx leaves a gap in the sequence number.
Status
This shows the state of the image. As well as the text, FFPx indicates the state of an image by changing the background colour. The
state can be one of:
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State
Locked

Meaning
The image has been locked

66

Default Colour Default Night
Colour

into position and is unaffected by shuffling

59

.

Light blue

Dark blue

Held

The image has been held back 67 , to see held back images, you can either tick
the Held Back Only tick box or select Show All from the toolbar.

Orange

Chocolate

Held and Locked

The image has been held back and locked.

Yellow

Heart Gold

Winner

This state only applies to knockout competitions; the winning images of a
knockout round are shown with a status of Winner.

Green Yellow

Sap green

Selected

This only applies to selection mode; selected images are shown with a state of
Selected.

Green Yellow

Sap green

Viewed

This only applies to selection mode; when an image has been viewed, the
background colour will change - the state field will not change.

Bisque

Tropical rain
forest

Bad Panel Name This state only applies to panel based competitions. It indicates that the loaded
image doesn't have a correct panel name .

Lime Green

Ao (English)

Image Resolution The image's resolution is larger than can be projected. FFPx will automatically
Larger than the shrink images to fit the projector screen, so these images will project correctly,
Projector's
but using images much larger than necessary slows down FFPx so it is good
Resolution
practice to use the Resize Image 64 option for these images.

Pink

Rose taupe

144

You can change the colour used for different states on the Detailed View settings

309

dialog.

Thumb
The Thumb column shows a thumbnail of the image. The size of the thumbnail can be adjusted using the Thum bnail Size slider
(above the toolbox).
Filename
This is the filename of the image.
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Author
The author name is obtained either from the image file or the image file name. The process is described in detail in the Author, Title
and Subject 87 section.
Title
Similarly to the Author name, the Title is also obtained from the image file or the image file name.
Subject
As with the Author and Title, the Subject is obtained from the image file or the image file name. The Subject column is not displayed
by default. To turn on the display, you can right click the header row of the detailed view table and turn on display of the Subject
column or use the FFPx Settings menu and select the Detailed View tab.
The subject field is used when scoring competitions which have a mixture of "set subjects". FFPx can calculate the score for individual
subjects provided that the Subject field is set to the appropriate subject.
225

Score
The score field is used to show the score awarded to an image. Scores of zero are shown as a dash ("-").
The format of the score depends on the scoring scheme in use. When there is one score per image and a score is awarded to each
image, then the score will be the number of points (for example, 8 or 9½). If there is more than one score recorded per image, then
the score will be shown as the list of scores and the total (for example, 7 + 8 + 7 = 22). Finally, for ordinal scoring schemes the
position is shown with the corresponding number of points in brackets (for example, First (10), Second (8) or Third (6)).
Votes
If you are using FFPx in Selection mode, then the Score column is replaced with a Votes column, showing the number of votes each
image has received.
Comment
The comment column shows any comments associated with the image. There is more about adding comments here

© 2 0 17 A n dre w Pe ppe r

75

.

43

44 Film Free Projection Extended

Configuring the Detailed View
You can control whether the Thumbnails, Filenames, Author names, Titles, Subjects or Comments columns are displayed by right
clicking the header of the table and selecting the columns from the menu that appears:

Alternatively, you can use the FFPx Settings
2.3.2

309

dialog.

Lightbox View

The alternative to the Detailed View
images in the sequence are shown:

39

usually used for FFPx is the Lightbox View mode; in this mode just the thumbnails of the

The lightbox view mode makes sorting images easier. If the mix & match competition is selected then FFPx only allows a lightbox
view.
As with the Detailed View, the size of the thumbnails can be adjusted using the Thum bnail Size slider.
In lightbox view mode, the state of an image is indicates by the background colour of an image; the colours are shown below:
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State
Locked

Meaning
The image has been locked

66

Default Colour Default Night
Colour

into position and is unaffected by shuffling

59

.

Light blue

Dark blue

Held

The image has been held back 67 , to see held back images, you can either tick
the Held Back Only tick box or select Show All from the toolbar.

Orange

Chocolate

Held and Locked

The image has been held back and locked.

Yellow

Heart Gold

Winner

This state only applies to knockout competitions; the winning images of a
knockout round are shown with a status of Winner.

Green Yellow

Sap green

Selected

This only applies to selection mode; selected images are shown with a state of
Selected.

Green Yellow

Sap green

Bad Panel Name This state only applies to panel based competitions. It indicates that the loaded
image doesn't have a correct panel name .

Lime Green

Ao (English)

Image Resolution The image's resolution is larger than can be projected. FFPx will automatically
Larger than the shrink images to fit the projector screen, so these images will project correctly,
Projector's
but using images much larger than necessary slows down FFPx so it is good
Resolution
practice to use the Resize Image 64 option for these images.

Pink

Rose taupe

144

You can change the colour used for different states on the Detailed View settings

309

dialog.

As well as the colour, the state is also indicated by the tooltip which is displayed when the mouse hovers over an image.
The Im age To o ls window which appears under the toolbox can be used to manipulate the projected image and to move projected
labels; this is described in more detail here 79 .

Projecting the Lightbox
If the projector is turned on and using the second monitor, you can project the images on the lightbox by selecting one of the
projection options on the lightbox area of the toolbox:
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If Pro ject lightbo x is selected FFPx automatically resizes the images so they all fit on the projected screen. Because of this, if you have
a large number of images, the thumbnails will be small and it may take several seconds before the projected images appear. The
projected lightbox view looks like this:

If you select Pro ject with num bers then the projected lightbox thumbnails have numbers superimposed upon them:
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On the lightbox view itself, numbers are also superimposed. This allows the judge to refer to images by number and the projectionist
to know which images they are referring to.
If Pro ject selected is selected, then only the selected images on the lightbox will be projected.
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2.3.3

Status Panels

To the right of the image views (detailed or lightbox), FFPx shows status information about the selected image:

Going through each panel; the Image Count shows the number of images in the sequence. If there are any title or blank images, these
will be shown separately.
The Held Back panel shows the number of held back images. There is a More button on the panel which opens a menu offering
options to display unheld images (the default), held back only, all images or to unhold all held back images.
The Scoring Scheme panel shows the name of the current scoring scheme. The More button on the Scoring Scheme panel opens a
menu for scoring:

From this menu, you can show the results, open the Vote for Images

217

dialog or select another scoring scheme.

The Author's Name panel shows the author associated with the current image. If you click the More button on the Author's Name
panel then a dialog appears which lets you edit the author, title and subject information for the image:
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Note that this dialog will modify the image file's metadata.
The shooting information panel shows the shooting information retrieved from the image file; in the example above we can see the
image was taken using a Nikon D7000 camera at ISO 320. The exposure was 400 at f8. Aperture priority was selected and the lens
was set to 300mm focal length.
The Errors panel shows any errors; this is only used for panel competitions where the number of invalid file names will be shown.
2.3.4

Open Existing Tab Set or Sequence

From within FFPx
Once you have saved a sequence or tab set, you can reload it by selecting Open from the File tab or by clicking the Open Existing
Sequence option on the Start-up Options window. FFPx will open a standard file selector dialog:
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Sequences are stored as a .ffpx type file, tab sets are stored as .ffpx-ts type files. You can change the type of file to load from the file
type dropdown; FFPx can also read .DSS sequence files (from Film Free Projection).
When you have selected a sequence or tab set file and clicked Open , FFPx will create a new tab and load the sequence(s); note that
FFPx stores the name and location of each image file - not the actual images, so if you have renamed, moved or deleted any of the
images files then FFPx will produce an "Problem Loading <filename>" error message.
If you want to move an entire sequence, including the images, to another machine use the Save Sequence and Im ages 30 facility.
Similarly, if you want to move an entire tab set (all the current tabs, sequences and images) use the Save All Sequences and
Im ages 30 facility.
As well as the image names and locations, the sequence files contains the type of competition (InterClub, Mix & Match and so on)
and the scoring scheme used for scoring the competition.
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If the scoring scheme saved with the sequence doesn't exist, then FFPx will add it to the list of scoring schemes. If you have an
existing scheme with the same name as the scheme saved with the sequence, then FFPx will check if the saved sequence is different
and, if so, create a new name for the added sequence.
For example, you create a sequence and select a scoring scheme called "ByAuthor" to score it. You save the sequence.
You decide to change the "ByAuthor" (for example, you change the minimum score from 0 to 1).
When you load your saved sequence, FFPx finds that the "ByAuthor" scheme being loaded is different from the existing one, it adds
the loaded sequence with the name "ByAuthor(1)" and uses that sequence to score the sequence - unless you use the Select
Schem e to Use... option from the Sco re menu to change it.

From Windows Explorer
You can also load a sequence from Windows Explorer by double clicking the sequence file. From within Explorer, FFPx sequences
appear with an FFPx or FFPx tabset icon, for example:
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You can double click a sequence file and Windows will automatically start FFPx (if it isn't already running) and load the sequence file.
You can also drag and drop sequence files into a running version of FFPx.
You can right click the FFPx icon in the taskbar to see recently loaded sequences:
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If you are using Windows 7, then the operating system remembers recently used sequence files and these can be opened from the
Start menu.

If the images have moved
If the folder containing a sequence's images has been renamed or moved, then FFPx won't be able to load those images. FFPx asks if
you want to "find" an image if it can't be loaded:

If you know where the image is, click the Find file button and you can navigate to the folder containing the image, select the image
and FFPx will load it. If subsequent images can't be found, FFPx will check the selected folder to see if the missing images are in there.
Clicking Skip causes FFPx to ignore the image. Clicking Skip all m issing files causes FFPx to ignore all the missing files.
If you have successfully used the Find file option, then after the sequence has been loaded you'll be asked if you want to save the
sequence with the new image paths; clicking Yes means that the next time you load the sequence, the image files should be found.
2.3.5

Discarding Sequences

To remove the current sequence, click the small cross on the right hand side of the sequence tab:
If there are images associated with the tab, you will be asked to confirm the discard; clicking OK will remove the sequence and the
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associated tab. If there is only one tab and you close that tab, FFPx will return to its start up state.
2.3.6

The Context Menu

In both the Table and Lightbox views, a context menu is available. To display the context menu, right click an image:

The actual entries available on the context menu depend, to some extent, on the competition type and whether the image has been
scored.
Going through all the possible menu options:

Hold Back
This option is used to hold back

67

the selected image.

Lock
This option is used to lock

66

an image into position. If an image is locked then it won't be affected by shuffling the images.
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Unlock All
If there are "locked" images, then this option allows you to unlock all locked images in the sequence.

Insert
The insert option has a submenu:
Blank
This option inserts a blank image (a solid black image) into the sequence at the current image position.
Blank Every...
This option inserts a blank image every n images.
Title Image...
This option opens a submenu that lets you insert a pre-defined title image into the sequence. You can see more about title images
here 70 .

Change Club Name...
If a title image is selected, then this option allows you to change the camera club name that's projected on some title images.

Change Competition Name...
If a title image is selected, then this option allows you to change the competition name that's projected on some title images.

Change Judge Name(s)...
If a title image is selected, then this option allows you to change the judge name(s) that's projected on some title images.

Add Comment...
Selecting the Add Co m m ent... option will produce the Co m m ent dialog:
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The Co m m ent dialog allows you to add a comment to an image; there is more about commenting here

75

.

Resize selected to fit projector
If an image is larger than required to fit the projector resolution, this option allows you to resize the image to fit the projector
resolution.

Rotate
This option displays the Ro tatio n menu which allows you to rotate or flip

64

images.

Ambiguous Metadata
This option will be visible if FFPx has detected ambiguous metadata. Metadata can be stored in three different locations in an image
file, IPTC, XMP and EXIF (there is more about the different formats here 87 ). If there is contradictory data - for example, if the EXIF
author name is John but the XMP author name is Jane - then the metadata is ambiguous and you can select the Am biguo us
M etadata option to resolve the problem; essentially by selecting the data you prefer to use. The Am biguo us M etadata dialog is
described here .
106
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Select...
The Select... option allows you to select images based on particular criteria:
All; all the images are selected.
Deselect All; all the images are deselected.
All with this Score; all the images with the same score as the current image are selected.
All by this Author; all the images with the same author name as the current image are selected.
All with this Subject; all the images with the same subject as the current image are selected.
All Locked images; all the locked images are selected.
Invert Selection; any selected images are deselected, any deselected images are selected.

Cut, Copy, Paste
These options are used to move images within the sequence. The process is described here

27

.

Selections
The Selections submenu is used if you are using FFPx in Selection

257

mode.

Panels...
This menu option only appears during panel based competitions; it drops down a Panels menu which allows you to select all the
images in a panel or to sort the panels by score. See Panel Based Competitions for more information.
144

Knockout Winner
This option is used during Knockout

120

competitions to change whether an image has won or lost a knockout round.

Clear Score(s)
If an image has a score associated with it, this option will be visible and can be used to clear the score. For most scoring schemes you
can give an image 0 points to clear the score. However, for placed based competitions this isn't possible so the Clear Sco re option

© 2 0 17 A n dre w Pe ppe r

57

58

Film Free Projection Extended

should be used to remove a "place" allocated to an image.

Rename Image File
This option is used to rename the image file; this is mainly used for panel competitions to correct misnamed files.

Delete
This option deletes the selected image.

Text Size...
The Text Size option opens a slider to adjust the text size of the detailed view table.

Detailed View Settings...
Open the FFPx settings dialog on the Detailed view tab.

Properties
This option is used to display the EXIF, XMP or IPTC

87

properties associated with an image.
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2.4

Images

2.4.1

Shuffling and Sorting Images

A common requirement for camera club competitions is to randomly shuffle images; clicking the shuffle ( ) button on the Home tab
will arrange all the images in a random order - except for locked images 66 . If an image is locked then it keeps its position in the
sequence; this is intended largely for title and end images - you can place a title image at the start of the sequence and an End image
at the end, lock these two and click the shuffle button. All the images will be randomly arranged, except for the first and last images.

Multi-Leg Competitions
For Multi-Leg competitions, it is vital if the final scoring is to be accurate that images aren't moved, to ensure this - or at least to
make it very difficult! - FFPx disables the shuffle/sort options if the sequence is from a Multi-Leg competition.
139

Shuffle Options
As well as "straight" shuffling, there are a number of sorting/shuffling options available. Clicking the drop down arrow under the
shuffle button displays the options:

Going through these options:
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Sort by File Name
As you might expect, this sorts the images alphabetically by file name. You can also sort the sequence by score by clicking the
Filenam e heading at the top of the Detailed View table.
Sort by Author
This sorts the images alphabetically by author name. You can also sort the sequence by score by clicking the Autho r heading at the
top of the detailed view table.
Sort by Author Surname
This is similar to the "sort by author" option except that FFPx looks for each author's surname and sorts alphabetically by that.
Sort by Score
This sorts the image by score with the highest scoring image first. You can also sort the sequence by score by clicking the Sco re
heading at the top of the detailed view table.
Sort by Subject
Clicking So rt by Subject... will open the Select Subject Order dialog:
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This dialog is used to select the order you want the sequence sorted into. For example, if you are running a competition with two
"set" subjects of "portrait" and "landscape" with other images going into "open", you may want to judge all the portrait images first,
then all the landscape and finally the open. Using the Select Subject Order dialog you can use the Move Up/Move Down buttons to
move the selected subject into position and when everything is correctly placed, click the So rt Im ages button to sort the sequence
into the subject order you've specified.
Sort by Comment
The So rt by Co m m ent option will sort the sequence into alphabetic order of comment. You can also sort the sequence by comment
by clicking the Co m m ent heading at the top of the detailed view table.
Sort by Highest Score for Each Author
This option sorts the images by the highest score for each author, then the second highest score and so on. For example, there is a
small competition with 3 entrants Andrew, Bill and Charlie. They receive scores as follows:
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Author
Andrew
Andrew
Bill
Charlie
Bill
Charlie

Score
6
9
8
9
9
7

After sorting by highest score, the table sequence will be:
Author
Andrew
Bill
Charlie
Andrew
Bill
Charlie

Score
9
9
9
6
8
7

Group Authors Together and Sort by Subject
This option will group the images by author name, but sort each group by subject. The groups are randomly shuffled. This sort option
is used by the Selection mode.
257

Distribute Author Names
This option will sort the images trying to keep the author names separated as much as possible.
Shuffle but Keep Author Order
With this option, FFPx shuffles the images but keeps the original order of individual images. To explain; suppose an author enters
three images (called One, Two and Three for simplicity's sake) and as projectionist, you load these images in the order One, Two and
Three. After a "normal" shuffle, these images could end up anywhere in the sequence and the author's original order is lost. Using the
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Keep Author Order shuffle option, the images are moved but the author's order is maintained.
Shuffle but Sort Author's Images by Subject
With this option, FFPx shuffles the images but keeps the original subject order of individual images: Imagine that an author enters
three images with the subjects of Portrait, Landscape and Open. As projectionist, you load these images in the order Portrait,
Landscape and Open. After a "normal" shuffle, these images could end up anywhere in the sequence and the author's original order is
lost. Using the Keep Author Subject Order shuffle option, the images are moved but the author's subject order is maintained.
Knockout Mode
If FFPx is running a knockout competition, then the shuffle function will try and stop pairs of images being by the same author.
Shuffling is performed automatically at the start of each knockout round, so there is normally no need to use the shuffle command
"manually" during the knockout competition.
Panel Mode
If FFPx is running a panel based competition, then the Shuffle button will shuffle the panels but not the images within each panel, so
the order of the panels will change but the images will be kept in "panel" order.
Selection Mode
If you are in selection mode and have checked the Gro up im ages by autho r and so rt by subject option on the Selection Dialog ,
then clicking the Shuffle button will move the author groups around but keep the images grouped by author. If the Gro up im ages
by autho r and so rt by s ubject option is not checked, then clicking the shuffle button will perform a regular shuffle.
261
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2.4.2

Rotating Images

To rotate an image right click an image. You'll see a rotate image option; click that to get the rotate menu:

You click the rotation option you want. When you rotate an image the original image file is modified, so it's recommended that you
only use copies of the images for competitions - this is the usual way of operating in any case. A side effect of this is that it is not
possible to rotate read-only images (such as those stored on CD).
You can temporarily rotate a projected image using the Image Tools
2.4.3

79

Window.

Resizing Images

If images have a larger resolution than the projector supports, FFPx will automatically shrink the displayed image to fit the projector
resolution . However, it is good practice to resize the images to fit the projector resolution; it makes then images load and project
faster.
307

When you load images into FFPx, they are automatically compared in size to the projector resolution. If an image is larger than
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necessary, then the background colour of the image's row in the detailed view is shown in pink. You can resize an individual image by
right clicking and selected the Resize selected to fit pro jecto r option:

If a sequence has images that are too large within it, then the sequence title will have a "»" character added. You can right click the
sequence title and select Resize All Im ages to Fit Pro jecto r from the menu that appears.
If the projector hasn't been opened or if the projector resolution is less than 1024x768 then FFPx doesn't offer the resize options. You
can set the projector resolution using the Settings dialog .
307

If an image is being projected then FFPx cannot resize it.
2.4.4

Deleting Images

To remove an image from the sequence, you can select the image and press the delete key. You can also right click an image and
select Delete from the menu that appears.
You can delete multiple images by holding down the Ctrl key whilst clicking them with the mouse and pressing the delete key to
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remove them all. You can delete all the visible images by pressing Ctrl+A and then pressing delete; only the visible images will be
deleted - if there are held back images and Sho w All and Held Back o nly are not selected, then the held back images will not be
deleted.
If you delete the last image in a sequence, then the tab associated with that sequence will be removed.
Note that the image file is not being deleted; the image is only being removed from the FFPx sequence.
2.4.5

Locking Images

If an image is locked then its position in the sequence is not affected by clicking the Shuffle/So rt button . This is usually used for
title and end images that are always in the same position in the sequence. To lock an image right click the image you want to lock;

and select Lo ck from the menu that appears. To unlock an image that is locked, right click and select Lo ck again.
If an image is locked then, in detailed view mode, the colour of the row changes and the status of the image is shown as "Locked". If
you are working with the lightbox, then you will see the status of the image as "locked" as a tooltip when the mouse hovers over the
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image.
A tip for held back images; if you have a title image which introduces the held back images then you can place that at the front of the
sequence, lock it and hold it back - it won't appear in the normal sequence, but it will appear as soon as you switch to Held back only
images.

Locked Images and Scoring
Locked images are treated differently from normal images; if an image is locked then FFPx assumes it is a title slide and
will not insist on the image having an author name set even if the scoring scheme would normally require that all images have
author names set.
Will not include the image in the results summaries.
The automatic slide change can be set so that it stops when it meets a locked image.
2.4.6

Holding Back Images

During a competition, the judge will often ask for an image to be "held back". This groups together the images the judge particularly
likes for marking at the end. This is easy with FFPx.
During a competition, you will have a list of images such as this:
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As an example, suppose the judge has just talked about the fourth image in the sequence - the row that is currently selected, however
instead of giving it a mark he decides to "hold it back", you press the space bar on the computer; the image will disappear from the
list of images and the next image will automatically appear. You can choose to show just the held back image by choosing the Held
back o nly menu option in the Held back images panel on the Home tab, or from the menu associated with the Held Back status
panel.
To see the held back images together with the non-held back select the Show all option from the Held back images menu or Held back
status panel menu.
You can "unhold" all the held images by clicking the Unho ld All button on the Home tab or by selecting the Unho ld all im ages
option from the Held Back status panel menu.
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2.4.7

Selecting Images

You can use the "standard" Windows selection techniques to select images; holding down the Ctrl key allows you to select multiple
images by clicking each image you want to select. You can also select a block of images by clicking the first image of the block you
want to select then holding down the Shift key and click the last image of the block; all the images in the block will be selected.
More sophisticated selections are available on the Select... submenu of the context menu:

Going through the options on the Select... submenu:
All; this selects all the images.
Deselect All; this deselects all the images.
All with this Score; this selects all images with the same score as the current image.
All with Score Lower than...; this selects all images with a score below the score of the current image.
All by this Author; this selects all the images by the same author as the current image.
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All with this Subject; this selects all the images with the same subject as the current image.
All Locked Images; this selects all the locked

66

images in the sequence.

Invert Selection; any selected images are deselected, any unselected images are selected.
2.4.8

Title Images

Title Images are images that FFPx can generate to give extra information to the viewers. For example, they can be used to introduce
competitions, indicate the time for a break or the end of a competition.
FFPx comes with four built-in title images; Welcome, Break time, End of Competition and Held Back Images and it's easy to add new
title images for your own requirements.
To insert a title image into a sequence, you right click where you want the title image to appear in the sequence and select Insert
Title Im age... from the context menu that appears. For example, to insert the Welcome title image:
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To insert an image at the end of the sequence, right click after the last image of the sequence - a smaller context menu appears that
allows you to insert title image or blanks at the end of the sequence.

More about Title Images
Title images are always inserted locked into position - they are unaffected by shuffling.
It is possible to hold back title images; for example, the Held Back Images title image is automatically held back.
Title images usually contain "custom" information - such as the camera club name, competition name or judge(s)'s name.
If the custom information has not been defined then when you try and project a title image, you will be asked for the
information.

Managing Title Images
To customize the built-in title images or to create new title images, select the M anage Title Im ages option from the context menu
(shown above). The Setup Title Im ages dialog will be displayed:
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Going through the dialog; the top left shows a preview of the current title image. Under the preview, you can change the background;
note that changing the background affects all the title images.
There are three types of background for title images; built-in images, a solid colour or an image file.
Under the Title Image Background box is the Font for Titles area; clicking the Fo nt... button will open the font select dialog; this lets
you choose the font face and colour used for title image text; it affects all title images.
Going through the large Image Options area on the right hand side of the dialog:
You can choose the title slide you're working on by selecting an option from the Existing Title Im ages dropdown.
The M ain text fo r im age area lets you set the text for the particular title image.

© 2 0 17 A n dre w Pe ppe r

Using FFPx in Detail

If the Sho w club nam e is checked, then the club name appears at the top of the image.
If the Sho w co m petitio n nam e option is checked, then the competition name is shown under the main text.
If the Sho w to day's date option is checked, then today's date is shown.
If the Sho w judge nam e is checked, then the judge(s)'s name will be shown.
If the Sho w num ber o f im ages rem aining is checked, then the number of images in the sequence after the current title image will
be shown. Note that title images and blanks are ignored when calculating the images remaining.
If the Sho w to tal num ber o f im ages option is checked, then the total number of images in the sequence (ignoring title images and
blanks) is shown. Note that this option combines "intelligently" with the Show number of images remaining option to form a single
line of text.
If the Ho ld back this title im age option is checked, then the title image will be automatically "held back" when it is inserted into a
sequence.

Creating Title Images
To add a new title image, click the New title im age... button. You'll be asked for the name of the new title image.

Deleting Title Images
You can delete the current title image by clicking the Delete this title im age... button. You'll be asked to confirm the delete.

Renaming Title Images
You can rename the current title image clicking the Renam e title im age... button.

Restoring the Default set of Title Images
To go back to just the default, built-in, set of title images, delete all the title images; the built-in set will be restored.

Competition Information
Title images such as the Welcome image contains competition and club information; by default it will show the club name, the name
of the competition, the judge(s)'s name(s) and the number of images in the competition. When you first project a title image, you will
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be asked for the information:

FFPx will save the club name and assume that the name doesn't change from competition to competition. The competition and
judges' names will also be saved but as these are likely to change between competitions, you will be asked for these each time you
run a competition - FFPx offers previously used names as you start to enter the information.
Changing Competition Information
You can change competition information by right clicking a title image; you'll see options to change the club name, competition name
or judge(s) name:
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2.4.9

Commenting on Images

When an image is selected, you can add a comment either by typing "C" or by selecting Add Co m m ent... from the Context Menu
Either way, you will see the Co m m ent dialog:

54

.

The Co m m ent dialog shows a thumbnail of the image and the author, title and subject information.
You type the comment into the comment field. The drop down arrow on the comment field shows previous comments for other
images and you can select a previous comment from the drop down. Also, as you type, FFPx will prompt you with "matching"
comments to what you have typed.
At the base of the dialog is a Sho w Co m m ents in Detailed View checkbox; if you add a comment this will be automatically checked
as, presumably, you want to see the comments.
Clicking OK will save the comment in the sequence. Clicking Cancel will abort the Co m m ent dialog.
Comments are not stored as part of the image but as part of the sequence (.DSS) file. So to save the comments, you must save the
sequence file.
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2.4.10 Hold Back Filter

The Ho ld Back filter can be used to hold back images based on a variety of criteria. For example, suppose you have just held a
competition and at the end of the evening, you would like to show all the images that scored more than 8 points. The hold back filter
makes it easy to hold back all the images that scored fewer than 8 points, leaving just the images with more than 8 points to be
displayed.
To use the Hold Back Filter, click the Ho ld Back Filter button on the Toolbox. The Ho ld Back Filter dialog will be displayed:

In the example we gave above, we wanted to hold back all the images that scored fewer than 8. To do that, we type "7.5" into the
M ax Sco re textbox and check the Apply checkbox; the dialog now looks like this:
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Notice that the M atches field shows the number of images that will match this particular filter. To perform the hold back, we click
the Ho ld Back Filtered Im ages button and then click Exit .
You can combine any of the fields, for example you could set the filter to hold back all the images by the author "Andrew Pepper"
with a score of 9 or above with a subject of Portrait:
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Note that you have the option to Ho ld Back apart fro m the filtered im ages ; this will hold back all the images that don't match the
filter.

Multiple Filters
Up to 8 filters can be defined. You can use multiple filters for more sophisticated tasks; for example, to hold back the images from
Andrew Pepper or Dale Frank that score more than 8, we add a new filter (by clicking the Add Filter button) and set them as below:
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"Unhold" All
The "Unho ld" All button allows you to set the state of all the images to "Unheld".
2.4.11 Image Tools

The Image Tools window is used to temporarily change the projected image. It's also used as a preview window - it shows the image
that's being projected. Using the Image Tools window, you can crop the image, zoom in on part of the image, flip the image, change
the brightness of the image, display a "thirds" grid on top of the image and move a cross hair on the image. In addition, you can show
the original image alongside the modified image so the audience (and judge) can compare the effect.
You can always remove any of the added affects by clicking the preview image.

The Image Tools Window
The Im age To o ls window is always displayed to the right of the image table:
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The Im age To o ls window shows the currently projected image, including the Author, Title and Subject information (if the
appropriate metadata projection is turned on).

Cropping Images
You can crop the projected image by dragging the edge of the image on the Im age To o ls window. For example, imagine the image
below is being projected. The ever wise judge points out that the sky is boring and adds nothing to the image;

by dragging the edges of the image using the mouse, you can change the image to look like this:
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The projected image will change to reflect the new crop.
Note that the cropping is not saved, nor does it affect the original image.
You can remove all cropping by clicking the image in the Im age To o ls window.

Zooming into Part of the Image
To zoom into part of the image, use the mouse to drag a rectangle across the preview image in the Im age To o ls window. A dashed
rectangle will appear on the preview and also on the projected image. When you release the mouse button, the projected image will
zoom to the rectangle you've drawn. The dashed rectangle will remain on the preview image. For example, in the preview image, I've
dragged a rectangle around the three urns:
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The Image Tools
On the left side of the Image Tools is a tool strip:

Going down the strip:
Help
The help button displays help; explaining how to use the cropping and zooming tools.
"Thirds" Grid Tool
Clicking the "thirds" icon ( ) will add a "thirds" grid to the projected (and preview) image:
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The Brightness Adjustment Tool
Clicking the adjust brightness icon (

) drops down a slider tool to adjust the brightness of the projected image.
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Rotate Projected Image
Clicking the Rotate Projected Image icon (

) opens a menu to choose to flip the image horizontally or vertically.

Project a Pointer
Clicking the Project Pointer icon ( ) adds a crosshair cursor to the projected image. As you move the mouse cursor on the preview
image, the projected cursor also moves - so you can use this to point to particular parts of the image.
Compare with Original
Clicking the Compare icon ( ) projects the original image alongside the adjusted image so that the audience (and judge) can
compare the modified image with the original. For example, for the image below the original is on the left, the modified version has
been zoomed and flipped horizontally.
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Swap the Tool Strip Dock
Clicking the change dock button (
) will move the image tools strip to the right hand side of the preview image. For some laptops,
the tool strip can be hidden by the pop-up score window; changing the dock to the right hand side will prevent that.

Moving Metadata
The Im age To o ls window can also be used to move projected metadata. As you will recall, metadata is extra information about the
image. For example, for the following image, the display of title is turned on. Unfortunately, it happens that the title is placed directly
in front of the ladies' faces in the photograph:

On the Im age To o ls window, you can drag the metadata away from the faces:
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The projected image will change to reflect the changed position of the metadata. As with cropping, the change is temporary and when
the next image is projected the metadata will be in its usual position. It is possible to permanently change the position of projected
metadata in the FFPx Settings dialog.
307

2.4.12 Image Information

For scoring most competitions, FFPx will usually need to know the author of each image, in addition many clubs insist on images
having a title and, for set-subject competitions the subject of the image is also required. As we've said before, this kind of information
about the image is called metadata. FFPx can obtain metadata using three systems:
1. From the contents of the image file; as well as the actual image, there are places in the image file to store metadata. When a
digital camera takes a photograph, it usually saves "shooting" information - such as exposure, aperture, camera model and so on as part of the image file. It's also possible to set the author name, image title and image subject within the file.
2. From the file name; with this system, the author, title and subject are made part of the file name. So an image called (for example)
Snowdrop by Andrew - Portrait.jpg - would be (once the appropriate settings have been made) interpreted by FFPx as having the
author name "Andrew", the title "Snowdrop" and the subject "Portrait".
3. From the Photo Entry online system; author and title information is associated with each image.
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FFPx can be configured to use either of the first two systems, or a combination - if the image file contains the information, it is used,
but if it is missing then the file name is used instead. Competitions created using Photo Entry will always use the information
provided by Photo Entry.
You configure which system you want to use by selecting the More button on the Obtaining Im age Info rm atio n panel from the
Settings tab on the ribbon.
Technical Background - EXIF, XMP and IPTC
EXIF, XMP and IPTC are systems for storing metadata as part of an image file.
EXIF is an acronym for Exchangeable Image File Format (well nearly!) and is a widely supported standard for storing information in
image files. Most digital cameras store detailed shooting information within the image using EXIF. As well as shooting information, it
is possible to store a range of extra information; for our purposes the author, title and subject are the most useful. Also, some DSLRs
allow you to set the author name automatically.
XMP is an equally dodgy acronym for Extensible Metadata Platform. XMP was developed by Adobe and, as the name implies, is easier
to extend than EXIF. To get slightly technical, XMP uses a description language called XML which is a highly flexible and, as the name
implies, extendible information storage system; all the versions of Windows after XP uses XMP by preference (XP used EXIF). As with
EXIF, XMP provides the facility for storing the Author, Title and Subject for an image.
IPTC is a, surprising successful, acronym for International Press Telecommunications Council. Adobe Photoshop stores metadata
using both IPTC and XMP.
One complication is that an image can have any or all of EXIF, XMP and IPTC data attached so there are three places where the
Author, Title and Subject might be stored. In most cases, the information is only in one area and FFPx will use whichever area has the
information set. If there are images with different metadata in the different areas then there is an Am biguo us M etadata dialog which
makes it possible to decide which to prefer for particular images.
Viewing and Setting with Windows 7
Windows 7 made viewing and setting image metadata easier than earlier versions of Windows. To view and/or set the metadata you
need to open Windows Explorer:
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Double clicking Documents will open Explorer.
Press the Windows key (found between the Ctrl and Alt key on most keyboards) and, keeping the Windows key held down, press E
to open Explorer.
With Windows 7, you can right click the Start button and choose Open W indo ws Explo rer from the menu that appears.
Now you can navigate to the folder which contains images and click an image; the metadata appears at the base of the Explorer
window:

You can set the Author, Title or Subject by clicking the appropriate field at the base of the Explorer window (the area is called the
Details pane). For example, the metadata below has been set with the Author as Andrew, Title as All Saint's in the Snow and the
Subject as Landscape:
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Note that a Save button has appeared; to set the metadata, the Save button must be clicked - that will set the metadata for the
selected image.
If the Details pane isn't visible, then you need to turn it on - in the Organize drop down, there is a Layo ut submenu that should
allow you to turn on the Details pane.
Multiple Images
You can set metadata for multiple images; for example, you can set the author fields for all the images in a folder by selecting all the
images and setting the Author metadata - clicking Save will set all the images to have that Author.
Viewing and Settings with Windows 8 and later
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Windows 8's version of Explorer has changed to use the ribbon style interface. There are several ways to open Explorer; two common
ways are:
Click the Folders icon in the Windows taskbar -

,

Hold down the Windows key (between the Ctrl and Alt keys on most keyboards) and at the same time press the "E" key.
Once Explorer opens, you can navigate to the folder containing your images.

As you can see, the image metadata appears in the Details pane alongside the images when you click on an image. If you can't see the
Details pane, then select the View tab on the ribbon and make sure the Details pane is selected:
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You can set the metadata by typing into the appropriate field in the Details pane; for example, to set the Title, click alongside the
Title: field in the details pane and type the title you want. When you click the field, a Save button will appear which you can click to
save the changes to the metadata.
Multiple Images
You can set metadata for multiple images; for example, you can set the author fields for all the images in a folder by selecting all the
images and setting the Author metadata - clicking Save will set all the images to have that Author.
Setting on the Macintosh
Setting image metadata with the Macintosh is not easy. It is possible to set the EXIF information using the sips tool in the command
window. To access the command window, you use the Term inal program - under Applicatio ns /Utilities .
Although it's possible with sips , it isn't recommended. There are easier ways:
Use the File Name
Probably the easiest way for Macintosh users is to use the file name to hold the author/title/subject information; this is described in
more detail here 98 .
Use Photoshop
Most photographers will be using Photoshop (or a similar image manipulation package). The procedure for setting metadata with
Photoshop is described below 95 .
Use XnView
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XnView is a utility program which is available for MacOS, Windows and Linux. Although it's mainly intended for viewing information
about images, it is possible to set metadata, in particular the Author and Title.
You can download XnView from the www.xnview.com website. Once installed on your Mac, run the program and you can navigate to
your images. Select the image you want to change and from the Edit menu select the M etadata... submenu and then Edit IPTC
data... .
The Edit IPTC Dialo g appears (the examples below are from the Windows version):

The Caption area on the dialog corresponds to "Title", so enter the title for your image there. To set the Author name, select the
Credits tab:
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The Byline area corresponds to the Author name; enter your name in the Byline area to set the Author name.
Click W rite to update the metadata for the image.
One restriction of XnView is that it can't set the "Subject" field for an image.
Use Online Entry Systems
Any computer that has access to the Internet with a browser can be used with the FFPx Online Entry System
system.

112

or the Photo Entry

113
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Metadata Within FFPx
To examine the metadata associated with the current image with FFPx, click the More button on the Autho r's Nam e status panel:

This will open the m etadata dialog:

You can set the metadata values of Author, Title and/or Subject using the m etadata dialog, note that if the image file is read-only you
will not be able change the metadata and that FFPx will only change the EXIF area of an image.

Setting Metadata with Photoshop
Adobe Photoshop uses both the IPTC and XMP areas for metadata and you can set the XMP/IPTC metadata for an image with Adobe
Photoshop (using the File Info ... option from the File menu). However, for historical reasons, the names used by Adobe for fields are
different from those used by Microsoft for the same fields; the following table shows the how the names are used:
Windows name
Authors
Title
Subject

Adobe Photoshop Name
Author
Document Title
Description

FFPx uses the author, title and subject information in several ways:
When scoring a competition, the Author field must be correctly set if the scoring scheme is adding together the scores per
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author.
When printing out a score sheet, the author, title and subject can be shown for each image.
You can tick the show author and/or show titles options and FFPx will briefly show the author or title on the projected image.
When using the Knockout competition, FFPx will try and avoid having two images by the same author in the same round.
The Subject field is used for competitions where there is a mix of set-subjects and open images; the score Report Summary dialog
allows you to score only the images with a particular subject or break down the score by subject.
225

Setting How FFPx Obtains Metadata
To change how FFPx obtains metadata, select the More button from the Obtaining Im age Info rm atio n panel on the Settings tab of
the ribbon; the Im age Info rm atio n dialog will appear:

At the top of the dialog, you set how FFPx obtains information; going through these options briefly:
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Only from image file metadata
With this option, FFPx looks in the file for the metadata information - the file name is ignored.
Use file name as title
A useful compromise is to use the file name as the title; as we've seen, it's possible to set the author name for multiple images - so if
a club member sends you a set of images without the metadata set, it's quick to set the author name on all of them. However, it's
time consuming to set the title for each individual image. If you (or your club's projectionist) don't mind setting the author name,
then you could request members to make the image file name the title.
With the Use file nam e as title option checked, FFPx will look for an image title in the metadata, if none is present the image file
name is examined - FFPx tries to ignore images that are actually file names generated by popular camera manufacturers; so image
files who's names start with "_DSC" or "_IMG" will be ignored as these are unlikely to be the titles. Assuming the image file name
isn't recognised as being a camera generated one, the file name is used as the title.
Although using the file name as a title can make your club's members' lives easier, there are some restrictions. There are some
characters that can't be used as part of the file name - you can't use any of the following:

From both the image file metadata and the file name
With this option selected, FFPx looks in the image file for metadata, if there's none there then it can try and interpret the file's name -
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the way the file name is interpreted is described in detail below.

Only from the image file name
FFPx can use the image file name to store the author, title and/or subject information. To set this up, you enter an example file name
and the resulting author, title and subject that would be produced by that file name. Once you've done that, assuming that members
use the correct format for their file names, FFPx should be able to deduce the author, title and/or subject automatically.
There are a couple of restrictions in using the file name; apart from not being allowed the "forbidden" characters - listed above, you
also need to avoid "ambiguous" schemes; for example - suppose your example file is Sunny by Andrew.jpg - the title is "Sunny" and
author, "Andrew". This looks fairly safe until Fred wants to use the title "Side by side" - the resulting filename is Side by side by
Fred.jpg - so FFPx has to decide whether the title is "Side" and the author is "side by Fred" or the title is "Side by side" and the author
is "Fred".
You can avoid this kind of problem by using "unusual" characters; for example, curly brackets don't usually occur in titles, so you
could use a file name format such as {Side by side} Fred.jpg ; now members can use, more or less, anything they like as a title.
However, balanced against this is trying to keep things as simple as possible for members.
Setting up FFPx to use the File Name
Before you set up FFPx, you should decide what format you're going to use for file names; for this example, we'll use the format:
title -- author.jpg
So a valid file name would be Kingfisher -- Andrew.jpg , note that I've used two dash characters ('--') as this is unlikely to occur in
titles.
To set up FFPx to use the file name, select the More button from the Obtaining Im age Info rm atio n panel on the Settings tab of the
ribbon. The Image Information dialog will appear:
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Before you can set up how the file name is formatted, you need to set the Obtaining Image Information option to either Fro m bo th
the im age file m etadata and the file nam e or Only fro m im age file nam e . For this example, we select Fro m bo th the im age file
m etadata and the file nam e as it's the most commonly used option.
Now you can click the File Nam e Settings... button; the Use File Nam es fo r M etadata dialog appears:
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Enter an example file name into The Sam ple file nam e text box; we'll use the example from above:
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Under the Sample File name area, there is an Igno re cam era generated file nam es option. If this is checked (the default) then FFPx
will ignore file names that are generated by the popular cameras.
Enter the author and title that this file would generate into the appropriate areas:
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Note that there is a "Conversion template" that is being displayed; this shows how the sample file name is being interpreted.
Once you've entered the author and title, you can click OK and the settings are saved. Now if you load images with the appropriately
formatted file names, you should see the author and title information for each image:
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Setting the Subject
If you're competition needs the subject set, then the procedure for the file name is very similar to the example above for an image
with author and title:
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For the example, the subject (Portrait) has been added to the file name and to the Subject field.
Numbers in File Names
If your club uses numbers in file names - for example, to indicate a priority for each image, or the number of the competition - then
you should put a number in the sample file. For example, if your camera club has a file format such as
Title_Autho r_Subject_Prio rity.jpg , so that Andrew_Kingfisher_W ildlife_2.jpg might be a valid file, the dialog would look like this:
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The "2" in the sample file has been replaced by "[NN]" in the Conversion Template; when FFPx loads image files, it will ignore
numbers in that position of the file name.

Which is Best?
As you have probably noticed, there are often several ways to do something with a computer, but there is rarely a "best" way. For
regular competitions, some clubs prefer the online entering system, some insist their members set the metadata correctly and email
the entries to the projectionist, some use the file name system and, doubtless, some use a mixture of all systems.
For smaller clubs, with a few members bringing memory sticks containing images "on the evening", using the folder name as the
author name is quite convenient - the projectionist creates a folder for each member and copies their images into the appropriate
folder, FFPx can then load all the folders in one go and use the folder name as author.
During the "learning" phase of switching to digital competitions, using the file name as the title is quite a good compromise; some
users will set the metadata correctly, others will struggle, but happily set the file name as the title - the projectionist has to manually
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set the author name for those images.
For most clubs, I'd recommend the combination of systems - obtaining the information from both the image metadata or (if that is
absent) the file name; it makes life much easier for members who use Mac computers. There are two drawbacks with only using the
file name: Firstly, because some characters are "illegal" for file names, these characters can't be used for image titles - for example,
you can't use question marks.
Secondly, if the members have misnamed their images (perish the thought!), then correcting the file names is more difficult than
correcting the file metadata; that's because it's possible to set the author name in the metadata for several images in a single
operation, with the file name, you would have to rename each file individually.

Preferred Metadata Source
Under the obtaining image information panel, there's a panel for setting the preferred metadata source. As you'll recall, there are
three places that metadata can be stored in the image file and FFPx looks in all of them. If there's metadata in more than one place,
and it differs, then you can select which source FFPx should "prefer". FFPx will warn you about this "ambiguous metadata"; there's
more about that here .
106

Using the Folder Name
There is another way of setting either the author name or subject for images; FFPx can use the folder name as the author or subject.
This system is useful for small groups of people, but is difficult to manage with larger numbers. This is described in more detail here
.
109

2.4.13 Ambiguous metadata

Occasionally images have ambiguous metadata. As explained in the Image Information 88 section, there are three areas which can be
used to store metadata. FFPx examines all three areas when a sequence is loaded and if the areas contain ambiguous information
about the image, the problem is flagged with the message:
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For example, if an image has "Andrew Pepper" in the EXIF area and "Andy Pepper" in the XMP area, then the author name is
ambiguous - the scoring system built into FFPx assumes that the same author name is used for all images by that author.
To correct the ambiguous metadata, right click any image and select the Am biguo us M etadata... option from the context menu that
appears. The Am biguo us M etadata dialog will appear:
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The particular sequence has three problem images; the first image has two author names available; "Andrew" or "Andrew T Pepper"
and two titles: "John girds his loins" and "AMBIG DESC" - the other two images also have ambiguous author/title information.
To resolve the problem, click on the "correct" information - as the field is corrected, FFPx will change the colour of the field from red
to green. After correction, the dialog looks like this:

To permanently "fix" the problem, you can click the Update Files button - this removes the ambiguous data, just leaving the
"correct" metadata. As FFPx has to modify the image files to do this, it's recommended that you do this to copies of the images.
If you click the Clo se button without performing the update files function, then the preferred metadata will only be remembered
whilst FFPx is running.
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The Sho w Subjects option selects whether the subject field is to be shown; many competitions do not use the subject field so you
may not care if the subject field is ambiguous.
2.4.14 Using the Folder Name As Author or Subject

As an alternative to using the image metadata 87 , you can use the image folder name to hold the author or subject information. This
makes life easier for club members as they don't have to set the metadata, but makes your life more complicated as you will have to
place images into appropriate folders - one folder per author.
As an example, we'll use the folder name for the author; a sample directory (FolderAsAuthor) has been set-up like this:

Each club member has their own folder to hold their images; this is why it's more labour intensive for you as you have to create a
folder for each member and copy the appropriate images into each folder.
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With the folders set-up, we start FFPx and load the images from these folders; the easiest way is to use the Add Fo lder o f Im ages
option and make sure the Lo ad subfo lders option is selected.
Once the images are loaded, the Fo lder as Autho r button is clicked on the Obtaining Im age Info rm atio n panel on the Settings tab
of the ribbon and the Override im age m etadata is also selected:

FFPx uses the parent folder for each image as the author name; the detailed view looks like this:
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Using the Folder Name as Subject
Probably of more practical use is the facility to use the folder name as subject; there are usually only a few subjects in a competition.
The procedure is identical to that for using the folder as author name except you select the Fo lder as subject option from the
Obtaining Im age Info rm atio n panel.
If the image already has an Author or Subject
One minor complication is that some images may have an author name or subject set already. That's why we selected the Override
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im age m etadata option; that forces FFPx to use the folder name by preference.

Saving Preferences
When you save a sequence, FFPx will include whether to use the folder name as author or subject and whether you want to overwrite
existing metadata.
2.4.15 Entering Images Online

Registered users of Film Free Projection can make use of the FFPx Online Entry System. The detailed instructions for setting up and
using the online are on the www.filmfreeprojection.co.uk website.
Using the online system is a three phase process; firstly, the club projectionist (probably you) defines some information about your
club:
Club name,
email address for entries,
club website address,
projector resolution,
foreground and background colours for the club website,
the preferred font for the club website.
Next, you need to define the competitions that you hold. For each competition you define:
The competition name,
whether the competition is panel based,
the number of panels per author,
the number of images per author or panel,
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whether the images are titled.
Optionally, you can define a competition calendar, which sets the closing date for each competition and, for set subject competitions
you can define the possible subjects.
Once this information is defined, a URL is provided which gives a link to an online entry page which will be customised for your club.
Club members will need to register with the online system, but once they are registered they can upload images from their PC, Mac
or Linux system. The online system will set the author name automatically and makes it easy to set the title and subject. Also, the
online system resizes images to fit the club projector's resolution. Finally, a single click will email the images to the projectionist.

Using Photo Entry
Photo Entry is a third party online entry system designed for camera clubs to manage their competitions. Photo Entry has several
useful features:
A database of competitions is maintained, so you can go back to any competition to see the entries and scores.
Photo Entry can calculate an end of season result for a competition.
Setting the author name is automatic and, therefore, consistent.
Photo Entry provides a simple way for adminstrators to manage users including a useful "impersonate user" option to allow
administrators to enter images on the behalf of users who don't have access to a computer.
Configuring FFPx to use Photo Entry
Before FFPx can be used to load Photo Entry competitions, you need to configure an administrator id and password into the FFPx.
From the Settings tab, select FFPx Settings and click the Photo Entry settings option:
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The Photo Entry URL is the website address FFPx uses to connect to Photo Entry; you shouldn't change that without a very good
reason.
The User ID and Password fields should be set to an administrator account for Photo Entry.

Loading a competition
Note that to load or update a competition from Photo Entry, your computer must be connected to the Internet.
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Once the Photo Entry settings have been made. You can select the
competition from Photo Entry dialog will appear:

Lo ad fro m Pho to Entry option from the File menu. The Load

FFPx automatically loads the list of competition groups - you can see that I only have one group; "2017-18 Season". Select the group
containing the competition you want to load and FFPx will load the associated competitions:
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The competitions are loaded; after each competition name is the state of the competition; Photo Entry competitions are in one of 4
states:
Future - the competition is planned but users cannot enter images
Open - the competition is open for images
Closed - the competition no longer accepts entries and is awaiting scores
Judged - the competition has been judged and the images have scores
To load a competition's entries, you click on the competition. For example, if I click on the Garden Trophy competition, the entries for
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that competition are loaded:

At this stage, FFPx has downloaded thumbnails for each entry so you can make sure the entries make sense; if you're happy, click
the Save images and import into FFPx button. FFPx will ask you for a root folder for Photo Entry competitions. Note that FFPx
assumes that you use a folder structure such as <root folder>/<Competition group name>/<Competition name>/
For example; if my root folder is ...Do cum ents/Pho to Entry co m petitio ns/ then when I save the Garden Trophy entries, they will be
saved in a folder called ...Do cum ents/Pho to Entry co m petitio ns/2017-17 Seaso n/Garden Tro phy.
Once a root folder has been set, FFPx downloads the entries and saves them, creates a sequence and title slide and closes the dialog.
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You can only load closed or judged competitions into FFPx. However, you can change the state of an open competition to closed by
clicking that competition. For example, the Placed Based competition above is marked as "open". If I click on it, I receive the dialog:

If I click Yes , FFPx will mark the competition as closed and load the associated entries.
Once a root folder has been set, the next time you load a Photo Entry competition, you'll be asked to confirm the save location:

In most cases, you can click Yes to confirm the location is sensible.
Once a competition has been loaded into FFPx, it can be treated as a normal competition - with some minor restrictions:
You can't add images to the sequence from the local PC; if you did then Photo Entry wouldn't recognise the entry when you tried to
save the scores.
You must use an appropriate scoring scheme; if you create a non-placed based competition with Photo Entry, you mustn't use a
placed based scoring scheme to score it; the types must match.
Placed based competitions
Photo Entry assumes that placed based competitions have the following places:
First, second, third, highly commended, commended, selected, not selected, disqualified. FFPx maps this onto the default Placed
Based settings - creating an appropriate scoring scheme if none is available. Do not change the scoring scheme for Photo Entry placed
based competitions. FFPx assumes that the default scheme is in use.
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Uploading competition scores
Once a Photo Entry based competition has been scored, you can upload those scores to the Photo Entry system. From the File Menu,
select the

Uplo ad to Pho to Entry option.

If the Uplo ad to Pho to Entry is greyed out, this means the competition wasn't created using Photo Entry or you haven't set a
scoring scheme for the competition.
Assuming all is well, upload dialog will open and the scores uploaded:

There is a Change co m petitio n to "Judged" button which will change the status of the competition to indicate it has been judged.
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2.5

Competitions

2.5.1

Club Competition

The club competition is the default competition mode for FFPx; when you start FFPx running it will start in Club Competition mode,
when you exit from any other competition mode, FFPx will return to Club Competition mode.
Club competition mode is how most competitions are run; each image is shown in turn and receives a score. At the end of the
sequence, the results are calculated and displayed.
There is a walkthrough of a club competition here
2.5.2

320

.

Inter Club Competition

Inter Club competitions, as its name implies, is used for competitions between clubs. In Inter Club mode, FFPx will use the folder
name of images as the club name.
Inter Club mode is used for a competition between clubs held on a single evening at one club. FFPx can also be used to run Multi-Leg
competitions - where the same sequence of images is scored at different clubs; this is described in the Multi-Leg section.
139

The competition type is selected from the Competitions tab on the ribbon; Inter Club is an option on the Sim ple Co m petitio ns
panel.
With Inter Club mode turned on, the use of the Load Folder of Images 23 facility is slightly different - the Include subfo lders option is
always on. In detailed view mode, a new column appears; Club Nam e .
Scoring Inter Club mode is described here
2.5.3

202

.

Knock Out Competition

Knock Out mode is designed to run a knockout competition.
In a knockout competition, two images are shown simultaneously and one of these two is picked as the winner - either by a judge or
by a show of hands. The winner goes through to the next round and the loser is eliminated. An example should make this clearer:
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Suppose we start with 16 images. For the first round of the knockout competition, we show 8 pairs of images. For each pair the
winner is picked and goes through to the next round.
After the first round we have 8 winning images, for the next round we show 4 pairs of images - this is the quarter final round.
After the quarter final round, we'll end up with 4 winning images - 2 pairs, or the semi-final.
After the semi-final we have two winning images and it is the final.
When the final winning slide is selected, FFPx will automatically switch the projector to single image mode to display the winner.
One complication this example avoided was the situation where we don't start with a number of images such as 16, 32 or 64. If we
start with a different number (19 say) then there is an elimination round to remove 3 images so we have a suitable number of
images. FFPx handles this automatically.
Before each round, FFPx will shuffle the images - trying to avoid matching two slides from the same author.
To start a KnockOut competition, you click the Kno ckOut button on the toolbar or select Kno ckOut from the Co m petitio ns menu.
Once projection is turned on, the Start Kno ckOut button is enabled and when you click that the Kno ckOut dialog is displayed:
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In KnockOut mode, the projector is automatically switched to dual image mode so that two images are projected simultaneously.
During the competition, the operator uses the Kno ckOut dialog to choose the winner of each round.
As the winners are selected, FFPx will display the images with the various winning slides flagged:
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This gives you a chance to change the winner if the wrong button was clicked; you can right click an image and change the winner
status:
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A walkthrough of a Knockout competition is here

330

.

KnockOut Projection Options
On the FFPx Settings
dialog, it is possible to choose to project the KnockOut Round and KnockOut progress; if the former is
turned on, then the Round will be projected (for example, Elimination Round or Semi-Final).
304

If KnockOut progress projection is turned on, then a progress bar will be displayed whilst the losing images are removed and the
remaining images are being shuffled - if there are a large number of images then it may take a few seconds so it reassures the
audience that all is well to see the progress bar.
2.5.4

Mix & Match Competition

"Mix & Match" is a competition commonly held in camera clubs. Back in the days of film slides(!), teams each brought a fixed number
of slides, say 60. There was one conventional slide projector per team. The competition proceeded in a series of rounds; for a round a
team put up a slide in one projector. The other teams tried to match that image; produce an image that looks similar. A judge then
decided which, if any, slides match and, optionally, which was the "best" of the images.
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Mix & Match with a Single Laptop/Projector
FFPx provides a way to run a mix & match competition with a single laptop and digital projector for up to four teams.
Before starting FFPx, each team's images should be placed into folders - one for each team. For the sake of fairness all teams should
have the same number of images - although this isn't enforced by FFPx.
Once the folders are ready, start FFPx as normal and from the Co m petitio ns tab select M ix & M atch . The M ix & M atch Setup dialog
will be shown:

Make sure that the Using m o re than o ne co m puter and pro jecto r option is not checked.
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Note that Team One always starts, so you should decide before completing the dialog box who is going to be first up.
Going through the dialog:

Number of Teams
This is the number of teams competing in the Mix & Match. If you increase the number then the dialog display will automatically
adjust the number of team setting areas.

Score Checkbox
If the Sco re this Co m petitio n using checkbox is checked, then you can select a scoring scheme from the associated dropdown to
score the Mix & Match competition with FFPx. The dropdown will only contain valid scoring schemes; ie those that have been defined
as Mix & Match scoring schemes.

Scoring Schemes...
Clicking the Sco ring Sc hem es... button will open the scoring schemes dialog
scoring schemes to make them suit the current competition.

172

. This allows you to add or change the existing

Team Setting Area
The major part of the dialog is split into up to four Team Setting areas. The Nam e text box contains the name of the team; the Fo lder
button name will change to reflect the name set in this text box. The Fo lder button will open a folder selection dialog and allow you
to select the folder for that team's images.

Help
The Help button will open the Help dialog for the Mix & Match competition.

Status Information
Alongside the Help button is a status panel; this shows hints about completing the dialog.
Below we show a completed form for a two team competition (Ladies v. Gentlemen) using a Mix & Match scoring scheme:
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Click OK and FFPx will confirm the scoring scheme being used for the competition and load the image files. The lightbox view will
automatically be selected, a M ix and M atch tab on the ribbon will appear and be selected and the first team's images (in the above
example, the Ladies' images) will be shown:
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You may need to click the Pro jecto r On/Off button to turn on the projector.
The Mix and Match panel on the ribbon will remind you about who should be selecting images; in the above example, the Ladies are
to select a slide.
The Identify Team s button is used to show which area of the projected screen "belongs" to which team; if the button is clicked with
the example above, then the projected image will look like this:
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Click the Identify Team s button again to remove the identifying labels.
The Ladies team representatives now select a slide - clicking the one they want displayed. The representatives should be asked to step
away from the laptop once their selection has been made.
Next the operator clicks the Sho w Selected Im age button; the Ladies' slide is projected:
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The gentlemen's representatives now step up and select what they hopes is a matching image, again the operator click the Sho w
Selected Im age button and the "matching" image is shown alongside the ladies:
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The judge can now decide if the images match, and which is best. Whilst this delicate decision is being made (and assuming you are
scoring the competition using FFP), FFPx produces a message box:
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Once the judge has made a decision, click M atch or No M atch as appropriate. If the scoring scheme in use has the score for "Best"
image selected, then you will be asked a second question:
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If you make a mistake and click the wrong button then you can click the < Back button to return to the Match/No Match option.
Assuming all is well; click the "best" image.
As before, you can click the < Back button to return to the previous question, but if no mistake has been made, click the OK button
to complete the scoring; the projected images will be blanked and, this time, it will the Gentlemen's turn to choose an image.

Showing the Score
In between rounds, you can display the scores by selecting the Sho w Results option from the More button menu on the Sco ring
Schem e status panel. For example:
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The competition can stop at any point; you shouldn't feel obliged to show all the images! All teams will have had the same number of
goes whenever team one is invited to select a slide, so that is a fair place to stop. If there are no more images to be shown then FFPx
will produce a message box saying there are no more slides in the competition and automatically turn off the projected image.

Mix & Match with Three or Four Teams
Mix & Match is scored differently if there are more than two teams. For example, with three teams, instead of being asked M atch or
No M atch , you are shown the contending images with a No M atch option:
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If any of the images match, you click their button; FFPx will place a Matched label across the matching images. You can "unmatch" an
image by clicking its button again. You can mark any number of images as Matched; if no images match then click the No M atch
button. Once the Matching/Unmatching is completed, you should click Next > to move to the Best Image dialog (if the best image is
to be scored) or to blank the screen.

Mix & Match Time Limit
One option on the Mix & Match scoring scheme is to impose a time limit on matching images. If a time limit is set then when a
team has to match an image a stopwatch style countdown is shown at the top of the screen:
210
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An option on the FFPx Settings dialog is to have sound effects on the Mix & Match timer. If this option is on then, for the last ten
seconds, FFPx will add a "beep" to the stopwatch.
300

If no image is selected before the timer runs out, then that team will automatically "lose" the round - not matching and not getting
best image.

Mix & Match without a Scoring Scheme
If you leave the Sco re the co m petitio n using checkbox unchecked, then FFPx will run the Mix & Match competition but without
scoring; at the end of each round, you will be prompted to blank the screen ready for the next round:

Projection Options
If Pro ject Sco re is turned on in the FFPx Settings
each projected image.

304

dialog, then FFPx will superimpose No Match/Match and Best as appropriate on

There is a walkthrough of a Mix and Match competition here

334

.

Mix & Match With Multiple Laptops/Projectors
If your club has more than one projector, laptop and screen then you can run multiple copies of FFPx with each team uses a single
folder of images on their laptop; click the M ix & M atch... button to open the Mix & Match dialog and make sure the Using m o re
than o ne co m puter and pro jecto r option is checked. The dialog will change to let you set a single folder for this team's images (in
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this example, the ladies have configured their folder):

Note that you cannot use FFPx to score the competition if there are multiple laptops/projectors in use.
Once you've selected the folder containing the images, you can click OK to start the competition. The images will be loaded and the
lightbox view mode selected automatically:

© 2 0 17 A n dre w Pe ppe r

1 37

1 38 Film Free Projection Extended

When it is your turn to show an image, you can select the image from the lightbox table and click Pro ject Slide . The selected image
will be projected and the blank screen dialog shown:

When you click OK on this dialog, the projected image will be blanked and the image removed from the list of images.
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2.5.5

Multi-Leg Competition

In a Multi-Leg competition, the same sequence of images is shown (and scored) at more than one club. FFPx then combines the
results to create an overall result for the competition.
There are three phases to the Multi-Leg competition:
Creating and Distributing the Sequences
Scoring the Sequences
Combining the Results

Creating a Multi-Leg Sequence
Creating a Multi-Leg sequence is much like creating a regular club competition sequence, one club has to be "in charge" - creating the
sequences and sending them to participating clubs. For this "master" club, the projectionist creates the sequence and then saves the
sequence for a Multi-Leg competition; this is on the File menu:
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Selecting this option will open the Save fo r M ulti-Leg dialog:

© 2 0 17 A n dre w Pe ppe r

Using FFPx in Detail

In FFPx, a Multi-Leg competition can have between two and four legs; you can increase the number of legs using the Num ber o f Legs
up/down counter. Each leg must have a unique name. The name is used as a folder name when creating the sequences for each leg
and so must also be a valid file name.
You set the destination folder for the Multi-Leg sequences by clicking the Change save fo lder... button; a standard select folder
dialog will open and you can set the target folder for the sequences.
Once you've defined all the legs and set the target folder, you can click the Save button. FFPx will create a sub folder for each
sequence; each sub folder contains all the images for the competition and a s equence.ffpx file that will load the sequence. You can
copy the folder onto a memory stick (or into a ZIP file) to send to participating clubs. Note that the entire folder must be sent to the
participating club - not just the sequence.ffpx file as the folder contains the images as well as the sequence file.
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Scoring the Sequences
The second stage of a Multi-Leg competition is scoring the sequences. When FFPx loads a Multi-Leg sequence file, it won't allow the
projectionist to move or delete images; for a Multi-Leg competition to make sense, the judge must see the same images, and for the
scoring to work they must be in the same order.
Scoring a Multi-Leg sequence is the same as scoring a "normal" competition; the score is typed on the keyboard as the image is being
projected. Note that the scoring scheme in use when the sequence was created will be used for all the legs - FFPx will load the scoring
scheme as part of the sequence.
The critical thing to do after the sequence has been scored is to SAVE THE SEQUENCE! Each club (including the "master" club) must
save the sequence, which will include the scores.
After a leg has been scored, the saved sequence.ffpx file can be sent back (by email or memory stick) to the master club
projectionist. He or she then copies the sequence.ffpx into the appropriate folder for each leg.
For example, if two clubs are involved - you would be the "Home" club and the other club the "Away" club. When you saved the
sequence for Multi-Leg, two folders will have been created - "Home" and "Away". You send the entire folder "Away" to the other club
which they use to score a competition. After the competition, they send back the saved sequence.ffpx file to you which you copy
into the "Away" folder; replacing the one that was in there. You must also save your scored sequence into the "Home" folder after
your club competition.
Combining the Results
Once all the results are in, you can combine them to produce an overall result. To do that, you load your scored sequence into FFP; in
the example above you would load the sequence from the "Home" folder.
With the scored sequence loaded, you can click the Sho w Results... button on the Sco re panel of the Ribbon:
The Co m petitio n Repo rt dialog will be displayed, showing the results for your leg of the competition:
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To calculate the results for the other legs, click the M ulti-Leg Co m petitio n button at the top of the dialog; FFPx looks in the
"surrounding" folders for the other sequence files to calculate an overall result:
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As you can see, an extra column has been added to the results showing the score each image received from the Away leg and the
overall score calculated for each author.
2.5.6

Panel Based Competition

Some competitions use panels of images. A panel is a group of images. There are three types of panel competitions:

By Group
In by group mode, each panel is shown in turn. For example, think back to the days of 35mm slide based competitions; there are
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three competitors (Alan, Bill and Charlotte). The competition has panels of three slides, Alan is extra keen and enters two panels - the
projector carousel might be loaded like this:

By Slide Mode
In by slide mode, all the "slide 1"s are shown followed by all the "slide 2"s and so on. It's important for scoring purposes that the
group order is maintained; so with the above example, the slides would be shown in the following order:
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By Slide and Cycled
This mode is similar to the By Slide mode as all the "slide 1"s are shown followed by all the "slide 2"s, but a different panel is used as
the first slide of each round; with the above example, the slides would be shown in the following order:
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For FFPx to recognise images as being part of a panel they must be named in a particular way:
panel namePnumber-Snumber.jpg
If the slides above were to be entered in a panel competition, then the image file names would be:

alanP1-S1.jpg , alanP1-S2.jpg , alanP1-S3.jpg , billP1-S1.jpg , billP1-S2.jpg , billP1-S3.jpg , charlo tteP1-S1.jpg , charlo tteP1-S2.jpg , charlo tt

FFPx is fairly flexible with the name part of the filename; the case of the name is ignored and spaces and punctuation characters are
ignored so that Alan P1-S1.jpg is treated the same as alanp1-s1.jpg and apepperp2-s2 .jpg is the same as APEPPER p2-s2.jpg .
However, it is important to realise that the FFPx cannot know that the image file AndrewP1-S1.JPG belongs to the same panel as
AndyP1-S2.JPG .
Because of this numbering scheme, FFPx is limited to supporting up to nine panels from each competitor. However, FFPx allows up to
15 images per panel - after the 9th image, letters are used - (in the world of the computer programmer, this is called hexadecimal
notation). The conversion of decimal to hexadecimal is as follows:
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For example, andrewP1-SE.jpg would be slide 14 from Andrew's first panel.
You can select the type of panel competition from the Panel Based panel on the Co m petitio ns tab of the ribbon:

For more panel settings, select the More button on this panel to open the Panel menu:
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Going through the menu:

Insert Titles Between
If this button is pressed, then FFPx will automatically insert title images between rounds.

Remove Inserted Titles
If this button is pressed, then FFPx will remove any automatically generated title images.

Title Design...
Clicking the Title Design... button will open the Panel Titles dialog which allows you to set the appearance of the panel title images.
This is described in detail here .
154

Correct Panel Names...
The Co rrect Panel Nam es... option is used to open the Co rrect Panel Nam es dialog; this is described here

151

.

Shuffling Panels
If you click the shuffle button (
) whilst in panel mode, the FFPx will shuffle the panels as appropriate. Note that as part of the
shuffle process, any system generated titles are removed before shuffling then re-inserted afterwards.

Holding Back Panels
If you press the space key or select Ho ld back from the context menu (obtained by right clicking an image) whilst in Panel group
mode, the entire panel is held back. If you are working in slide or cycle mode then only the current slide will be held back.

Deleting Panels
To delete a panel, you can use the Freeze Pro jecto r button. Clicking the Freeze Pro jecto r button will stop the projector from
automatically projecting a selected image. The Freeze Pro jecto r button will flash red to indicate that FFPx is operating in this mode.
Note that the Freeze Pro jecto r button is only available for detailed view mode.
With the projector frozen, you can right click an image from the panel you want to delete and pick Select all im ages in this panel
option from the Panels... option:
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All the images with the same panel name will be selected; press the delete key to delete the selected images.
Once the panel is deleted, click the Freeze Pro jecto r button again to "unfreeze" the projector.

Sorting Panels by Score
To sort the panels by score, with the highest scoring panel first, right click an image and from the Panels... option select So rt panels
by sco re .
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2.5.6.1

Correcting Panel Names

If images are loaded with incorrect or duplicated names, then the Co rrect Panel Nam es... option on the Panels menu becomes
enabled.
Note that in the status area, we are told there is a bad panel name and 2 duplicated panel names, although it isn't quite as bad as it
sounds - the "2 duplicated panel names" error message implies two images with the same name so it's actually one error. As
suggested, the Co rrect Panel Nam es button is clicked to open the Co rrect Panel Nam es dialog:
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As we learned from the Panel Settings dialog, there is one illegal filename and two duplicated images. We'll deal with the bad
filename first.
The illegal filenames are shown in the Pro blem Filenam es dropdown, a thumbnail of the problem file is shown in the file
information area as well as any associated metadata. The problem filename is AndrewP1S1.jpg it looks as though the "-" has been
missed out of the filename (before the "S1") and it belongs in Andrew's panel 1, we can check that by selecting andrew(1) from the
Place in Panel drop down, the dialog changes to look like this:
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Seeing a missing Slide 1 confirms the theory. We'll click the "Slide 1" box to add the image to the panel. The Renam e File area of the
dialog will show the new filename (andrewp1-s1.jpg ) and we click the Renam e File button to confirm the change. The dialog will be
updated, removing the image from the Pro blem Filenam es drop down.
If the entire panel has been misnamed, then you will need to use the New Panel dialog to create a new panel to place the illegal
images. Click the New Panel... button and you will be asked for the new panel name. The panel number will be inserted
automatically so don't type that.
Once the new panel has been created, the process for placing the image into the panel is exactly the same as for adding an image to
an existing panel; you click the slide number you want for the image.
You can drag and drop images around the panel; FFPx renames the file appropriately as you drag the image.
In our example, there are no more illegal files; the dialog automatically switches to the duplicated files. There are always pairs of
duplicated images, so if FFPx indicates 2 duplicated images, this means there are 2 images with the same name and removing one of
the images will correct the problem.
Usually, duplicated images are images that have been accidentally loaded twice - clicking the Rem o ve fro m Sequence button will
remove one of the duplicated images and resolve the problem.
If the images are different, then one of images has been misnamed and you need to treat it as an illegal filename and place it into a
panel to correct the problem.
Click Do ne when you have corrected the panel names.
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2.5.6.2

Panel Title Slides

The Panel Titles dialog is opened by clicking the Title Design... option on the Panel menu. The dialog allows you to design the title
images that will be inserted automatically between rounds of the panel competition:

Going through the Panel Titles dialog:

Panel Title Background Image
The panel title background image area is used to select the background image to be used for panel titles; you can select from one of
the built-in backgrounds, a solid colour or use an image file.
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At the top of the dialog is a preview of the projected title slide for round 1.

Panel Title Text
The heading area is used to set the text to be displayed between rounds; the default text "Round %n" displays as "Round 1" for round
1, "Round 2" for round 2 and so on. The %n is replaced by the round number. You can click the Fo nt... button to open a dialog to
change the font and colour of the displayed text.
You can drag the Heading text around the preview image to position it appropriately for your background image. The heading will
only be displayed if the Sho w Heading checkbox is checked.
If the Centre Heading checkbox is checked, then the heading text will automatically be centred horizontally.
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2.6

Tabs

2.6.1

Introduction

FFPx supports multiple documents; you can load up to 8 sequences and switch between those sequences. As an example, three
sequences have been loaded into FFPx:
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At the top of the detailed view, there are three tabs (Unnamed Sequence, Intermediate and Advanced). You can switch sequence
simply by clicking the appropriate tab. FFPx treats each sequence entirely separately; you can specify a different scoring scheme for
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each tab, you can be in lightbox mode on one tab and detailed view in another, you can even (with some restrictions) run entirely
different types of competitions on each tab.
More Details
You can copy (or cut) and paste images between tabs.
If a sequence has been modified without being saved, FFPx shows an asterisk by the tab name; in the example above, two tabs
have modified sequences.
If a sequence contains images that are larger than required, FFPx shows a double angle quote character ("»") by the tab name.
If you use image selection mode, then one of the options is to transfer all selected images to a new tab.
The restrictions in competitions mentioned above are that you can't switch tabs if you are running a knock out or mix and match
competition; this is because FFPx is, essentially, "running" the competition and it doesn't make sense to suddenly switch to a
different competition.
You can change the order of tabs by dragging a tab to a different position.
2.6.2

Adding Tabs

When you load an existing sequence, a new tab is automatically created for that sequence. The new tab will be given the name of the
sequence that you've loaded, however if there is an existing tab with the same name, the FFPx will add a number to the end of the
name to distinguish it.
To add a new tab manually, click the plus sign to the right of the tabs:
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2.6.3

Removing Tabs

To remove a tab, click the small cross at right hand side of the tab:
If the sequence associated with tab has been modified without being saved, then you will be asked to confirm the removal.
2.6.4

Renaming Tabs

To rename a tab, right click the tab to rename and select Renam e Tab from the menu that appears.
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2.7

Projection

2.7.1

Projecting Extra Information

FFPx can briefly superimpose extra information (called metadata) about images onto the projected image. As described in the Author,
Title and Subject 87 section, FFPx obtains metadata from within the image file itself or by decoding the image file name.
The Title and Author display is controlled from the Im age Info rm atio n panel on the Ribbon:

In the Im age Info rm atio n panel, there are two buttons;
for the author name and
for the image title. If either or both of these
are clicked, then when the image is projected the appropriate information is superimposed onto the projected image.
The Duratio n is the time in seconds that the title or author will be displayed for and the Size is the font size of the text.
You can move the projected information on the projected in two ways; to temporarily move it, use the Image Tools
permanently change the position, use the FFPx Settings dialog.

79

window. To

307

For other information that can be projected, click the More button on the panel and the detailed settings dialog for image
information will be opened. This is described here .
304

2.7.2

Projecting Camera Shooting Information

Most digital cameras store shooting information (such as exposure time and aperture) as part of the image file. FFPx will extract this
information from the file and, if you are using a second monitor, you can add this information to the projected image by clicking the
Pro jec t Cam era Sho o ting Info rm atio n button in the Pro jecto r panel on the ribbon:
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A translucent bar of information will be added to the projected image, an example is shown below:

The bar mimics the information shown in camera view finders; the camera model number, ISO setting, exposure time, F-stop,
exposure programme (A for aperture priority, S for speed priority or P for programme mode), lens focal length and flash fire
information is shown.
There are three points to note:
The information is only shown when the second monitor is in use; the small window which appears when using FFPx on a single
monitor computer is too small to show the information bar.
FFPx can only display information if it is present in the image file.
For some early digital cameras the ISO information was not stored; FFPx will display question marks if the ISO information is not
available.
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2.7.3

Freezing the Projector

If you are operating in detailed view mode then the Freeze Pro jecto r button is available in the Toolbox 34 . If you click the Freeze
Pro jec to r button whilst projecting an image, then that image will continue to be projected even if other images are selected.
This allows you to examine the properties, rename or delete images in the sequence without changing the projected image.
The Freeze Pro jecto r button will flash red to indicate that FFPx is operating in this mode.
2.7.4

Colour Managing the Projector

Some Background
Colour devices, such as monitors and projectors vary in how they present colours. So that images look consistent when they are
viewed on different devices, a colour profile file can be associated with a given device which describes how that device shows colours.
These files are obtained in two ways; they may be supplied by the manufacturer or created by a monitor calibration tool. The idea is
that the operating system and applications use these files to process images before they are shown.
You may be wondering why you've never been asked for a "colour profile" when you install a monitor or, indeed, a projector.
Windows largely makes colour management invisible by defining a standard colour profile (sRGB) to which monitors are assumed to
conform.
The problem is that sRGB, because it has to be supported by a wide range of devices, defines a relatively small range of colours
(gamut is the technical term for the range of colours that can be displayed).
All versions of Windows from Vista onwards support colour management. For Windows 10, you set the colour profile by right clicking
the desktop and selecting Display settings . Scroll down and select the Display adapto r pro perties option. There's a tab on the
dialog that appears for colour management.
For Windows 7 or 8, you can associate a colour profile with a device by right clicking the desktop and selecting the Screen
Reso lutio n option from menu that appears. From the dialog that appears select Advanced settings and then select the Co lo r
M anagem ent tab at the top of the dialog.
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FFPx supports colour management of the projected image, using a colour profile file (a .icm or .icc file) that matches your projector.
FFPx automatically looks for the appropriate colour profile for your projector or monitor.
Assuming you have such a file, to turn on colour management, click the Co lo ur m anage the pro jecto r button on the Settings tab of
the Ribbon.
You can configure how FFPx manages the projector by clicking the More button on the Co lo ur m anagem ent panel, this will produce
the Co lo ur M anagem ent dialog:

If you check the Use o perating system 's co lo ur pro file option then FFPx will look for the colour profile the operating system has
associated with the display. The option also won't be available if the display doesn't have a colour profile associated with it.
Alternatively, you can define the colour profile file by clicking the Change... button and selecting a profile file.
There are two things to note about colour management:
The differences are often fairly subtle, don't expect big changes.
Most projectors have a fairly small gamut and are designed to be used with Windows so sRGB (or turning off colour
management) may actually be the most appropriate setting.
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2.7.5

Using FFP without a Projector

Although FFPx is designed to be used with a projector or second monitor, it is possible to run the program on a computer with a
single monitor; for example for practising beforehand - something we all encourage!
If you turn on projection on a single monitor computer then FFPx will resize itself and fit a small window along side the main FFPx
window. .
If your computer has two monitors, you can see the affect of using a single monitor by clicking the Use Seco nd M o nito r button on
the Settings tab of the ribbon.
2.7.6

Multiple Projectors

If your computer has more than one extra screen connected, then FFPx may choose the "wrong" screen for the projected images; you
can select which screen is to be used from the Pro jecto r panel on the Settings tab of the ribbon:

In this case, there are two extra screens and the second one has been selected for projected images.
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2.8

Scoring

2.8.1

Scoring Overview

FFPx provides a comprehensive range of scoring options so, hopefully, most situations are catered for. If you use FFPx for scoring a
competition, some things are always the same:
A scoring scheme must be defined which is appropriate for the competition; this specifies such things as the minimum and
maximum possible scores, and how the scores are interpreted. Several scoring schemes can be defined and stored by the
operator and the appropriate scheme loaded for each competition.
Scores must be entered; to enter a score, a number is typed whilst an image is being projected. Before a score can be entered,
the image must be being projected - so the Projector button must be turned on - and scoring must have been turned on - by
clicking the Score button.
If you type a number and the projector button or scoring is turned off, then FFPx will assume you're trying to score an image and
produce a warning message - it also flashes the button(s) that need to be turned on.
If you click the Score button and there are no scoring schemes, then you will be invited to create one using the score scheme wizard
.
170

There are two ways of scoring an image; by typing the score whilst that image is being projected or by clicking in the Score area of the
image's row in the detailed view table.
Typing the Score
If you type a number when projecting an image a window appears into which the score is entered:

You can correct a score using the Backspace key, to confirm the score press the Enter key.
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If you have entered the wrong score, you can usually correct it by selecting the image and typing the correct score. However, for
placed based scoring schemes, you will need to right click the image and select Clear Sco re from the menu that appears.
You can abort entering a score by pressing the Esc key and confirming you want to abort score entry.
FFPx allows up to six individual scores to be entered for each image which contribute to the final score for that image. Each score is
entered by typing the score followed by the Enter key. When all the scores have been entered, the scores are registered and FFPx will
move to the next image in the sequence.
The scores can also be entered from multiple keyboards, FFPx supports up to six keyboards and records which keyboard entered
which score.
The score is shown in the right hand column of the detailed view. You can sort the images into score order by clicking the "Score"
heading at the top of the score column.
Clicking the Score Area
If you click in the Score area for an image in the detailed view, a score table will pop-up:

FFPx builds the pop-up depending on the scoring scheme in use; in the above example, images are scored between 0 and 10 and half
marks are allowed.
There are two additional options for holding back the image (

) and cancelling the score (

) - ie closing the score table pop-up.

If the scoring scheme is placed based, then you'll see a pop-up like this:
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In general, you can use either scoring method at any time, but there is are a few limitations with scoring by clicking the Score Area:
It only supports a single score - if the scoring scheme has multiple scores set then clicking in the score area has no affect.
The maximum number of possible scores the pop-up supports is 28; for example, if you're using a scoring scheme where the
scores are between 1 and 20 and half marks are allowed, then the pop-up won't work as there are too many possible scores.
More obscurely, the minimum number of possible scores is 4.
At any point in a competition a results summary can be generated. This will give the "state of play" of the competition. At the end of
the competition, this will, obviously enough, give the result of the competition. However, it is possible to change the scoring scheme
used to produce the scoring report so, for example, you can generate a report where the results are for each author and then easily
switch to display the results for each slide.
FFPx can calculate the overall results for a collection of sequence files; so, providing club members use the same name throughout a
season and you remembered to save sequences after they've been scored(!), you can generate the overall results for a season of
competitions.
Some clubs have competitions where there are a mixture of set subject and open images. For example, a club may have a competition
where members can enter a Portrait or an Open image. By setting the image type (Portrait or Open) in the Subject field associated
with the image, FFPx can calculate the scores for particular subjects within the competition.
If you have a second monitor connected, then you can project the scoring report.
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Scoring reports can be printed
records.

237

or saved

237

in HTML format so they can be incorporated into club websites or saved for club

When saving a sequence the scores and the scoring scheme currently in use is also saved as part of the sequence. When you load a
sequence, FFPx will load the saved scores and the scoring scheme. If the scoring scheme doesn't exist then it is added to the list of
scoring schemes. You should be aware that if you change a scoring scheme, for example, you change the minimum score from 0 to 1,
then when you load a sequence using the older version of the scheme then it is the older version that will be used by default; FFPx
prefers the scheme that is part of the sequence.
FFPx indicates in the status text at the bottom of the FFPx window which scoring scheme is in use and whether this has been
"preferred" over an existing scheme with the same name.
If you have more than one sequence loaded (ie more than one tab active), you can have a different scoring scheme on each tab - FFPx
will automatically switch scoring schemes as you change tabs.

Pre-Scoring
One situation for which FFPx cannot be used directly is for scoring a competition which is Pre-Scored; the judge looks through the
images and allocates points before the competition. As the judge is unlikely to have FFPx installed on his or her computer, FFPx
provides the facility to export the sequence as an HTML based slide show that can be viewed on any computer with an Internet
browser. This can be given to the judge, together with a printed score sheet which is completed by the judge.
238

315

This section gives an overview of the basic scoring modes:
Scoring By Author

180

In the scoring by author mode a score total is recorded for each projected image. At the end of the competition, the total for each
author is added together to create a score. The winner is the author with the highest score. For this type of competition, FFPx has to
know the author for each image and will warn the projectionist if images are loaded without the author defined.
Some clubs don't add all the scores together; for example, an author might enter three images but only the top two "count" towards
their total.
Calculating Season Results

185
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Provided that competitions have been scored with a "By Author" scoring scheme, FFPx can calculate a summary of results for several
sequences and give an "overall" result for an entire season.
Scoring InterClub Competitions

202

If you are having a multi-club battle, FFPx will assume that each club's images are stored in a folder for that club, with the club's name
being used as the folder name. The calculation of the score is very similar to a "By Author" competition except the club name is used
to calculate a total score for the club.
Scoring Multi-Leg Competitions

207

FFPx can run a Multi-Leg competition; the same sequence is scored at different clubs and the result combined to produce an overall
result.
Scoring Mix & Match Competitions

210

If you are having a Mix & Match competition, FFPx will be more proactive, prompting you at the end of each round for the score.
Scoring By Slide

187

In the scoring by slide mode a score total is recorded for each projected image. The winning slide is the one with the highest score.
Placed Based Scoring

191

Some clubs don't allocate points to each image but place the top few images. For example, the best image will be allocated First
place, the next Second place and so on. FFPx supports up to nine such placements. The name for each place can be changed (for
example, the first place could be called "Gold", the second "Silver"). FFPx allocates points based on placement, for example First place
might receive 10 points, second 8 points and so on. It's also possible to specify how many of each place is allowed; for example, you
could have First, Second, Third and then 5 Highly Commendeds.
Note that if your placed based competitions are loaded via the Photo Entry system, you must use the default placed based scoring
scheme.
Scoring By Panel
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In the scoring by panel mode a score is recorded for each image and the total for each panel calculated.
Voting for Images

217

This is a variation on conventional scoring; in this scoring system, all the images are shown to the audience then each member votes
for their favourite image(s). FFPx calculates a "score" for each image given the votes cast by each member.
2.8.2

Scoring Scheme Wizard
You may find it easier to create a scoring scheme by using the Scoring Scheme Wizard. To access the wizard, select the New schem e using
W izard... option from the Sco ring menu:

The scoring scheme wizard will start:
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You will be led through the creation of the new scheme by the wizard.

Limitations
The wizard does not allow you to modify the place names or scores if the scoring scheme is place based. To change the place names
or scores, use the Sco ring Schem e dialog .
177
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2.8.3

Scoring Scheme Dialog

Before a competition can be scored using FFPx, a scoring scheme must be set up. Click the More button on the Sco re panel and you'll
see the Sco ring menu:

Scoring schemes can be set up using the scoring scheme wizard

170

or by clicking the Create a new schem e... option.

As an example, click Create a new schem e... and you'll be taken to the Sco ring Schem es dialog box:
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Controls Common to All Tabs
Help
The Help button will open the context sensitive help for the Sco ring Schem e dialog.
Save
The Save button is used to save the current scheme. The save button is enabled when modifications have been made to the current
scheme.
OK
The OK button is used when you have completed using the Sco ring Schem e dialog. Changes to the current scheme will be saved.
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Cancel
The Cancel button cancels modifications to the current scheme and closes the dialog. Note that if you have previously saved scoring
schemes, then these scoring schemes will remain saved.

The General Tab
Name for Scoring Scheme
The Sc hem e to Edit dropdown is used to select the scheme you want to edit; as we've just created a scheme then it will show that
newly created scheme - called "Untitled". If you change the current scheme, by selecting a different scheme from the dropdown and
you've modified the current scheme, you will be asked if you want to save the current scheme before switching to the new scheme.
The Nam e area sets the name of the scheme.
Scheme is used to score
This area is used to select the type of competition for this scoring scheme; FFPx can score four different types of competition and you
should make sure the appropriate button is checked as FFPx will only allow appropriate scoring schemes to be used with a given
competition. For example, if you are running an InterClub competition, you will need to have an InterClub scoring scheme defined to
score it.
This is the Default Scoring Scheme for the selected competition type
If this checkbox is checked, then FFPx will assume that the scoring scheme is the default one to use for a given competition type. For
example, if you have two Club Competition scoring schemes defined and FFPx is operating in Club Competition mode, then the
default Club Competition based scoring scheme will be loaded automatically.
Delete Scheme
Clicking the Delete Schem e button will remove the current scheme. You will be asked to confirm the delete.
New Scheme
Clicking the New Schem e button will create a new scoring scheme. If you have modified the current scheme, then you will be asked
if you want to save changes before being asked for the name of the new scheme.
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The Each Slide is Scored Tab
Click the Each Slide is Sco red tab at the top of the dialog box to access the next page of the dialog box:

Number of Scores Per Slide
The Num ber o f sco res per slide counter is used if there is more than one score recorded per image. Some competitions have more
than one judge who each records a score for a given image. FFPx allows up to six separate scores to be recorded for each image.
If the number of scores per slide is more than one, then you can use multiple keyboards, instructions on setting up multiple
keyboards are here .
212

Half Marks
If you allow half marks in your scoring scheme, then tick the Half m arks are used checkbox.
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Minimum and Maximum Score Per Slide
The M inim um sco re per slide is the lowest score an individual judge can award an image, so if there were three judges (ie the
Num ber o f sco res per s lide counter is set to 3) then the lowest total would be the M inim um sco re per slide counter multiplied by
the Num ber o f sco res per slide .
The M axim um sco re per slide is the highest score that an individual judge can award an image. If there were three scores per slide
and the M axim um sco re per slide is set to 10 then the highest total an image could receive would be 3 x 10 = 30.
Maximum Number of Slides per Author/Club
The M axim um num ber o f slides per autho r is the highest number of images an individual or club is allowed to enter per
competition. Note that for this is only checked if the scoring scheme has Autho r/club's Sco res Added To gether field checked. For
club competitions, the "author" field must be set for all the entries for this type of scoring scheme; for instructions on how to set
that see here 87 . For InterClub competitions, FFPx uses the name of the folder containing the images as the club name.
When scoring is turned on, FFPx will go through the currently loaded images checking the number of entries per author. A warning is
displayed if the maximum number of entries per author is exceeded but the extra images are not removed from the sequence.
Author/club's scores added together
If the Autho r/club's sco res are added to gether checkbox is ticked then FFPx will add the scores for an author (or club for InterClub
competitions) together. For this to work for club competitions, the "author" field must be set for all the entries (see here 87 ).
Number of slides per author/club that count toward the score
This counter indicates how many of an author's or club's slides will "count" towards that author's or club's total.
For example, if an author enters three images which score 7, 8 and 9 then it might be thought that they score 7 + 8 + 9 = 24 points.
However, if the number of slides per author is set to 2 then the author score would be 8 + 9 = 17 - the lowest score being discarded.

Place Based Tab
To select the Place based page of the dialog, click the Place Based tab at the top of the dialog box:
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In a placed based competition the top few images are given a place; in the default settings (shown above) the "best" slide of the
competition is awarded First place, the next Second place and so on. Points are associated with each place. In the example above,
First place is awarded 10 points, Second place 8 points and so on.
Going through the dialog:
Competition is Placed Based
If the competition is placed based, then you should tick this checkbox.
Position Table
The position table shows the name and score of each position in the scoring scheme. If your scheme is placed based, then you can
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change the name of each place by clicking the name and typing the new name.
Similarly, you can change the number of points allocated to each place by clicking the score and typing the number of points.
Default Score for Slide
To encourage entries, some clubs award a score to each image entered. You can set the default score using this counter.
Maximum in this Position
Up to 9 occurrences of each place are allowed; for example, a scoring scheme could have First, Second, Third and 5 Highly
Commendeds. To set the maximum number of a particular place, click the M axim um in this Po sitio n button associated with the
place.
New Row Button
To add a row to the table, click the New Ro w button - FFPx allows up to 9 rows in the position table; thus allowing 9 places in a
competition. New rows are always added to the bottom of the table.
Delete Row Button
To remove a row from the table click any field of the row and click the Delete Ro w button.

Mix & Match Tab
To select the Mix & Match page of the dialog, click the M ix & M atch tab at the top of the dialog:
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The Mix & Match competitions are scored in a slightly different way from other competitions; FFPx is more proactive - using dialog
boxes to ask for the score rather than waiting for you to enter it. For more details, see here .
133

Matching Slide Scores
The M atching Slide Sco res counter is used to set the number of points awarded to a matching image.
If no-one can match then score
This counter indicates how many points are awarded if no-one can match an image. Normally, this number is the same as the
M atc hing Slide Sco res number.
"Best Slide" is given a score of
This checkbox and counter indicate whether the "Best" slide of a round is awarded a score and, if so, how many.
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Time limit to match image
The time limit counter is the number of seconds the team trying to match has to match the image.
2.8.4

Scoring By Author

This is probably the most widely used camera club competition; each image is given a score and at the end of the competition the
winner is the author with the highest total.
For club competitions scoring schemes to work, the Author parameter for all the image files must be correctly set
exception being locked images 67 .

87

- the only

Creating a "By Author" Scheme
In the following example, we'll create a scoring scheme for the following style of competition:
Images are given a score between 0 and 10 points
Half-marks are permitted - so, for example, 8½ would be a legal score.
Members enter up to three images, but only the top two scores count towards their total.
To create such a scheme:
From the Scoring menu
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, click Create a new schem e...

You'll be taken to the Sc o ring Schem es dialog box:
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Change the scheme name to something appropriate (for example, "My Author").
Make sure the Club Co m petitio ns button is selected and click the Each Slide is Sco red tab at the top of the dialog box:

© 2 0 17 A n dre w Pe ppe r

1 81

1 82 Film Free Projection Extended

Set the fields of this page to match the requirements; the sample above is correct - in fact, this is the default setting.
Click OK and the scheme will be saved.

Scoring a Competition
If the "By Author" scheme is not the default scheme, then it will need to be selected from the Scoring panel:
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Before a competition can be scored, you need to turn scoring on by clicking the Sco re button on the Score panel:

FFPx will check the loaded sequence to make sure that all images have an Author name set and that no-one has entered more than
the maximum number of entries permitted. Assuming all is well; you will see a message to confirm the scheme that is in use:

Once the projector is turned on, there are two ways you "score" an image:
By typing the score as a number followed by the Enter key. To enter a score such as 8½ you can should enter 8.5 or, if the W hen
Sco ring, press '.' fo r a half option has been turned on, then you can enter 8. - FFPx will automatically insert the half point.
Or you can click in the score column next to the image being scored; a table of possible scores will be displayed and you can click the
appropriate score.
At any point, you can display a report on the competition by clicking the Sho w Results button on the Score panel.
A results summary will be shown for the current scheme:
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More about the result reports is here
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2.8.5

Season Results

For competitions that are author based, FFPx can calculate the overall results for a collection of sequences - provided, of course, that
you remembered to save the sequence at the end of competitions.
To calculate a season results, click the lower half of the Sho w Results button on the Score panel.

To add sequences, you click the Add Sequence(s) button; a standard file selector dialog is opened and you can select FFPx sequence
files. You can continue adding sequences until an entire season is present. For example:

© 2 0 17 A n dre w Pe ppe r

1 85

1 86 Film Free Projection Extended

FFPx sets the competition date from the "last modified" field of the sequence file; you can change the date by clicking the arrow
beside the appropriate field.
FFPx needs to know the scoring scheme to use to calculate the season results; you can set the scheme in the Sco ring schem e fo r
results dropdown.
When all the sequences have been added, click OK .
FFPx will calculate an overall result by examining the score each author received in each competition:
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2.8.6

Scoring By Slide

This is probably the simplest scoring scheme; each projected image is given a score. At the end of the competition, the image with the
highest score is the winner.
In practice, this is a rarely used scheme. However, it is a useful one to have available. For example, if you competitions are normally
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scored "by author" then the scoring result report will show the winning author. The Co m petitio n repo rt dialog allows you to change
the scoring scheme for the report and if you change the scoring scheme to "by slide" then you will see the top scoring images of the
competition listed.

Creating a "By Slide" Scheme
In the following example, we'll create a scoring scheme for the following style of competition:
Images are given a score between 0 and 10 points.
Half-marks are permitted - so, for example, 8½ would be a legal score.
To create such a scheme:
From the Sco ring menu, select Create a new schem e...
Replace the "Untitled" name with a suitable name for the scheme; for this example we'll use "By Slide".
Click the Each Slide is Sco red tab at the top of the dialog box.
For our example, the defaults are close to what's required, but you must make sure that Autho r/club's sco res are added to gether
isn't checked.
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Click OK and the scheme will be saved.

Scoring a Competition
If the "By Slide" scheme is not the default scheme, then it will need to be selected from the Scoring panel.
Before a competition can be scored, you need to turn scoring on by clicking the Sco re button; FFPx will produce a message to
confirm the scheme that is in use.
Once the projector is turned on, you "score" you have two ways to score an image:
By typing the score as a number followed by the enter key. To enter a score such as 8½ you need to type 8.5.
By clicking in the Score area beside the selected image; a table of scores will be produced from which you can select the score.
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At any point, you can display a report on the competition by clicking the Sho w Results button on the Scoring panel.

More about the result reports is here
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2.8.7

Scoring Place Based Competitions

In this scheme (also known as an ordinal scheme) the "best" image in the competition is award First place, the second best Second
place and so on.
There are two variations to the place based scheme:
1. As camera clubs often run a year-long league, the "placed" images are usually awarded points based on their position.
2. Some clubs award all entered images a score - to encourage members to enter images.

Creating a "Place Based" Scheme
For our example, we'll create a placed based competition with the following settings:
There will be four places; First, Second, Third and Fourth.
A default score of 1 point is awarded to each entered image.
First place will receive 10 points, second 8 points, third 6 points and fourth 4 points.
Click Create a new schem e... from the Sco ring menu to open the Sco ring Schem es dialog
Change the "untitled" name to something more suitable; for example, "Place Based".
Click the Place Based tab at the top of the dialog box:
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Make sure the Co m petitio n is placed based checkbox is ticked.
The example above shows the default places; it's close to what we want, but not exactly right. We need to delete row 5 - to do that,
click the row and then click the Del. Ro w button. The last row will be deleted.
Next, we want to rename the fourth position to be called "Fourth". To do that, click in the current name for row 4 ("First Highly
Commended") and type "Fourth". Finally, change the Default sco re fo r slide to 1. The panel should look like this:
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Click OK and the scheme will be saved.

More on Placed Based Scoring
Up to 9 places can be specified and for each place, you can set the maximum number of each place (again up to 9). For example, you
may have 4 places; First, Second, Third and Highly Commended but up to 5 Highly Commendeds are allowed. To set the number of a
position allowed, click the M axim um in this Po sitio n button; a counter will appear to allow you to specify the number. The
completed Place Based dialog would look like this:
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Scoring a Competition
If the "Place Based" scheme is not the default scheme, then it will need to be selected from the Select Schem e to use option from
the Sc o ring menu:
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Before a competition can be scored, you need to turn scoring on by clicking the Sco re button on the Sco ring panel. FFPx will
produce a message to confirm the scheme that is in use.
Once the projector is turned on, you can "place" an image either by typing the number of the place; for example, to indicate an image
gets first place, you type "1" - the score window will appear showing the place:

To confirm the place, press the Enter key. You can change the place by typing the appropriate number (2 for second, 3 for third and so
on). You can abort the place setting by pressing the Esc key.
Alternatively, you can click in the score area alongside the image in the detailed view and a table of possible places will be produced:

Correcting Mistakes
If you need to remove an image's place (for example, you gave the wrong image first place) then Freeze
the image and you should see a Clear Sco re(s) option on the menu that appears:
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Select the Clear Sco re(s ) option and you will be asked to confirm the score should be cleared; click Yes and the place will be cleared
(in fact, the score is set to the default score for images). Note that the Clear Sco re(s) option only appears if the selected image has a
score.
At any point, you can display a report on the competition by selecting the Sho w Results ... option from the Sco ring panel.
A results summary will be shown for the current scheme:
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More about the result reports is here
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2.8.8

Scoring Panels

In a panel based competition, authors enter Panels of images. When scoring a panel based competition, FFPx will add together the
score for each image in a panel to calculate a panel score. The panel with the highest total is the winner.
144

Creating a Panel Scheme
In the following example, we'll create a scoring scheme for the following style of competition:
Images are given a score between 0 and 10 points.
Half-marks are permitted - so, for example, 8½ would be a legal score.
To create such a scheme, click the Create a new schem e... option from the Sc o ring menu. This will open the Sco ring Schem es
dialog .
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Change the "Untitled" name to something more suitable; for example "Panel Based".
Make sure the Panel Co m petitio ns button is checked:
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Click the Each Slide is Sco red tab at the top of the dialog box:
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The default settings shown above are correct for our scheme.
Click OK and the scheme will be saved.

Scoring a Competition
Before selecting the scoring scheme, make sure FFPx is working in Panel mode - otherwise FFPx will disable the panel based scoring
schemes. If the "Panel Based" scheme is not the default panel scheme, then it will need to be selected from the Sco ring panel:
144
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Note that the non-panel based schemes are greyed out.
Before the competition can be scored, you need to turn scoring on by clicking the Sco re button on the Sco ring panel; FFPx will
produce a message to confirm the scheme that is in use.
Once the projector is turned on, you "score" an image in one of two ways:
By typing the score as a number followed by the enter key. To enter a score such as 8½ you need to type 8.5.
By clicking in the Score area alongside the image in the detailed view; a table of possible scores will pop-up and you can click the
appropriate score.
At any point, you can display a report on the competition by selecting the Sho w Results ... option from the Sco ring panel.
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More about the result reports is here
2.8.9
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Scoring InterClub Competitions

Scoring an InterClub competition is very like scoring a "By Author" club competition; each image is given a score and at the end of the
competition the winner is the club with the highest total. For InterClub competitions, FFPx uses the club's folder name as the club
name and that is used to calculate the score so it is not necessary for the images to have author names set.

Creating an InterClub Scheme
In the following example, we'll create a scoring scheme for the following style of competition:
Images are given a score between 0 and 10 points
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Half-marks are permitted - so, for example, 8½ would be a legal score.
Clubs can enter up to 20 images and all of them count.
To create such a scheme, click Create a new schem e... from the Sco ring menu. The Sco ring dialog will appear.
Change the "Untitled" name to something more suitable; for this example, we'll use InterClub. We've also selected InterClub as the
competition type:

Next, click the Each Slide is Sco red tab at the top of the dialog box:

© 2 0 17 A n dre w Pe ppe r

203

204 Film Free Projection Extended

The only changes that were needed were to change the M axim um num ber o f slides per autho r/club and Num ber o f slides per
autho r/club that co unt to wards the sco re to 20.
Click OK and the scheme will be saved.

Scoring a Competition
First of all, you will need to select InterClub as the competition type from the Sim ple Co m petitio ns panel on the Co m petitio ns tab.
Next, make sure that the InterClub scoring scheme is selected on the Scoring panel:
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Before a competition can be scored, you need to turn scoring on by clicking the Score button on the Scoring panel; FFPx will confirm
the scoring scheme in use.
Once the projector is turned on, there are two ways of scoring an image;
By typing the score as a number followed by the Enter key.
By click in the Score area along side the image in detailed view. A table will pop-up with the possible scores.
An option on the FFPx Settings

306

dialog allows you to project the club name after an image has been scored.

At any point, you can display a report on the competition by clicking the Sho w Results button on the Sco ring panel:
A results summary will be shown for the current scheme:
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In the default view, you see each club with each image score. You can see the overall state of the competition by clicking the
Overview button:
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More about the result reports is here
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2.8.10 Scoring Multi-Leg Competitions

Multi-Leg competitions are scored in a similar way to a regular "By author" style competition. The difference is when the results are
calculated: FFPx can examine the surrounding folders for other FFPx sequence files which contain the other club's scores for the same
sequence of images and produce a combined result.
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To produce the Multi-Leg report, you start by loading the sequence file from your camera club; this might produce a result like this:

Next, click the M ulti-Leg Co m petitio n button at the top of the report window. FFPx looks in the surrounding folders; for example, if
the path for your camera club sequence is;
C:\Users\Ho m e\Do cum ents\Co m petitio ns\M ultiLeg\Ho m e\Sequence.FFPx
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then FFPx will look in all the sub-folders in the
C:\Users\Ho m e\Do cum ents\Co m petitio ns\M ultiLeg\

folder for sequence.dss files. This directory structure is created by FFPx when you save a sequence for Multi-Leg competitions, so
providing things haven't been moved FFPx should find all the sequence files. FFPx combines the scores to produce an overall result:
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2.8.11 Scoring Mix & Match Competitions

Mix & Match competitions are somewhat different from other scored competitions as FFPx will prompt you for a score, rather than
you entering a score.

Creating a Mix & Match Scheme
In the following example, we'll create a scoring scheme for Mix & Match with the following rules:
Teams are awarded two points for each image that "matches".
If no match is found for an image, then two points are awarded.
In each round, 1 point is awarded to the best image shown, regardless of whether it matches.
There is a 60 second time limit to match the image.
To create such a scheme:
Click the Create a new s chem e... option from the Scoring menu.
The Sc o ring dialog will open; change the "Untitled" name to something more suitable; for example, "MixMatch" and change the
competition type to M ix & M atch . The dialog will look like this:
172
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Click the M ix & M atch tab at the top of the dialog:
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The settings shown above are almost correct for the scoring scheme we described, we just need to check the Tim e lim it to m atch
im age check box and set the time to 60 seconds.
The scoring of a Mix & Match competition is described here
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2.8.12 Scoring with Multiple Scores per Image

Some competitions have several judges each of whom allocate a score to an image.
FFPx supports up to six scores per image. When multiple scores are being used then when a score is entered, the score window will
look like something this:
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In the above example, two scores are recorded per image; one score has been entered (8).
Individual scores will only be registered when the Enter key is pressed. So to register two scores of (say) 8 and 7, you should type:
8 <Enter key>
7 <Enter key>

There are two ways these scores can be entered:

Using a Single Keyboard
With a single keyboard, each score is entered from a single keyboard - usually the laptop keyboard. The scores are recorded in the
order they are entered.

Using Multiple Keyboards
To use multiple keyboards, the scoring scheme in use must have the Num bers o f sco res per slide to be more than 1 and there
must be more than one keyboard connected to the PC.
Before the competition, you can setup which keyboard is associated with which score and which keyboard is a "master" keyboard - ie
which keyboard can edit a sequence.
Setting up Multiple Keyboards
On the Sco re panel, click the More button and choose Setup M ultiple Keybo ards... from the menu that appears. The Setup
Multiple Keyboards dialog appears:
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To associate a particular score box with a given keyboard, click the score box with the mouse, then press a key on the appropriate
keyboard:
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In the example above, score box 1 (shown as Sco re (1) ) has been clicked and a key pressed on one of the two keyboards connected
to the computer. The other score box is still awaiting a click by the mouse.
Once all the score boxes have had a keyboard associated with them, click OK and you can proceed with the competition.
As it is essential that this keyboard association is performed before a multiple keyboard competition is scored, FFPx will check to see
if it has taken place when the score button is clicked or if a sequence with a scoring scheme with multiple keyboards is loaded.
Setting the Master Keyboard
The "master" keyboard can edit sequences; pressing the delete key will remove the current image, the cursor keys can be used to
select images and so on. By default, any connected keyboard can edit a sequence, but if you have several judges scoring images, you
may want to stop their keyboards from deleting images - remember they are using the keyboards in the dark!
To set the master keyboard, from the Sco re panel, select the More button and choose Select the M aster Keybo ard... from the
menu that appears. The Master Keyboard dialog appears:
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Follow the instructions on the dialog; press a key on the keyboard you want to be the master (usually the laptop keyboard). Confirm
the selection by pressing a key on the master keyboard again and the selection will be confirmed.
Unfortunately, FFPx can't "save" the master keyboard; the keyboard identities change depending on which USB socket they're
plugged into.
Scoring with Multiple Keyboards
Scoring a competition with multiple keyboards is much like scoring with a single keyboard. A score can be entered on any of the
keyboards - in fact scores can be entered simultaneously. FFPx records which keyboard entered which score. However, as with the
master keyboard, the keyboard "mapping" is not stored as part of the sequence as the order keyboards appear will change depending
on which USB socket they are connected to.
If you unplug a keyboard whilst a competition is in progress, then FFPx will revert to single keyboard scoring - even if there is still
more than one keyboard connected.
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Abstaining
When multiple scores are being recorded per image, it's possible one of the judges to "abstain" - usually when one of their own
images is being projected. To abstain, enter an asterisk character ("*") followed by the Enter key; FFPx will calculate the average of the
other scores and replace the abstaining judge's score with the average.
2.8.13 Voting for Images

This is an exception to the rule that all scored competitions require a scoring scheme; in this system a typical competition starts by all
the images being shown to the club members, then each member votes for their top 3 (say) images.
To enter the votes for images, click on the Vote button or select Vote for Images... from the Scoring menu.
The Vote for Images dialog appears:
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You can change the number of images each member can vote for by changing the Vo tes per perso n value.
If the Vo ting o rder indic ates preference check box is cleared, then each vote counts equally - FFPx will give 1 point for each vote an
image receives. If the check box is checked then the order the image numbers does affect the value of each vote and FFPx gives 3
points to the first image, 2 points to the second and 1 point to the third.
FFPx checks the entry of votes; a member can't vote for the same image twice and the image number can't be higher than the
number of images.
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Once the voting is complete, you can click OK and return to the detailed view to see the points awarded to each image. If you click on
the Sco re label at the top of the detailed view, the images will be sorted by score - giving the result of the competition.
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2.9

Scoring Results
FFPx can generate five different report styles; Panel based, Placed based, By Author, By Slide and Mix & Match. The style of report
produced depends on the scoring scheme in use. "Locked" images are ignored for scoring purposes and do not appear in the results.
To show the Competition Results dialog, click Sho w Results from the Sco ring panel on the ribbon or select Sho w Results from the
Sco ring Schem e menu - that's opened by clicking the More button on the Scoring Scheme status panel towards the bottom of the
FFPx window.

Panel Based
In a panel based competition, the results report shows the highest scoring panel first, second highest next and so on:
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Place Based
In a place based competition, the results are shown in "place" order:
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By Author
For these competitions, the results are presented with the highest scoring author in first place, the second highest scorer in second
place and so on. The report takes into account the Num ber o f sco res per autho r that co unt to wards the sco re number which is
set in the Sco ring Schem e Dialog .
172

The example below is a By Author results report:
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For By Author competitions, if you click the Appearance drop down and select Sum m arize Repo rt you can display an overview of
the results which doesn't show the individual image scores. For example, if Sum m arize Repo rt has been selected for the above
competition, the result looks like this:
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By Slide
In this competition, the results are shown with the highest scoring slide in first place, the second highest in second place and so on:
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Images which have been "locked" are assumed to be title slides and will not be displayed in the result report.

Scoring Separate Subjects
Some camera clubs have competitions with a mix of set-subjects and "open" images. For example, a competition may comprise a mix
of Portraits and Open images. FFPx can calculate a score for individual subjects or all the images. For example, Andrew, Bill and
Charlie enter a competition; two images can be entered and these can be either Portraits or Open - the list of images could look like
this:
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If you look at the scores for each image, there are three ways of interpreting this:
Overall Andrew is the winner; he has the highest scoring image (Bluebell.jpg scored 9).
For the Open images, Charlie is the winner with Moon Rise.jpg scoring 8½.
For the Portraits, Andrew is the winner (again with Bluebell.jpg).
For FFPx to be able to score such competitions, the Subject field of the image has to be set. This can be set using Windows 88 or using
the Pro perties 48 option from the image context menu. In Photoshop, this field is called the Description and is set from the
Descriptio n page of the Im age Pro perties dialog.
By default, the Subject field is not shown on the detailed view. You can turn on the display of the subject field by right clicking the
title bar of the detailed view and clicking Sho w Titles or by using the FFPx Settings dialog for the detailed view.
309

With the Subjects turned on, the image table looks like this:
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Competitions with subjects are scored as usual, but when the competition report is displayed, the calculation performed can be
changed by using the Calculate fo r Subject drop down menu. For example, the following is the result report for a competition
scored by slide:
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Note that at the base of the display, we're told that FFPx is "Showing results for 'All Images'". If we click the Set subjects more
button and change the Calculate fo r Subject option down to po rtrait , then the report changes to look like this:
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Now only the images with Portrait in their subject field are scored. Similarly, by selecting o pen from the dropdown, the results are
shown with only Open images.
Default Subject
If any image does not have the Subject field set to anything then you will need to define a Default Subject - the subject to which FFPx
will assume an image belongs if there is nothing in the Subject field; FFPx will prompt you if you try and calculate a score report by
subject if there are some images without a subject:
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Click the drop down and select a default subject from the list. Note that FFPx generates the list of subjects from the subjects present
in the loaded images, so there must be at least one image with the required default subject.
You can change the default by clicking the Set subjects
Subjec t option.

menu on the Co m petitio n Repo rt dialog and then selecting the Default

Report Broken Down by Subject
An alternative report style is to have the report show the scores for each subject in turn. For this type of report, select All Subjects
from the Calculate fo r Subject dropdown. A report generated with this style looks like this:
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Mix & Match Reports
Mix & Match competitions have a relatively simple report as individual image scores are not recorded, only the overall team position.
A typical report looks like this:
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Displaying Thumbnails
It is possible to add thumbnails to reports, apart from:
Panel based
Author based in Overview mode
Mix & Match Reports
To add thumbnails to a report, select the Sho w Thum bnails option from the Appearance more button. An example report with
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thumbnails is shown below:

Note that if thumbnails are part of a report, then this affects saving the report

237

.

Zooming the Report
You can change the size of the text of the report by clicking the Zoom icon; a slider will appear and you can use it to set the font size.
If the report is being projected, the projected report is also zoomed.
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Changing the Report Scheme
It's possible to change the report by using more button on the Scoring Scheme panel. Note that you cannot generate a report for a
panel based competition using a non-panel based scoring scheme and similarly, you cannot use a panel based scoring scheme to
score a non-panel based competition.

Changing the Report Appearance
As you would expect, the Appearance more button has items to change how the report appears. FFPx has several different report
styles available, and it's easy to add your own. To change the overall style, select the Overall Style... option from the Appearance
more button. The Select Sco re Repo rt Style dialog opens:

You can choose a new style for the report from the Select Style dropdown. You can modify the selected style by changing the
elements in the Style Details area or click the Create New Style button to create a new style which you can define in the Style
Details . You can delete the selected style by clicking the Delete this Style button.
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Restoring the Default Styles
To restore the default styles, use the Delete this Style button repeatedly until all the styles have been deleted, the defaults will be
restored.

Report Settings
To change the settings of the displayed report, select the Settings... from the Appearance
Repo rt dialog will be displayed:

dropdown. The Co nfigure Sco re

As you can see, you can configure a number of items about the competition:
The Cam era Club Nam e , Co m petitio n Nam e , Co m petitio n Date and Judge nam e(s) options are self-explanatory. The Extra
Co m m ents field is for overall comments about the competition.
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FFPx will save the name of the Camera Club so it will appear on future reports as well as saving the foreground and background
colours for the report page, the remaining competition parameters will not be saved.
In the General Settings area, you can choose how FFPx handles "tied" images. For example, suppose Andrew, Bill and Charlie have
scored 18, 18 and 17 respectively. Andrew and Bill are equal first, but should Charlie be second or third? Some clubs would give him
second place as he has the second highest score, some third as there are two people ahead of him. In the General Settings area,
select If there are tied po sitio ns, leave appro priate gaps to leave a gap (so in our example Charlie would be third), select If there
are tied po sitio ns, do n't leave gaps not to leave a gap - so that Charlie is placed second.

Score Report Columns
You can choose the columns that are displayed in the score report from the Appearance
dropdown. The Sho w Thum bnails ,
Filenam es , Date and Co m m ents fields are self-explanatory, the M inim um Sc o re option allows you to set the minimum score
required to appear in the report.

Multi-Leg Competitions
If the competition you are calculating the results for is part of a Multi-Leg competition, then you can click the M ulti-Leg Co m petitio n
button. FFPx will examine the "surrounding" folders for sequence.dss files and calculate an overall result for the competition. There
is more about Multi-Leg competitions here .
139

Sorting the Results
You can sort the results of most types of competitions by right clicking the results table and select the So rt by... option:

By default, sequences are sorted by score in descending order with the highest score first. Sorting by Author sorts the results by
author name in alphabetical order. Sorting by Comment sorts the results by the contents of the Comment 75 field. Images with
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comments will be sorted, images without comments will be placed after those images in score order. One use for this is when a
competition is scored but the judge also gives a "top 3" images; in the comment fields, you can put "1", "2" or "3" to indicate the top
three images, then when showing the result, sort by comments.
The sort option isn't available for panel based, Mix & Match or KnockOut competitions.

Projecting the Results
You can project the results by clicking the Project Report icon ( ). This will show the results information on the second monitor (ie
the digital projector). Note that this option is only available if you have the second monitor enabled on the computer.

Printing Reports
To print the report, select the Print Repo rt icon (
print the report.

), the standard Windows print dialog will be produced to select the printer and

Saving Reports
You can save the report as an HTML or PDF file; this makes it easy to display without needing to have FFPx installed on the computer
and you can also incorporate result reports into the club website.
To save the report, select the Save as htm l (
) or save as PDF (
to allow you to choose a filename for the saved file.

) button. The standard Windows save file dialog box will open

If your saving an HTML version and the report has thumbnails, then a folder called Im ages is created in the folder where the report
has been saved; this holds the thumbnails associated with the sequence. This has two consequences:
If you try and save two reports with thumbnails to the same folder, then the Im ages folder will be overwritten - so only the later
report will correctly show thumbnails.
If you want to move the saved report with thumbnails to another folder or computer, then you must also move the associated
Im ages folder.
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2.10

Exporting and Importing

2.10.1 Exporting Sequences

You can export sequence information in five different ways:
1. Tabs, Sequences and Images
2. Sequence and Images
3. HTML
4. Comma separated values (CSV)
5. Filtered Export.
The first two options makes it easy to transfer all the tabs (including all the sequences and associated images) or a single sequence,
again including the associated images from one machine to another; many projectionists prepare the sequence(s) on one computer
and then want to transfer everything to a second computer for running competitions.
HTML exporting generates an HTML version of the sequence that can be shown on any computer with an Internet browser. This is
intended for use in competitions where pre-judging is to be used; in this situation, the judge is sent the HTML version of the sequence
and a printout of the score sheet and scores the images before the actual competition. An HTML sequence is used as it is unlikely that
the judge will have FFPx installed on their computer.
CSV (or comma separated values) is used to allow you to transfer the sequence information to a spreadsheet program. As the
exported CSV file includes scores, this makes it possible to process the scores from several competitions using the spreadsheet
software. The CSV file is a plain text file, so it is possible (with care) to modify an exported CSV file and then to import it back into
FFPx.
The Filtered Export allows you to selectively place images into folders based on a range of criteria (including their score).
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2.10.1.1

Entire Sequence as CSV

Exporting a sequence as a comma seperated value (CSV) file allows you to load a scored sequence (or indeed an unscored sequence)
into a spreadsheet program. To export the sequence as a CSV, select the Expo rt menu from the File menu and click the Expo rt as
CSV option:

If there is no scoring scheme defined, then you will move straight to a file selection dialog to select the file to export the sequence and
the entire sequence saved; the exported file is in the form:
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For Club Competitions with a single score, the file is of the form:
Number, Filename, Full Path, Author, Title, Subject, Comment, Score
For Club Competitions with multiple scores, the file is of the form:
Number, Filename, Full Path, Author, Title, Subject, Comment, Score, SubScore (1),SubScore(2),...SubScore(n)
The score column holds the total score and each SubScore column holds the individual scores. The number of SubScore columns is set
in the Sco ring Schem e dialog as the Num ber o f sco res per slide value.
173

If the competition is place based, then the format is:
Number, Filename, Full Path, Author, Title, Subject, Comment, Place
For panel competitions, the format is:
Number, Filename, Full Path, Author,Title, Subject, Panel Name, Slide no, Comment, Score
For InterClub competitions, the format is:
Number, Filename, Full Path, Author, Title, Subject, Club Name, Comment, Score
An example Club Competition with single score exported sequence, loaded into a spreadsheet looks like this:
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Sequences exported as full sequences can be imported back into FFP . Note that if you modify the author, title or subject in the
CSV, the modified values will not replace those extracted from the image files when you import them. How to modify the author, title
or subject fields of image files is explained in the EXIF, XMP and IPTC 87 section.
254

2.10.1.2

Using Scoring Scheme

If you select the Expo rt as CSV option and there is a scoring scheme defined for the current sequence, then the Co m m a Separated
Values Expo rt Optio ns dialog box will appear:

This dialog allows you to select to either export the entire sequence (as described here ) or you can export the results of a
competition calculated using a scoring scheme; there are four different formats for the exported sequence:
239

Scored by Author
With this scheme, the exported file is of the form:
Position, Author, Score, Title, Subject, Points, Filename, Comment
An example export, imported into a spreadsheet looks like this:
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Note that the exported sequence is in position order, so the first place author is first, second placed second and so on.

Scored by Slide
With this scheme, the exported file is of the form:
Position, Title, Author, Filename, Subject, Score, Comment
An example scored by slide export; imported into a spreadsheet looks like this:

Placed Based Scores
With a placed based scoring scheme, the exported file is of the form:
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Position, Title, Author, Filename, Subject, Place, Score, Comment
An example placed based export, imported into a spreadsheet looks like this:

Scored by Panel
With a panel based scoring scheme, the exported file is of the form:
Position, Panel Name, Author, Scores, Total
An example panel based export, imported into a spreadsheet looks like this:
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InterClub Competition
With an InterClub competition, the exported file has the format:
Position, Club Name, Score, Author, Title, Subject, Points Filename, Comment
An example InterClub competition, imported into a spreadsheet looks like this:

2.10.1.3

As HTML as Slide Show

If you want to give a third party a sequence they can view with an Internet browser then you can export the sequence as an HTML
Slide Show. HTML (HyperText Markup Language) is the language recognised by Internet browser software. To export a sequence to
HTML, select the Expo rt as HTM L Sequence option from the File menu:
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You will be asked for an HTML filename:
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As an example, we've used TestSequence as the filename. Clicking the Save button will generate the HTML sequence. If you use
Explorer to examine the folder where the sequence was saved, you will see the HTML filename you typed together with a folder with
the same name - this folder is part of the sequence and is required along with the HTML file:
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If you load the generated sequence into a browser (the easiest way is to double click the HTML document), the browser screen will
look like this:
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As indicated, pressing F11 will expand the browser to fill the screen. Users of Microsoft Edge won't see this message as Edge doesn't
support F11 to switch to full screen. You can click any of the thumbnail images to show an enlarged version; at the base of the
enlarged image you will see something like this:

The image number is the number of the image in the sequence; this will correspond to the image number in a printed score sheet.
The image title is shown in brackets after the image number.
The Prev link will go to the previous image in the sequence; this is the first image in the sequence so this link is disabled. The Ho m e
link takes you back to the original thumbnail display, Next will go to the next image.
2.10.1.4

Filtered Export

Filtered export provides a way to store images in folders depending on a range of criteria. For example, suppose there has been a
selection process where images are being selected for an exhibition. Each image is given a score out of ten, at the end of the selection
process you may want to store all the images that score 9 or more for the exhibition and store all the images that scored 8 for later
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evaluation. This is easy with filtered export.
To start the Filtered Expo rt dialog, select Filtered Expo rt from the File menu. The dialog will be shown:

For our example, we want to export all the images with a score of 9 or more. To do that, we put 9 in the M in Sco re area and tick the
Apply checkbox. Note that the Target Fo lder shows the folder name that will be created for this export and the M atches area shows
the number of images that match the filter:
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For the second part of the requirement (to store all the images that score exactly 8 separately), we click the Add Filter button and in
the new filter that appears put 8 into the M in Sco re and M ax Sco re areas and tick Apply:
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We need to set the destination folder for the export; to do that we click the Change... button alongside the Expo rt to fo lder area. A
folder selection dialog open and we select a destination folder (Exported Images):

© 2 0 17 A n dre w Pe ppe r

251

252 Film Free Projection Extended

With the Expo rt to fo lder destination folder defined, the Expo rt button is enabled. Some status text also appears to let us know
what will happen when we click Expo rt .
Finally, we click Expo rt . The export will be performed, if we use Explorer to navigate to the Expo rted Im ages folder we find two
folders containing the exported images:
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More about the Filtered Export
The Help button will open the context sensitive help for the Filtered Export.
You can define up to 8 filters.
The M in Autho r To tal and M ax Autho r To tal values are used to filter images based on the total score by the author.
If you are scoring a panel based competition, then the M in Autho r To tal and M ax Autho r To tal columns will be replaced by M in Pnl
Sco re and M ax Pnl Sco re - used to filter images based on the score a panel has received.
You can practise using Filtered Export by using the Hold Back Filter 76 . This is a very similar dialog that holds back images based on
the filter, so you can see the affect of filters without creating folders.
The source images of a sequence can come from several folders and it is therefore possible that two images might have the same
filename. If, when exporting images, two images have the same filename, FFPx will create a new filename for one of the images. For
example, if two images both have the name "image.jpg" then FFPx will rename one of the images to be "image(1).jpg".
In a similar way, if images are already present in the target folder for an export, then FFPx will create new filenames for any duplicated
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filenames.
2.10.2 Importing CSV Sequences

FFPx can import CSV sequences, provided that they have been exported as full sequences - ie not those exported using a scoring
scheme.
As with FFPx sequence files (.FFPx files) the .CSV file does not store the image files, only the location of the image files. The import will
only work if the image files are in the same locations as they were when the exported .CSV file was created.
To import a sequence, you select the Im po rt CSV, from the File menu:
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Importing a CSV sequence will cause any existing sequence to be discarded. You will be asked for the sequence to import.
When importing the sequence, FFPx will attempt to select an appropriate scoring scheme; if there is more than one suitable scheme
you will be asked for the scheme to use:
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Note that if you change the author, title or subject in the CSV then this will not replace the metadata associated with the image; the
image metadata will be used.
2.10.3 Exporting and Importing Settings

The FFPx Settings can be exported for transfer to another computer running FFPx or to allow several different settings to be used.
To export the current settings, select Expo rt settings... from the Settings panel's more menu:

A select file dialog opens; select the file for the settings.
To import a previously saved settings file, select Im po rt settings... from the same sub-menu.
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2.11

Selecting Images for Exhibitions or External Competitions
Introduction
As well as running club competitions, FFPx can also be used to select images for exhibitions or external competitions.
A typical scenario for image selection is that each member submits a number of images (up to 5 say). A panel of judges views the
member's images and each judge votes for their favourite image. The image with the highest number of votes is "selected".
A slight complication of the scheme described is if, after the selection process, there aren't sufficient images for the exhibition. In that
case, the "second best" images of each member are assessed and, again, judges vote on them to pick the "best runner up". The
process is repeated until sufficient images are chosen.
There are a number of options for selection mode; for example, the above scheme assumed that every member gets at least one
image selected. It also assumes that judges can't "abstain".
The FFPx selection system provides a flexible system to cater for these variations. FFPx has Selection Schemes, similar in concept to
Scoring Schemes. You can define many different selection schemes. For example, your club may use one scheme to pick one image
per member. For the second round a different scheme could be used. You could define two schemes called "Round 1" and "Round 2"
and select the appropriate scheme for each round of the selection process.
When you save a sequence in selection mode, the associated selection scheme is saved along with the sequence.

Selection Dialog
To define selection schemes and to choose to run in selection mode, click the Selectio n M o de button on the Co m petitio ns tab. The
Select Im age fo r Exhibitio n dialog appears:
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At the base of the dialog are options available for all the tabs. Going through these:
Help displays context sensitive help for the dialog.

The Pro cess Selec ted Im ages button performs the selection option set in the When Selected area.
Delete removes the currently selected selection scheme.
Save saves any changes to the currently selected scheme.
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OK exits from the Select Images for Exhibition dialog. If you have made changes without saving them, then you be asked if you

want to save the changes. If you don't save changes then they will not take effect.
Cancel cancels the dialog.

2.11.1 Selection General Settings

The General Tab
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Going through the options on the General tab:
If the Run in Selectio n M o de checkbox is checked, then FFPx will run in Selection mode.
If you have previously defined selection schemes, then you can select these from the Select an existing schem e dropdown menu.
The Create New Schem e button will create a new selection scheme; you will be asked for a name for the new scheme.
If the This is the default schem e checkbox is checked then this is the scheme that is loaded automatically if no scheme has
previously been selected. If there is only one scheme, then it is automatically made the default scheme.
If the Sho w Statistics checkbox is checked then FFPx will superimpose statistics about the selection process on the projected imageshowing how many images have been selected and how many more are required.
The W hen Selected area contains checkboxes for the possible actions to take when the Pro cess Selected Im ages button is clicked.
The options are:
If Transfer selected to fo lder is checked then the selected images are moved into the specified folder. The images are removed
from the sequence so all that is left are the unselected images.
If Save in Separate fo lders is checked then folders are created in the specified folder; one folder for each of the marks received.
For example, if there are 4 judges, the possible scores are 0, 1, 2, 3 or 4. When the Process Selected Images button is clicked, a
folder will be created for each of these possible scores (the folders have the names "0", "1", "2", "3" and "4"). All the images that
scored 0 points will be copied to the folder called "0", all those that scored 1 are copied to the folder "1" and so on.
If Transfer selected to new tab is checked, then a new tab called Selected Images is created and the selected images moved to
that tab. The images are automatically removed from the original sequence.
If Rem o ve Unselec ted is checked, then the unselected images are removed from the sequence.
You can combine these options; they are processed in the order they are shown, so if you check Transfer selected to fo lder and
Trans fer selected to new tab then only the first option will actually do anything as once the images have been transferred to a
folder, there won't be any selected images to transfer to a new tab.
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2.11.2 Selection Scheme Options

Going through the Schem e Optio ns tab:
The minimum and maximum entries per author counters are largely self-explanatory; FFPx will warn you if someone has submitted
too many entries.
The Num ber o f Judges counter sets the maximum number of votes that can be received by an image.
The Num ber o f Im ages Required is the number of selected images required; if Show Statistics
how many images remain to be selected as each image is projected.

260

is turned on, then FFPx will show

If the Gro up im ages by autho r and so rt by subject checkbox is checked, then when you are running in Selection mode, FFPx will
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sort the images so that each author's images are grouped together, but then sort each group by the Subject field of each image. This
means that if you want to select images by looking at groups of authors' images, the author can specify the order they are shown by
putting the appropriate number into the Subject field.
For example, Andrew wants to enter four images into the selection process. He set the Author name to be "Andrew" for each image
and then chooses the order he wants them to be seen; he then sets the subject field of the first image to be "1", the subject of the
second image to be "2" and so on. There are instructions about setting the author and subject using Windows and/or Photoshop here
88 .
This sorting mode is also an option on the Shuffle

62

dropdown menu.

If you have turned on the Gro up im ages by autho r and so rt by subject checkbox, then you can also turn on the Insert title slides
between Autho r Gro ups checkbox. If this is turned on, then slides are inserted between the groups, partly this is to make it clear
when you switch from one author to the next, but the title slide can also show information about the selection process. There is more
about that in the Designing Selection Title Slides section.
265
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2.11.3 Selection Criteria

Going through the Selec tio n Criteria tab options:
If the Judges m ust vo te fo r o ne im age per autho r checkbox is checked, then FFPx can automatically calculate the number of votes
for the final image in the author's group. For example, if Andrew has entered 4 images and there are 6 judges, then if the first 3
images receive a total of three votes, the final image must receive 3 votes. FFPx produces an explanatory message:
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If the checkbox is not checked, then judges can abstain; choosing not vote for any image.
If the At least o ne im age per autho r is selected then FFPx will check each authors images; if all their images have been voted upon
but none were selected, then a warning message is produced, for example:

The M inim um sco re fo r selectio n counter contains the number of votes required for an image to be selected. If the Judges m ust
vo te fo r o ne im age per autho r checkbox is checked, then this number is calculated and can't be changed; for example, if there are 6
judges then the minimum score for selection must be 4.
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2.11.4 Designing Selection Title Slides

The Selectio n Title Des ign dialog is opened by clicking the Design Titles button on the Select Im ages fo r Exhibitio n
The dialog that appears looks like this:

Selection title slides can be inserted automatically between author groups; the option is on the Schem e Optio ns
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tab of the
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Select Im ages fo r Exhibitio n dialog.

Going through the dialog:
At the top of the dialog, a preview of the title slide is shown.
The Selectio n Title Bac kgro und Im age area allows you to set the background to be used for the selection title slides; this can be
one of the built-in backgrounds, a solid colour or an image file.
The Heading area contains the text to be displayed. FFPx will convert several "escape codes" into extra information about the
selection process. The possible options are:

The default setting for the heading is shown in the dialog above.
The Fo nt... button opens the standard font selection dialog and allows you to define the font for the heading text.
If the Sho w Heading checkbox is checked, then the heading text is displayed.
If the Centre Heading checkbox is checked, then the heading is centred on the slide.
Clicking the Help button displays context sensitive help for the dialog.
Clicking the OK button will save the settings and exit the dialog. Clicking Cancel will abort any changes and exit the dialog.
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2.11.5 The Selection Process

When operating in selection mode, FFPx is similar in use to running a scored competition. Each image is shown and a number is
entered for each (the number of votes). A window pops up to receive the number of votes:

If the number of votes entered is greater than or equal to the M inim um Sco re fo r Selectio n
"Selected" and the background colour of the image in detailed or lightbox view will change.

264

then the image will be marked as

If you use Detailed View then as each image is viewed, the background colour of the row changes so you can quickly see which images
have been examined.
If the Judges m ust vo te fo r o ne im age per autho r
checkbox is checked, then FFPx automatically calculate the number of votes
for the final image in the author's group. For example, if Andrew has entered 4 images and there are 6 judges, then if the first 3
images receive a total of three votes, the final image must receive 3 votes. FFPx produces an explanatory message:
263

You can always override a voting decision by right clicking an image and choosing the Selectio ns submenu:
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Going through the submenu options:
Select will mark the current image as selected. Deselect will mark the current image as unselected. Deselect All will mark all the
images as unselected. Clear All Vo tes sets all the votes to zero. M ark All Im ages as Viewed sets all the images as being viewed.
M ark All Im ages as Unviewed sets all the images as not being viewed.

Typically, between rounds, you would mark all the images as unviewed and clear all the votes.
If the At least o ne im age per autho r is selected
then FFPx will check each author's images; if all their images have been voted
upon but none were selected, then a warning message is produced, for example:
264
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As suggested, you can force a selection by right clicking the image and using the Selectio ns submenu (described above).

Processing Selected Images
Once you have at least one selected image, you can click the Selectio n... button to start the Select Im ages fo r Exhibitio n dialog
and click the Pro cess Selected Im ages button. However, if there are unviewed images in the sequence, FFPx will produce a warning
message:
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2.12

Collecting Images

2.12.1 Introduction

FFPx has an "image collection" system to collect images from members using email, a shared Google Drive folder. There are several
advantages to using this system:
FFPx can automatically set the Author Name into the image's metadata because it "knows" where the image came from.
If the competition has multiple classes (for example, beginner, intermediate and advanced) then FFPx can place the image into the
appropriate class based on the author name.
The shared Google Drive is easy for members to use; they open the link you send them in an email and drag and drop their images
into the page that's opened. FFPx receives the image, sets the author name (if required) and places the entry into the appropriate
class for the competition.
If images arrive from an "unknown" member, FFPx makes it easy to put the images into the appropriate class and FFPx will
remember which class that member is in for the next time that competition is used.
FFPx automatically creates a folder for each competition with subfolders for each class.
For FFPx to automatically receive images requires some configuration; you need to have a Google Drive account to receive images via
Google Drive and to receive images via email, you'll need to configure FFPx with email settings.
You'll also need to configure at least one competition type; a competition type contains a list of members - their names, email
addresses and the class their images belong to. Most clubs only need one or two competition types - for example, you might have a
type for "Digital Image" competitions and another for "Mix and Match" competitions. Before the competition you set the appropriate
competition type as "active" and set a closing date for entries. FFPx will start looking for email and/or Google Drive entries for that
competition until the closing date has passed.
Note that this image collection system is not related to loading images from the Photo Entry online system; that's described here
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2.12.1.1

Email Configuration

To collect images from email, you'll need to configure FFPx with your email settings. I recommend creating a gmail or outlook.com
account specifically for competition entries - it will get complicated for you if FFPx is receiving your regular emails and it means that if
a club laptop is shared amongst several projectionists, they don't need to reconfigure anything to receive entries. If you want to use a
shared Google Drive folder for competition entries, then creating a gmail account makes more sense as you can use the same account
for the Google Drive account.
As an example, we'll use a gmail account. Gmail accounts are widely used (because they're free!) and easy to create from the gmail
registration page; just search for gmail with Google and you'll find the page. FFPx uses the IMAP protocol to collect emails and this
may need to be enabled on your gmail account. To do that, from the gmail web page, click the options button - it's shown with an
icon of a gear - and select the Settings option. On the page that appears, select the Forward and POP/IMAP tab:
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In the IM AP Access: area, make sure the Enable IM AP option is enabled (it is in the above example).
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Assuming that you have a gmail account with IMAP enabled, go to the FFPx settings dialog (from the File tab on the ribbon select
FFPx Settings ) and select the Online Entry Em ail Settings tab on the Settings dialog:

Enter your gmail email address into the first field; FFPx knows about gmail and will automatically fill in most of the form. The only
other configuration you'll need is to enter your gmail password. Click Test to check the settings; FFPx will send a test email to itself
and connect to the IMAP server to confirm it can receive emails. Assuming all is well, the dialog should look like this:
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FFPx automatically sets the appropriate settings for gmail or Outlook.com (formally hotmail) accounts. If you use another email host,
then you'll need to set the server addresses and may need to click the Advanced... button to show options for setting the server port
numbers and authentication options.
2.12.2 Competition Types

To collect images with FFPx, you need to set up at least one competition type; for example, our imaginary Gotham Camera Club has a
digital competition with two classes; intermediate and advanced. To create a competition type, go to the Co m petitio ns tab on the
ribbon and click the M o re button on the Co llectio n Im ages panel. The Co llecting Im ages dialog will open:
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At the top of the dialog, you can set the root where FFPx will save competition folders. As there are no competition type set up yet,
you should click New Type o f Co m petitio n to create our new competition type:
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Going through the dialog; enter a name for the competition - note that this name will be used as a Windows folder name and you
won't be allowed to use illegal characters.
For our fictional competition, Club Co m petitio n is the appropriate competition type.
Now set how you want to receive entries; for our example, we'll select both Email and Google Drive.
In the Class Details area, we need to uncheck the Beginner class - our fictional competition only has Intermediate and Advanced
classes. The complete form looks like this:
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Once the form has been completed, you can click OK to return to the Co llected Entries dialog:
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Now you can set the Las t day fo r Entries . FFPx will receive entries for one competition type at a time and only up to the Last day for
Entries. The idea of the system is that two weeks (say) before a competition, you set the last day for entries to the competition date.
and make sure the Co llecting entries fo r this Co m petitio n option is checked. Once the last day passes, FFPx will stop collecting
entries for that competition.
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2.12.2.1

Adding Members to a Competition Type

Click OK and you'll return to the Collecting Images dialog. On that dialog, click the M em bers Co m peting... button. You'll be taken to
the M em bers Co m peting in dialog:

You can enter members' names and email addresses into the table, but there is an easier way; click the Search fo r new M em bers
button to open the Search fo r M em bers dialog:
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If you haven't configured your email settings, now would be a good time - you can go to the email settings dialog by clicking the
Em ail Settings... button. There's more information about that dialog here .
271

At the top of the Search fo r M em bers dialog, you'll see a checklist panel; FFPx will search any other competition types you've set up
for member information. For example, suppose you'd previously set up a Mix & Match competition type with all the members'
names and email addresses, FFPx can automatically add those members to your new competition type. As this is the first
competition type we've created, this option isn't available and is crossed off the list.
If email is connected (it is in our example) then FFPx will try and find missing email addresses by searching through the headers of old
emails you've received.
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Finally, you can give FFPx some previous sequence files - either FFPx or from FFP - and FFPx will get the member names from those
files.
For our example, I've clicked the Sequences to Search dropdown and selected an earlier sequence.
Having selected the sequence to search, I click the Start Search button. In our example I used a small sequence with four members'
entries - three of whom were fictional, FFPx found the four members, one of which ("Andrew") could be found in the past emails; the
M em bers Co m peting dialog now looks like this:
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For the members with missing emails, the email address has to be entered manually - or, probably more easily, request that all
members send an email to the email address to be used for competition entries; that way FFPx can get their addresses
automatically.
The class for each member should also be set; the completed form looks like this:
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With the member table configured like this, then if Andrew, Sally, Fred or Pené enter using images attached to emails the FFPx will
receive the emails, set the author name (if it's missing) and places the images into the appropriate class.
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2.12.2.2

Email What Ifs

At this point, it's useful to go through various scenarios and what FFPx does in each eventuality:
Scenario
The email comes
unrecognised address

from

FFPx Does This
an When processing the email, you can place the images into a class (see here ); FFPx
remembers that choice and the next time an email is received from that address, it will know
the name and class.
286

The image metadata doesn't match Email addresses have two parts; the actual address (for example, andrew@gmail.com) and
the name associated with the email the name (for example, "Andrew"). FFPx extracts the name from the email and if the image
address.
doesn't have an author name set in the metadata, it uses the email name as the author
name. However, if the image has an author name in it's metadata then that name will be
used for classification; this allows members who share one email address to enter images
and get them classified automatically.
The email comes from an FFPx will still treat the image as unclassified; there may actually be two people with the same
unrecognised address but from a name at the club so FFPx doesn't assume that because the name's the same, it's the same
"known" member name.
person.
The email name doesn't match the FFPx will make you classify the image manually, but it will remember for next time this
member's name registered with the member enters an image. In an ideal world, members would use the same name for both
competition.
their email address and competition entries.
Two people share the same email If there are two members listed as having the same email address (for example, a couple
address
might share an address) then FFPx won't try and automatically classify the images; you can
place the images into the appropriate classes manually see here . However, there's one
caveat - which is described in the next scenario.
286

The email has no attached images

A message to that affect is placed in the Entry Status (see the Entry Status

296

section).

The email has an attached image FFPx renames the new image to avoid a clash; for example, if an image is received called
which has the same name as an "Portrait.jpg" and there's already an image with that name in the same class, FFPx renames
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existing image.

the image "Portrait (1).jpg".

2.12.3 Processing Images

FFPx will look for emails for a competition in the following situation:
Email settings

271

have been configured.

There's an active competition type

274

and it's before the last entry day for entries.

The projector is turned off; FFPx assumes that if the projector is turned on, there's actually a competition going on and it shouldn't
try and collect images.
FFPx detects an Internet connection.
Assuming all of these are true, then FFPx will detect incoming emails. These are processed using the Pro cess Entries dialog; to see
that, click the Pro cess Entries button on the Co m petitio n tab of the ribbon:
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At the top of the dialog, you're told about state of play for received images; in this case the competition has 4 members registered as
competing, 2 in each class. We're gathering images for Dig Comp and the last entry date is 27 Aug 2014. Excitingly, there's one email
which is unread and waiting to be processed. To read that email, click Pro cess Em ails .
FFPx reads the email and any attached images (in this case there's only the one). A table is displayed showing the received images:
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The image hasn't been automatically classified because the source name (Andrew Pepper) isn't a recognised member. However, once
we classify the image, Andrew Pepper will be automatically added to the members of this type of competition.
To classify the image, click the Classify button; the Classify Im ages dialog appears:
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As you can see, the image is currently "unclassified"; you can change the Class to Intermediate or Advanced using the drop down
option in the table. There's also an option to change the author name; this is for the situation where more than one person uses the
same email address. Having classified the image, click OK to return to the list of images, click OK on that dialog to return to the
Process Images dialog:
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If you look at the top of the dialog, you'll see an extra member has been added - FFPx added "Andrew Pepper" once the image had
been classified. In the lower half of the dialog, you'll see that the Advanced class has one image; the one that's just been received and
there are no unclassified images.
If images have been entered using a shared Google Drive folder, you'll see a notification:
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If there are Google Drive images waiting, you can click the Pro cess Go o gle Drive Files button; the images will be uploaded to your
computer, the Author name set and placed in the appropriate class.
As with receiving images via email, if the author name is already set in the image metadata, that will take precedence over the name
associated with the shared folder.

© 2 0 17 A n dre w Pe ppe r

Using FFPx in Detail
2.12.3.1

Images via Google Drive

An alternative to email entries is to use a shared Google Drive folder. This option is available to those members with gmail email
addresses. Assuming you have a gmail account, then configuration is straightforward from the Members Competing dialog:

At the top of the dialog there's a Co nnect Go o gle Drive button; click that and FFPx will open a browser dialog asking you to select
the account you want to use (if you have more than one gmail account).
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Having picked the account, you'll be asked to confirm that FFPx can access the Google Drive files:
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Click Accept and a message is sent back to FFPx; the Members Dialog changes to indicate you're connected to Google Drive:
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Once FFPx is connected, it will create a folder called FilmFreeProjectionExtendedEntries. Individual members will each have subfolders
for their images. You should only need to configure Google Drive once; the next time you run FFPx, it will automatically connect to
Google Drive.
If you want to change the gmail account associated with Google Drive then click the Disco nnect Go o gle Drive button. The next time
FFPx tries to access Google Drive, the browser dialog will open again to ask you to select the gmail account for the Google Drive.
Sharing a Google Drive folder with a Member
Once you've connected a Google Drive account to FFPx, you can share folders for individual members so they can enter images by
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dragging them into the shared folder.
For example, for the member "Sally" (shown above), I right click her name and select No tify M em ber o f Go o gle Drive Fo lder...
Three things happen:
A subfolder is created for Sally in FilmFreeProjectionExtendedEntries.
The subfolder is shared with Sally's gmail account.
An email is sent to Sally with a link to her shared folder for entering images.
Sally will also receive an email from Google telling her that a folder has been shared with her.
Once Sally receives her email with the link to the shared folder, she can open the link and a large Dro p files here area should appear
in her browser:

To enter images, she simply drags them onto that area. FFPx will detect the files and move them into the appropriate class for the
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competition; so once FFPx has moved them, they'll disappear from the Shared folder - this is to avoid FFPx moving historic images
from earlier competitions.
2.12.4 Entry Status

Status messages about the collection of images are displayed in a small window in the Entry Status panel of the Co m petitio ns tab:

You can display a larger dialog window by clicking the panel.

© 2 0 17 A n dre w Pe ppe r

Using FFPx in Detail

2.13

FFPx Settings

2.13.1 The Settings Tab

The Settings tab has settings for the ribbon, obtaining image information, colour management and the projector:

Going along the tab from left to right:
The FFPx Settings button takes you to the main FFPx settings dialog; this is described in detail starting here

298

.

The Ribbo n panel lets you change the style and theme 18 of the Ribbon, switch to use night colours 40 or switch FFPx to operate in
Touch Mode. If Touch Mode is turned on then the panel title bar is made slightly higher - to make touching the More button easier
and the cropping bars 81 are made wider, again to make them easier to use with touch.
The Obtaining Im age Info rm atio n panel is used to control how FFPx obtains metadata

87

for each image.

The Registratio n panel is used in combination with a purchased key to register FFPx. Clicking the More button will show information
about FFPx, including the version number, build date and time and who it is registered to.
The Co lo ur m anagem ent panel is used to control how FFPx manages colours

162

on the second monitor.

Finally, the Pro jecto r panel controls how FFPx uses the projector; whether the second monitor is used and if there are multiple extra
monitors, which one to use. There is also a W indo ws Display Settings button that opens the operating system display setting dialog
so you can set the correct position of the second monitor in relation to the laptop. The More button on the Pro jecto r panel opens
the FFPx Settings dialog and select the Projector setting page.
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2.13.2 Common Controls

To access the FFPx Settings dialog, select FFPx Settings... from the File menu. At the base of the FFPx Settings dialog are a set of
buttons which are common to all the pages:

The Help button will open context sensitive help for the appropriate page being displayed.
The Reset all button will RESET ALL THE SETTINGS OF THE PROGRAM TO THEIR DEFAULT VALUES. Not only the settings on the FFPx
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settings dialog, but such things as the camera club name, panel title slide designs and colour management information will be lost;

so use with caution!
The scoring and selection schemes are stored separately so these will not be reset with a Reset all .
Clicking OK will save the settings and close the dialog.
Clicking Cancel will abort any changes made on the settings dialog.
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2.13.3 General

The General settings page of the FFPx Settings dialog gives access to overall program settings:

Going through the options:
If the So und effects o n M ix & M atch Tim er checkbox is checked, then if a Mix & Match competition uses the time limit option, the
last ten seconds of the countdown generate a bleep.
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"Unho ld" Sco red Im ages controls the behaviour of FFPx when held back images are scored. If the checkbox is ticked, then when a
held back image is scored then FFPx will automatically "unhold" it; removing it from the held list. Some projectionists find this an
easier way of operating. If the checkbox is cleared then FFPx doesn't automatically unhold scored images.
If the Co nstrain M o use to M ain Screen checkbox is checked (the default), then when images are being projected onto the second
screen, the mouse cursor cannot be moved onto the second screen.
If the M o ve to next im age after sco ring checkbox is checked (the default), then after an image is scored the next image in the
sequence is automatically selected. If the checkbox is not checked, then after scoring an image that image will remain selected.
If W hen Sco ring, press '.' fo r a half checkbox is checked then, when scoring an image, you can press the full-stop character to
indicate a half-mark. If the option is unchecked, then you have to enter '.5' for a half-mark.
The Sho w Splash Screen o n Start-up checkbox controls whether the start-up splash screen is displayed when FFPx is started.
If the Sho w Test Im age o n Start checkbox is checked, then when FFPx starts running the default test image will be projected
immediately.
If the Flag im ages that Need to be Shrunk checkbox is checked (the default) then images that are larger than required to fit on the
projector will be flagged on the detailed view (the colour will be pink). If the projector resolution is less than 1024 x 768 pixels, then
images will not be flagged.
If the Sho w Start-up Optio ns o n Start-up option is checked, then the Start-up Optio ns window will be shown when FFPx starts up.
If the Sho w Start-up Optio ns o n Em pty Tab option is checked, then the Start-up Optio ns window will be shown when a new tab is
is opened.
If the Link Blank and Freeze Pro jecto r checkbox is checked, then the Blank projector and Freeze projector buttons on the toolbox
will be replaced by a single Blank and Freeze Projector button.
The M anage Test Im ages... button is used to open the Test Im ages dialog:
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FFPx allows you to define up to 4 test images apart from the built-in test image. To add a new test image, click the Add... button. A
standard Windows file selector dialog appears and you can select an image to use as a test image.
It is strongly recommended that the dimensions of any test images that you add match the dimensions of the projector, so if the
projector resolution is 1024 x 768 pixels, then the test image should have those dimensions.
If the aspect ratio of the image is different from the projector resolution, then FFPx will warn you in the tooltip associated with the
image. If the aspect ratio is mismatched, FFPx will distort the image to make sure it completely fills the screen.
You can remove any added test image by clicking an image thumbnail and then clicking the Rem o ve button.
To set a test image as the default image, click the image's thumbnail and then click Set as Default .
You can project an image by clicking the Pro ject Test Im age button. Click the button again to stop displaying the image.
FFPx displays the thumbnail of the current test image on the toolbar button for the test image.

© 2 0 17 A n dre w Pe ppe r

Using FFPx in Detail

Clicking Help will give context sensitive help on the Test Images dialog.
Clicking Do ne will save any changes. Clicking Cancel will abandon any changes.
Clicking the M anage Title Im ages butto n... opens the Setup Title Images

71

dialog.

The Print Optio ns... button will open the Print Optio ns dialog; described here
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2.13.4 Projection

The Pro jectio n page of the FFPx Settings dialog displays information about the connected projector and allows you to set the
resolution of the projector usually used for competitions and what information is projected:

At the top of the settings page, you can see information about the second monitor (ie the projector). Going through the setting
options:
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Projector Settings
Select Projected Information
Clicking this button opens the Projected Information dialog:

You can chose the items to project by clicking each item; items that aren't to be projected are shown greyed out.
If you are projecting an image, then the values for that image will be shown in this dialog. You can also chose to check the Sho w
changes no w checkbox; if that is done then when you select (or deselect) items, the projected information will reflect the changes.
At the base of the dialog you can select when information is projected. There are three options:
Club Competition; this is information that is projected when an image is selected. Note that for Mix and Match or KnockOut
competitions, this information is not projected.
KnockOut Competitions; this allows you to select information for KnockOut competitions - the KnockOut round name and a
progress bar when the images are being sorted.
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After Score Entered; this is information that will be projected after a score has been entered; for InterClub competitions this can
be the club name. For other competitions, the author and score can be projected after the score has been entered.
There are more settings for the projected information panel that can be set by clicking the M o re detail... button:

Going through the M o re Detail settings:
If the Pro jected Info rm atio n fo r Lo cked Im ages is checked then the information will be projected for all images (including locked
ones). If it isn't checked, then information isn't projected for locked images.
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Clicking the Fo nt... button opens a standard font dialog to allow you to choose the font for the projected information.
The Text Co lo ur and Backgro und Co lo ur opens colour selection dialogs to set the colours for the projected information.
The Backgro und Transparency slider sets how translucent the information box is.
The Panel Size slider sets the size of the information panel.
If the Centre text check box is checked then the panel is always centred horizontally, although you can change the vertical position.
If the Sho w bo rder check box is checked then the information panel has a border around it; if unchecked there is no border.
Clicking the Defaults button resets all the M o re Detail information to their defaults. Note that the default position for the projected
information panel is to be just below the projected EXIF panel.
Positioning the Information
You can drag the "Sample Text" label to set the position of the label on the projected image. Before changing the position of the label,
don't forget that people at the back of the hall won't be able to see labels so easily if they are at the bottom of the screen and that if
the label is right at the top of the screen then it will cover any projected EXIF information.
The Centre Text checkbox controls whether the projected information labels are always centred; if turned on then you can still set
the vertical position of the labels.
Note that FFPx will automatically adjust the font size if multiple images are being projected, shrinking it to keep it in proportion to
the smaller image sizes used if more than one image is being projected.
Enlarge Images to Fit Projector
If this checkbox is checked (the default setting) then images will be enlarged to fit the projector resolution. If the checkbox is clear
then, if the image is smaller than the projector resolution, it will not be enlarged. Images are always shrunk to fit the projector if they
are too big.

Default Projector Size
This group of controls allows you to set the resolution of the projector used for competitions. If you are running FFPx on the laptop
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used to run competitions, then you can check the Use co nnected pro jecto r reso lutio n check box; FFPx will automatically use the
connected projector resolution. However, if you are using FFPx on another machine then you should clear the Use co nnected
pro jec to r reso lutio n box and set the horizontal and vertical resolution as appropriate.
FFPx uses the projector size to decide when images are too big for the projector.
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2.13.5 Detailed View

The Detailed View page of the FFPx Settings dialog allows setting of the detailed view:

The Status Co lo urs box shows the colours used for the various states of images in the detailed (and lightbox) views. To change the
colour for a particular state, click the state and a standard colour selection dialog will open to allow you to set the colour.
FFPx has two basic colour modes; daylight and night colours. In daylight mode (the default), the detailed view uses white as a
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background colour and black text. With the night colour scheme, black is used as the background and white is used for text; the
default colours for the various row statuses are more subdued in the night colour scheme.
Clicking the Reset to Default Co lo urs button resets all the state colours to the FFPx defaults.
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2.13.6 Automatically Save Sequences

The Auto Save page on the FFPx Settings dialog allows you to control automatic saving of the sequence:

If Auto m atically save sequence is checked, then FFPx will either save the sequence whenever a score is entered or an image is held
back, or automatically save the sequence periodically; the time being set in the m inutes counter.
You can set the folder to save the sequence by clicking the Change button.
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FFPx will save the sequence to one of two filenames; the first filename is of the form:
<date>(1).ffpx

Where <date> is today's date.
The second file is of the form <date>(2).ffpx. FFPx will alternate saving between the first and second file.
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2.13.7 AutoSave Best Images

The Auto Save Best Im ages page on the FFPx Settings dialog allows you to set FFPx to automatically save the top scoring images in
competitions:

If Auto m atically save to p sco ring im ages is checked, then FFPx will save images that score the maximum number of points to the
specified folder.
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If the Only Save fo r Club Co m petitio ns option is checked, then FFPx will only save the "best" images for club competitions - panel
competition entries will not be saved.
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2.14

Printing and Print Preview
Although FFPx can be used to score a competition, you may want to use a paper system as an alternative "traditional" scoring technique or
simply as a backup. FFPx provides the facility to print out a "scoring sheet" of your sequence. A sample sheet is shown below:

You can display a print preview by selecting the Print preview option from the Print menu on the File tab.
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You can print the current sequence by selecting the Print option from the Print menu on the File tab.
You can changed various print options by selecting the Print o ptio ns... option from the Print menu on the File tab.

The Co lum n Selectio n area is used to control which columns are printed. Most of these are self-explanatory apart from the User Defined
column.
The Im age Selectio n area is used to control which images are printed as part of the print out.

The User Defined Column
The user defined column is an empty column which can be added to the printed sheet; it is used if you want to mark particular images - for
example, those that might be suitable for external competitions. By clicking the User Defined text box, you can enter the column header.
FFPx will print the column if the column name has been defined and the checkbox is ticked.
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2.15

Frequently Asked Questions
Q. I'm using Windows 10/8/7 or 64 bit; will FFPx run with my version of Windows?
A. FFPx runs on Windows 7, 8, 8.1 or 10 both 32 and 64 bit versions. Note that it doesn't run on Windows XP or Vista.
Q. I've tried to install FFPx and receive a "Value does not fall within the expected range" error message. What's the problem?
A. This is a problem with the Microsoft installation software if the user name being used for the installation contains an ampersand
character ('&'). Microsoft are aware of the problem, but their only suggested remedy is to not use a user name with an ampersand.
So the only solution is to use (if necessary create) a windows user name without an ampersand character in it.
Q. Is there any way to project more than four images simultaneously?
A. Switch to the Lightbox view and on the toolbox there is a drop down where you can select to project all the images, all the images
with numbers (so the judge can refer to images) or just selected images.
Q. I had some trouble getting the screen setup and I ended up with the image projected with a blue bar across the top; what
happened?
A. What has happened is that you clicked the Pro ject button without the Seco nd M o nito r option on the Settings menu ticked. This
can happen if you configure the laptop to have a second monitor after starting to run FFPx. If the Seco nd M o nito r option isn't
ticked, then FFPx will produce a small window for the projected image - this has a blue bar across the top. To fix the problem with
earlier versions, select the Seco nd M o nito r option from the Settings menu; FFPx will then place the image on the second monitor,
removing the blue bar.
Q. I'm using the "Show Index" facility, and occasionally the index number went up by more than one; what's happened?
A. This happens when images have been held back; FFPx skips over held back images, so the index number also jumps over the held
back images' index numbers. If you click Sho w All or tick Held Back Only you'll see the "missing" numbers.
Q. I've used the Project EXIF button and the ISO shows as question marks on some images even though it was taken with a digital
camera and the rest of the shooting information is present; what's going on?
A. Some early Nikon and Canon DSLR didn't store the ISO setting in the “conventional” place in the EXIF but in a “Maker's Notes” area.
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To make things worse, if an image has been saved by Photoshop, then the ISO information in the Maker's Notes is removed. With this
in mind, FFPx only supports the conventional ISO field which is widely supported by recent DSLRs.
Q. Why doesn’t FFPx support any image formats other than JPEG and TIFF?
A. This is mainly because these are by far the most widely used formats, but also other image formats don't support metadata
anything like as well as JPEG and TIFF, making them difficult to use for scored competitions. Incidentally, JPEG is the recommended
format as the file sizes are far smaller than for the equivalent TIFF images. If you have a sensationally good projector you may be able
see a difference between TIFF and JPEG and thus may consider the extra time and effort for handling the larger TIFF images
worthwhile.
Q. When entering the score, I've occasionally mistyped the score and FFPx "locks-up"; is this a bug?
A. Not a bug; to correct a score, you can use the backspace key - usually near the top right hand corner of the keyboard; the
backspace key erases the last digit entered. You can also press the ESC key to abort score entry.
Q. In the first round of a knockout competition, why are there a number of images that don't get seen?
A. These images have received a "bye" into the next round; this is described in more detail here

121

.

Q. Does FFPx run on the Macintosh?
A. No, there are no plans for a Macintosh version of FFPx.
Q. FFPx doesn’t support our particular competition; can it be added?
A. There’s a fair chance; having extra competition modes might give other users ideas for competitions they haven’t tried.
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3

Walkthroughs

3.1

Club Competitions
For a club competition, its best to obtain all the images for the evening before the club meeting starts - this gives you a chance to
print out a score sheet and to check that the resolution and format is appropriate. Remember the following:
FFPx only supports JPEG (.JPG) or TIFF (.TIF) images.
FFPx will operate faster if the images are the appropriate resolution for the projector. For most projectors, there is little point in
the resolution of the images being greater than 1024 x 768 pixels. In an ideal world, members will submit images ready resized
to match the projector. In practice, however, you will probably be required to resize them yourself - the easiest way is to load
them into FFPx on the machine that is to run the competition. If there are images bigger than the projector's resolution, they will
be shown in pink in the detailed view. Right click the tab heading and select Resize All Im ages to fit Pro jecto r .

Before the Meeting
1. Place all the images into a folder.
2. Start FFPx running and use the Add Images

22

button to add the competition images from the folder.

3. If needed, right click the tab heading and select Resize All Images to fit Projector.
4. Press the Shuffle

59

button to put the images into a random order.

5. Right click the first image, from the Insert Title Image...

70

menu select Welcome.

6. Similarly, use the Insert Title Image... menu to insert any other appropriate title images in the sequence - including the Held Back
Images title at the top of the sequence.
7. If the competition is to be scored by hand, then Print a score sheet
scoring scheme.

315

to use at the meeting. Otherwise select the appropriate

8. Save the Sequence.
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At the Meeting
1. Start FFPx and load

49

the sequence you saved earlier.

2. Use the test slide facility

38

to check the projector zoom and keystone is correctly set.

3. Click the Project images button to start the sequence, the first image in the sequence (hopefully your title image) will be projected.
4. Use the up and down keys to move around the sequence, if the judge requests seeing through each image before commenting on
them, you could use the Automatic slidechange 36 facility.
5. If the judge requests that an image is held back press the space bar - the image will disappear from the sequence and the next
image will appear.
6. If FFPx is scoring the competition, then as the judge announces the score, type the score into FFPx and press the Enter key.
7. After all the images have been shown, click the held back only 67 checkbox. The Held Back Images title slide should appear, as
before use the up down keys to move around the held back images and type the score as the judge announces it.
8. At the end of the competition, go to the Scoring/Calculate Score Results... menu option to display the results of the competition.
9. That's all there is to it, enjoy the competition!
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3.2

Elimination Competitions
Probably the second most common competition in camera clubs is the elimination competition. With this competition, members
submit a number of images and the judge goes through the images, removing "losers" (for want of a better word). After several
passes through the images, the winners remain - perhaps the top three plus some highly commended or a single winner.
You may be wondering why there isn't a special "Elimination Competition" mode for FFPx; the reason is that the regular club
competition mode is ideal for an elimination competition.

Before the Meeting
The elimination competition is one of the few competitions that can be sensibly run with members bringing images on the night;
although you may feel that allowing this is something of a slippery slope! Assuming that you receive the images before the
competition, they simply need to be loaded into FFPx - you don't need a scoring scheme and the images don't need the author field
to be set.
The loaded images are shuffled and (if required) title and end images inserted. The sequence can then be saved ready for the meeting.
Remember that if you want to transfer the sequence to another computer for the actual meeting, to use either the Save Sequence
and Images 30 or the Save All Sequences and Images 30 procedures.

At the Meeting
Start FFPx and load the previously saved sequence.
The judge will generally talk about each image and end by saying "keep" or "discard"; to discard an image, you press the Delete key,
to keep it, press the Enter key or the down arrow key to move to the next image.
When the judge reaches the last image in the sequence, you can press the Home key to return to the first image in the sequence and
you go through the images again.
As you see the list of images on the laptop screen, you can tell the judge when they are getting to the final few remaining images.
There is an extra bit of "finesse" you can offer the judge; if click the M o re... button in the Metadata area of the toolbox, you can turn
on display of the Image Index; this will briefly project how many images are remaining - as well as the image number being projected.
Another technique to help the judge towards the end is to show up to four images simultaneously by clicking the first image to show,
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then holding down the Ctrl key and clicking the other images to project.
If the judge wants to see more than four images simultaneously, then you can switch to lightbox mode and turn on Pro ject Lightbo x.
That way all the images on the lightbox display will be projected.
If you have an indecisive judge, then you may want to hold back images rather than delete them. That way the judge can change their
minds about an image and you can switch to held back only 48 mode and unhold the image to place it back into the sequence.

Elimination Panel Competitions
For panel based competitions where entire panels are eliminated at one go, the easiest way to remove a panel from the sequence is
to hold it back - pressing the space bar holds back the entire panel in one operation.
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3.3

InterClub Competitions
In one way, the InterClub competition is the simplest to run as it's not necessary for the images to have the author name set; FFPx
assumes that the folder name holding the image files is the club name.

Before the Meeting
To run an InterClub competition, you will need an InterClub scoring scheme

202

.

On the Evening
Usually, for an InterClub competition, other clubs arrive with a memory stick of images for the competition. Copy each club's images
into folders on the FFPx laptop, using one folder per club. Name the folder with the name of the club; for example, if a club name is
Gotham Camera Club, give the folder holding Gotham's images the name "Gotham Camera Club". It will be slightly easier if all the
club folders are subfolders of a single folder - the folder structure could look like this:

With all the images on the laptop, start FFPx and click the InterClub button or select InterClub from the Co m petitio n type menu. If
you've put the club folders as subfolders to a single competition folder, then you can use the Add Fo lder o f Im ages option from the
File menu or click the Add Fo lder button on the toolbar. Navigate to the competition folder. For InterClub competitions, FFPx will
automatically search subfolders, so clicking OK will load all the competition images in one go. Note that the Club Nam e column will
show the folder name.
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Use the Insert Title Im age...

70

menu to add appropriate title images to the sequence.

If you want the club name projected when an image receives a score, turn on the Club nam e after sco re option on the Projection
tab of the FFPx Settings dialog.
306

Click the Shuffle button.
Click the Score button. FFPx will confirm the scoring scheme in use.
Click the Project Image buttons and the competition will start; when images are scored by the judge, type the score.
At the end of the competition, click the Sho w Results button from the Sco ring panel, the results will be displayed.
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3.4

Multi-Leg Competitions
To run a Multi-Leg competition, you'll need to create a sequence - much like a regular club competition. However, you will presumably have to
gather images from all the participating clubs.
Once you have all the images load them into FFP; add any title images you want. Once you are happy with the sequence select the Save fo r
M ulti-Leg Co m petitio ns ... option from the File menu:

The Save Sequence fo r M ulti-Leg Co m petitio ns dialog opens:
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The Num ber o f Legs up/down count sets the number of legs in the competition (between two and four).
Click the Change save fo lder... to set where the sequences will be saved. FFPx will create a sub-folder for each leg. Each sub-folder
contains all the images and a sequence.ffpx file. Each participating club needs to have a copy of their appropriate sub-folder; you can
use a memory stick or send the sub-folder to a .zip file which can then be emailed to the club projectionists.
Each club runs the competition like a normal competition; scoring images as they are projected. At the end of the competition the
projectionist MUST SAVE THE SCORED SEQUENCE!
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After a participating club has scored the sequence, the projectionist should send the saved sequence.dss file back to you.
When you receive the sequence.ffpx file, you must place it back in the appropriate sub-folder for that club.
Once you have all the sequence files, load your club's sequence file and select the Calculate Sco re Results... option from the
scoring menu. The score for your leg of the competition will be displayed:

Click the M ulti-Leg Co m petitio n button at the top of the display and FFPx will examine the surrounding folders to your club's
sequence and use the sequence.ffpx files found to produce an overall result:
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3.5

Knockout Competition
Before the Competition
As with a Club Competition, it is recommend you obtain the images before the day of the competition. This gives you a chance to
load them into FFPx and make sure they are all of suitable resolution and have the Author's Name metadata 87 information set.
Unlike a Club Competition, title slides are not recommended as FFPx will treat them as "normal" images and enter them as part of
the competition. If you want to use title slides, then after displaying the image you must remove it from the sequence before running
the Knockout competition proper.
It is recommended that you ensure the author's name field is set correctly for each image as FFPx's shuffle facility will try and avoid
pairing off images by the same author.
Once the images are loaded you are ready to run the competition.
Either click the Kno ck Out button on the Competitions tab.
Click the Pro jecto r button.
The Start Kno ck Out button will become enabled. At the base of the FFPx window, the number of images in total and how many
"pairs" will be in this round should be shown.
Click the Start Kno cko ut button. The images will be "shuffled" and the first two displayed in split screen mode on the projector
screen. A dialog box with buttons containing thumbnails of the two images will appear (shown below).
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Note that the title of this box shows how many pairs are in this round and which pair this is. Under each image is a "maximize"
button; if you click and hold that button the corresponding image will be enlarged to fill the screen.
As indicated by the box, click the winning image. The next pair of images will be shown and so on. As the winning slides are selected,
you'll see that they are flagged as "winners" on the FFPx display (shown below).
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You can correct any errors by right clicking an image and selecting the Kno cko ut W inner option to change the state of that image. When a
round completes, the two images on the dialog will be replaced by one big button inviting you to click for the next round:
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When you are ready for the next round, you can click the button.
At the start of each subsequent round, FFPx will automatically remove the "losers" and clear the Winner flags from the previous round, finally
shuffling the images again.
When there are only two images in a round then this is the final; when the winning image is selected then FFPx will automatically switch off
split screen mode to show a full screen version of the winning slide - you can also click the runner up to show that in full screen mode.
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3.6

Mix & Match Competition
Before the Competition
Before the competition, prepare a scoring scheme for Mix & Match

210

.

Preparing the Competition
To run a Mix & Match
appropriate folders.

124

competition you will need to create a folder for each team. Put the images for each team into the

Decide which team is going to start.
Start FFPx and select M ix & M atch from the Co m petitio ns tab. The mix and match setup dialog box will open:
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Set the number of teams in the competition, in the Num ber o f Team s counter.
Assuming you are using FFPx to score the competition, tick the Sco re this Co m petitio n using checkbox and select an appropriate
scoring scheme from the dropdown.
Team one always starts, so you should put the name of the team that is going first into team one's name. You can now select team
one's folder (by clicking the appropriate button).
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Put the next team's name into the appropriate text box and select the folder for that team.
Carry on setting team names and selecting folders until all the teams have been defined.
FFPx will automatically show how many images are in the source folder so you can confirm that each side has the same number of
images.
Once all the teams have been named and have their image folders selected, click OK and FFPx will confirm the scoring scheme in use,
after this reminder the images will be loaded.

Running the Competition
From a practical point of view, the simplest set up is to sit representatives of each team around a table with you as the projectionist
running the show. You can then place the laptop to face each team representative in turn to select their images - a "lazy Susan"
turntable is a useful accessory for Mix & Match competitions.
Note that when you're in Mix & Match mode, you can only see a lightbox view of the images. FFPx prompts you through the process
of running a Mix & Match competition; first it will ask for team one to select an image.
Team one's representative selects an image simply by clicking it; they should leave the projectionist to actually click the Sho w
Selected Im age button because as soon as that button is clicked, the next team's images will be shown on the lightbox view.
FFPx has a prompt area in the control box that shows you who should be selecting images.
The next team's representative now tries to match the projected image, once selected, you click the Sho w Selected Im agea button the images are projected simultaneously.
Note that as teams select images, the selected images are automatically removed from the lightbox view.
Carry on with the team selecting images until all the teams have picked an image.
FFPx will then produce a dialog to find out if any images "matched". For a two team competition, the dialog looks like this;
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and you click M atch or No M atch as appropriate. Under the M atch and No M atch buttons are maximize buttons; if you click and
hold a maximize button, then the corresponding image will be enlarged to fill the screen. For example, if you click and hold the left
maximize button, the left image on the screen will be enlarged.
If there are more than two teams taking part, then the dialog looks like this:
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This is slightly more complicated as you can click more than one "matching" image (or click No M atch if no images match).
If the scoring scheme you are using has a score for the "best" image of a round, then you will be asked to select the best image:
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As the dialog says, click the better image. You can click < Back to return to selection of Match/No Match.
When the Best image has been selected, then you will be prompted to Click OK to blank the screen. Clicking OK will start the next
round.
If there is no "Best" image component to the scoring, then once you select the Match or No Match, you will go straight to the Click
OK to blank the screen prompt.
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The competition carries on in this way until you run out of time or images; note that whenever the first team is requested to select
an slide, then all the teams will have had the same number of images so that is the fairest time to stop.
At any time, you can select Sho w Results... from the Scoring Scheme status box More button menu.
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3.7

Panel Competitions

3.7.1

Panels where each Panel Shown in Turn

Before the Competition
Prepare a panel based scoring scheme

198

appropriate for the competition you are running.

From the Competitions tab, select the By Gro up panel competition.
To design a title image to place between panels, click the More button on the Panel Based panel and select Title Design... from the
Panels menu that appears. The Panel Title Design
dialog will appear.
154

In an ideal world, the competitors will have named their images correctly and submitted the images before the competition. As you
recall, images for a panel should be named in the form:
namePnumber-Snumber.jpg
So, andrewP1-S1.jpg is a correctly named panel file; it represents Andrew's panel 1, slide 1.
If, as sadly happens, some of the images are misnamed, you can select Co rrect Panel Nam es... from the Panels menu.
Assuming the images' filenames are all correct, click the Insert Titles between option. FFPx generated title images will be inserted
between each panel.
In panel mode, the table display of FFPx will be updated, note that in panel mode there are two extra columns; Panel and Slide
Num ber .
At the base of the FFPx Window, the number of slides and panels will be shown.
You can shuffle the images if you want to, FFPx will shuffle the panels - not the individual images. If there are blanks between panels
then FFPx removes them before shuffling then re-inserts them afterwards.
If required, print out a score sheet (from the File tab, select the Print option). If you plan to use FFPx to score the competition, select
a panel based scoring scheme.
Now you can save the sequence by clicking the Save Sequence button. Save the sequence somewhere you can find it easily; on the
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desktop or in the folder holding the images.

On The Night
Once the laptop and projector have been set-up, click the Open Existing Sequence button on the Start-up window and select the
previously saved sequence file. FFPx will load the panels and also set FFPx into Panels mode. The scoring scheme you selected will
also be selected.
Click the Start Pro jecting Im ages button to start the competition. As with a normal competition, you can use the up/down cursor
keys to move between slides and score an image by typing the score followed by the Enter key.
If the judge requests a quick run through of a panel, you can set the automatic slide change option to Sto p at the end o f panel and
turning on automatic slide change; FFPx will project each image in turn but stop at the end of the panel.
You can quickly move to the first image in the panel by pressing Ctrl+Up Arrow.
To hold back a panel, press the space bar (or right click an image and select Ho ld back ) the entire panel will be held back in one go.
As with a normal competition, checking the Held Back Only checkbox will show the held back panels.
Deleting a Panel
To delete a panel, select the next image you want to project and click the Freeze Pro jecto r button on the Pro jecto r panel - the
button will start flashing red.
Right click an image from the panel you want to delete and pick the Select all im ages in this panel option:

© 2 0 17 A n dre w Pe ppe r

Walkthroughs

Press the delete key and all the images in the panel will be deleted.
Click Freeze Pro jecto r again and the button will stop flashing.
At the End of the Competition
When all the images have received a score, go to the Results Sum m ary option from the Sco ring menu and you'll see the results of
the competition.
Enjoy the competition!
3.7.2

Panels in Group or Cycle Modes

Before the Competition
Prepare a panel based scoring scheme
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From the Competitions tab, select the By Slide or By Slide and Cycled panel competition.
To design a title image to place between panels, click the More button on the Panel Based panel and select Title Design... from the
Panels menu that appears. The Panel Title Design
dialog will appear.
154

In an ideal world, the competitors will have named their images correctly and submitted the images before the competition. As you
recall, images for a panel should be named in the form:
namePnumber-Snumber.jpg
So, andrewP1-S1.jpg is a correctly named panel file; it represents Andrew's panel 1, slide 1.
If, as sadly happens, some of the images are misnamed, you can select Co rrect Panel Nam es... from the Panels menu.
Assuming the images' filenames are all correct, click the Insert Titles between option. FFPx generated title images will be inserted
between each panel.
In panel mode, the table display of FFPx will be updated, note that in panel mode there are two extra columns; Panel and Slide
Num ber .
At the base of the FFPx Window, the number of slides and panels will be shown.
You can shuffle the images if you want to, FFPx will shuffle the panels - not the individual images. If there are blanks between panels
then FFPx removes them before shuffling then re-inserts them afterwards.
If required, print out a score sheet (from the File tab, select the Print option). If you plan to use FFPx to score the competition, select
a panel based scoring scheme.
Now you can save the sequence by clicking the Save Sequence button. Save the sequence somewhere you can find it easily; on the
desktop or in the folder holding the images.

On The Night
Once the laptop and projector have been set-up, click the Open Existing Sequence button on the Start-up window and select the
previously saved sequence file. FFPx will load the panels and also set FFPx into Panels mode. The scoring scheme you selected will
also be selected.
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Click the Start Pro jecting Im ages button to start the competition. As with a normal competition, you can use the up/down cursor
keys to move between slides and score an image by typing the score followed by the Enter key.
If the judge requests a quick run through of a panel, you can set the automatic slide change option to Sto p at the end o f panel and
turning on automatic slide change; FFPx will project each image in turn but stop at the end of the panel.
You can quickly move to the first image in the panel by pressing Ctrl+Up Arrow.
To hold back a panel, press the space bar (or right click an image and select Ho ld back ) the entire panel will be held back in one go.
As with a normal competition, checking the Held Back Only checkbox will show the held back panels.
Deleting a Panel
To delete a panel, select the next image you want to project and click the Freeze Pro jecto r button on the Pro jecto r panel - the
button will start flashing red.
Right click an image from the panel you want to delete and pick the Select all im ages in this panel option:
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Press the delete key and all the images in the panel will be deleted.
Click Freeze Pro jecto r again and the button will stop flashing.
At the End of the Competition
When all the images have received a score, go to the Results Sum m ary option from the Sco ring menu and you'll see the results of
the competition.
Enjoy the competition!
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3.8

Selecting Images for Exhibition
Before the Selection Process Starts
Image selection is often performed in more than one round; for example, in round 1, judges may select one image per entrant, in a
second round images are selected from those that missed out in the first round.
For our walkthrough, we'll assume there are six judges and 50 images are required for the exhibition, each author can enter between
1 and 6 images. The following rounds are used:
In Round 1, each author's images are shown in sequence and each judge must vote for only one image per author. Each author is
guaranteed that one image is selected. Any image that receives 4 votes or more is automatically selected. If an author has no images
selected when all their images have been viewed, then the operator has a casting vote and selects one of the images. When all the
images have been viewed, the selected images are copied to a folder and removed from the sequence.
In Round 2, the images not selected by Round 1 are shuffled randomly and each judge votes on each image. Any image that receives 4
votes or more is selected. When all the images have been viewed, the selected images are copied to a folder and removed from the
sequence. Round 2 is repeated until the required number of images have been selected.
Before the competition, we set up the two rounds using the Select Im ages fo r Exhibitio n
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We start by clicking the Create New Schem e button and naming the new scheme "Round 1". We check the Transfer selected to
fo lder checkbox and define the folder for the selected images. The completed dialog tab looks like this:

© 2 0 17 A n dre w Pe ppe r

Walkthroughs

Note that the Sho w Statistics checkbox has been cleared; instead we'll insert Title Slides between author groups which show
statistics for the selection process. Next, click the Schem e Optio ns tab:
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The above dialog has been completed correctly for our required scheme. Note that we are grouping the images together by author
and displaying a title slide between groups. Next click the Selectio n Criteria tab:
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The above dialog is completed correctly for the scheme. Note that the M inim um sco re fo r selectio n counter is disabled; because
the judge must vote for one image per author and at least one image per author is selected, FFPx knows that the minimum score for
selection must be 4.
With this tab complete, click Save to save the scheme and click the General tab; Round 2 needs to be built.
As before, we start by clicking the Create New Schem e button. The name for the new scheme is "Round 2". The settings for Round 2
are the similar to Round 1, except that we check the Sho w Statistics checkbox as we won't have title slides in this round showing
the statistics:
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Next we select the Schem e Optio ns tab; the completed tab looks like this:
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Finally, click the Selectio n Criteria tab; the completed tab looks like this:
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This time, we can set the M inim um sco re fo r selectio n . In practise, we might change this on the day depending on how many
remain to be selected after round 1. Save the scheme.
Hopefully, members will submit their entries before the selection evening and you can check they have their author name correctly
set. FFPx will group the images by author and then sort each author's images by Subject, if the authors want to ensure the images are
shown in a particular order, they should put the order number as the subject - ie "1", "2", "3" and so on. They must not use "one",
"two", "three" - FFPx sorts the subjects alphabetically and "four" would come first(!)
With all the images loaded into FFPx, the Run in Selectio n M o de checkbox should be checked on the Select Im age fo r Exhibitio n
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dialog and "Round 1" selected in the Select schem e to use dropdown menu. Click OK and save the sequence. If you plan to run the
selection process on a different computer, then use Save Sequence and Im ages 30 ; this saves the images as well as the sequence
information.

On the Evening
Load the previously saved sequence. Round 1 is the scheme in use. The judges vote on each image in turn. Images that receive 4 votes
are automatically selected. Note that each author's final image will automatically receive a score; if the previous images in the group
have received 3 votes (for example) then the final must receive 3 votes.
If an author doesn't receive at least 4 votes for any image, then the operator picks an image to select, right clicks it and chooses
Select from the Selectio n... submenu.
The title slides between each author's group shows how many images remain to be selected.
When all the images have been voted on, the Select Im age fo r Exhibitio n dialog is opened and Pro cess Selected Im ages clicked.
All the selected images are transferred to the specified folder and removed from the sequence.
With Round 1 completed, the General tab is selected and "Round 2" selected from the Select schem e to use dropdown menu.
Click OK to return to the sequence.
Right click any image and from the Selectio n... submenu, chose the Clear all Vo tes and M ark All Im ages as Unviewed . Shuffle the
images ready for the next selection round.
Now you can run through the sequence again, voting on each image. Any image that scores 4 or more will be selected. As the Sho w
Statistics checkbox was checked, each image will have the selection statistics briefly superimposed. When all the images have been
viewed, the Select Im age fo r Exhibitio n dialog is opened and Pro cess Selected Im ages clicked. If more images need to be
selected, the round 2 process is repeated until enough images are selected.
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Ambiguous Metadata
106
Author and Title
88, 106
Author, Title and Subject
From file name
98
From the file
88
Automatic Slide Change
AutoSave
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EXIF, XMP and IPTC
Setting within FFP
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Projector
Default size
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Sorting
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